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RSU Software

MTE provides three programs for collecting data with MetroCount Roadside Units (RSUs):
» MCSetup for desktop and laptop PCs (English).
» MCSetLite CE for Mobile Devices based on Windows CE or Windows Mobile (multilanguage).
» MCSetLite PC for desktop and laptop PCs (multilanguage).

M CSetup provides complete support for all MetroCount RSUs, including RSU setup and unload, Site List
management, RSU configuration and diagnostic tools. MCSetL ite provides all of the required functionality for RSU
control and data checking, with amultilingual user interface.
This chapter covers the fundamentals of gathering data using MCSetup, including:

* understanding RSU modes of operation and behaviour,

« configuring MCSetLite and M CSetup,

 connecting to a RSU,
checking RSU status,

 setting up aRSU,

* viewing real-time sensor hitsto check setup and installation, and

* unloading data.
Installation and usage of MCSetLite is covered in the MCSetLite User Manual.

Experimenting with the user interface and features in the office is recommended. This gives an opportunity to
become familiar with RSU behaviour, and make field setup a smoother process.

A comprehensive discussion of issuesincluding site selection, sensor installation and information can be found in the
corresponding Roadside Unit Operator Guides.
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RSU Basics
Philosophy

All MetroCount Roadside Units are designed to make the process of data collection as simple, and asreliable as
possible. The primary mode of operation isto store time-stamped sensor hits, forming a hit stream of raw data. This
approach to data collection maximizes the analysis potential and results in data unconstrained by units of
measurement, classification schemes, or by binning counts. There is no need to decide, and in many cases
compromise, the information required before a survey.

Most importantly, the datais auditable. Using a variety of simple software tools and techniques, data quality can be
verified, and maintained.

Communication

MetroCount RSUs are controlled via a standard RS-232 serial communications port, using MCSetLite or M CSetup.
Theideal scenarioisto invest in amobile PC for use in the field. This provides the advantage of software toolsto
ensure correct RSU operation on-site, and to verify basic data quality.

A mobile PC is not a requirement. RSUs can be successfully setup using an office PC, and the start time deferred to a
time after the RSU has been placed in the field.

Operating States

The following diagram shows the three operating states of a RSU.

4— ~Unload &
/ < stop

Deferréd Immediate
setup setup

Active Start time Active Unnll‘oa d
Deferred reached Logging ]
~—_
RSU Operating States

The ldle state is the RSU's low-power, standby state. In this state, the RSU does not log any data and simply retains
any existing datain memory. This resultsin very low battery consumption.

A survey is begun by performing a Setup operation. Thisis asimple process of specifying the sensor configuration
and a number of site description parameters. The RSU may be set to start immediately, or deferred for up to 10 days.
Once the start time is reached, the RSU entersits Active Logging state.

Inits Active Logging state, the RSU time-stamps sensor hits. It also performs a number of maintenance tasks, such
as checking battery voltages and monitoring memory usage.

The RSU does not require a stop time or logging duration. It simply continues to time-stamp sensor hits until an
Unload operation is performed (with the option to stop the RSU), or its memory capacity isfilled. Once the RSU is
stopped, it returnstoits Idle state.

Dataisretained in the RSU's memory until the next setup operation is performed. Thus the data may be unloaded
again if required.
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During asurvey, data may be retrieved from the RSU, without interrupting the survey, by performing an Unload
operation without the stop option. This allows a mid-survey data quality check to be performed.

Datasets

Header Details

All the survey parameters provided at setup, along with the current status of a RSU, are collectively stored in the
RSU's Header. When checking a RSU's status, it is the unit's header that is retrieved.

When an Unload operation is performed, a Dataset is created, which contains the RSU's current header information,
followed by the raw data. Datasets are then analysed by MTE's analysis component - M CReport.

Setup—p| Header Header
—Unload—»
. Raw Raw
—Vehicles—»| Data Data
RSU Dataset

RSU Data Flow
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MCSetup Configuration

Preferences

MCSetup can be started from the Start Menu by locating the MetroCount v3xx folder, and selecting MCSetup. If this
isthefirst time MCSetup has been started, the Preferences dialog box will be automatically displayed. If MCReport
has not been started, the New user file setup dialog box will also be displayed.

||

MNew user

Set working folder

MTE needs to create a set of folders to store Samples, Profiles and Templates,

Location to copy files
Documents

The sub-folders in bold will be created
E-GE CAUsers\MTE Demo User\Documents
=@ MetroCount
B2 MTE 3.21
-0 Assembly
o Data
~{2 Dutput
~{J Profiles
{1 Samples
-3 Script
o Sites
-3 Software
T WML

Setting a working folder location

MTE needs afolder location to store working files, such as MetroCount data, Profiles and templates. The default
working folder location will be the current user's Documents folder. Thisis highly recommended asit is guaranteed
to be accessible under al versions of Windows. To select a different folder, click the ... button. When done,
MCSetup will create the list of folders shown in the sub-folders tree, and copy a set of default working files.

| New user

Set initial preferences here

MCSetup has detected that this is a new installation. “You will need to selact
a communication port and several other user options before you start

MCSetup new user settings

©2013 MetroCount® - - MTE User Manual

O
o
o)
)
Q)
<k
@
Q
=5
o
S5




MCSetup's Preferences contain a number of options that need to be set before communi cating with Roadside Units.
These options can be reviewed at any time by selecting View » Preferences from the main menu.

RSU serial part
CoM3

GPS serial port GPS port speed

COMa 115200 e

Falder for Site Lists and maps
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CAUzers"MTE Demo User\DocumentsiMetroCount\MTE 3.2145ites E] g
—~

o
>

Base folder for unloaded data
C\Users\MTE Demo User\Documents\MetroCountsMTE 3 214D ata E]

Subgroup unloaded dats files by.
[ ear |[ Month | [ Site | [ Atmibute |

[unloads]

Use metric units

Use high speed unload
Allow editing of site list
[] Entorce site list use

MCSetup's Preferences

The most important setting is the RSU serial port. Thisis the serial communications port that will be used to
communicate with MetroCount RSUs, which may be a MetroCount USB Adapter, or a physical serial port ona
desktop or laptop. For alist of available seria ports, click the ... button.

|| Mame De.. Details Type Skatus
%COM‘? Ports  Commupication Serial port  Available:

B coms Ports€etroCount USB Adapter (COM3 Serial port  Available
e

%COMB Ports  GPS Recerer Serial port  Available

4 2

Selecting a serial port

A suitable serial port should have a status of Available with ayellow icon. A red-circleicon indicatesthe port is
unavailable, possibly becauseit is aready in use. Simply select the desired serial port, and click the OK button.

The GPS serial port setting is used to retrieve coordinates from a GPS unit, to be stored in a Site List or dataset
header. Click the ... button to select from alist of available ports. USB and Bluetooth GPS units generally create a
virtual seria port, which can be used by MCSetup. Refer to the GPS unit's documentation for the default serial port

speed.

The Folder for Site Lists and maps is where MCSetup will first look for Site Lists, and their associated maps. The
default folder isthe Sites folder in MTE's working folder location.
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The Base folder for unloaded data is where MCSetup will place data unloaded from a RSU. The default folder isthe
Data folder in MTE's working folder location. M CSetup can also automatically group datainto subfolders using the
Year, Month, Site and Attribute buttons. Folders will be created in the order the buttons are pushed.

Subgroup unloaded data files by...
" [Lorear ] [ Month | Site_ ] [ Adtributs |

VSITENTEAR[Unloads]
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Grouping data into subfolders
The Use metric units option isfor MCSetup's internal use only, such as displaying vehicle speed in the Sensor View.
This option in no way affects the data being logged by a RSU. The units of measurement used for data analysis are
set in MCReport.

Unchecking the Allow editing of Site List will prevent editing of sitesin a Site List, to discourage site editing in the
field. The Enforce site list use option will disable the Setup and Unload buttons on MCSetup's main toolbar until a

siteisselected in aSite List.
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MCSetup Layout

MCSetup's basic layout is shown in the diagram below.

a MCSetup - stirling3a.sit 3 E‘M
StatLIS File ‘iew Roadside Unit Technical Window Help
b *g COM1 a Plus § Single channel T N200MPRS MCSE-LS [MC55E] (c)Microcom 190ct04
ar
RSU § stirling3a.sit

"?;z’s o || sitetane  Dir Star Deb Desc =
Se:z ; FJ040 SN Immediately  30-30  Luce

’ %US.U SM(5)  Immediately 30-30 Luce/ =

. Kt 4 EJos1  Weh)  MextHour 030 Hale .
L4 L4
Maln *Unlnad oz E@  MextHour 30-30 Hale o Slte
toolbar ®| - Bl W@ MextHour W30 Hale List

oY) EQU?.Z E( Mext Hour 30-30 Hale
i %UE.U WUE (B)  Mext Hour 30-30 Cror
i FJ0g.0  WEE  Mext Hour W30 Cror
@310.1 S Immediately 30-30 Emp
— w2 N Inmediately  30-30 Emp

_@'J Egll.l e Immediately 30-30 Emp -

IR | K mm— '
Use Ctrl (1,5,u,v,c) keys to access toolbar, Alt key to enter menu,

MCSetup's layout

The Status bar displays information about the currently connected RSU, including Signature type, current channel
(for multi-channel RSUs), and the RSU's identifier and firmware revision.

The main toolbar provides the core RSU functions. Note the shortcut keys listed at the bottom of the screen for
convenient keyboard operation.

Button Shortcut key Function
> Crl +r Get RSU status
5 Ctrl +s Setup RSU
Unload
Ctrl +u Unload data
Ctrl +v View sensor hits
Cans) Change RSU channel (multi-channel
@4;7?11 Cul +c RSUs only)

The document area of MCSetup is used for displaying Site Lists.

©2013 MetroCount® - - MTE User Manual
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Establishing a Connection

Once aserial port has been selected in MCSetup's Preferences, connect a RSU and click the RSU Status button on
MCSetup's main toolbar. If the New Connection dialog box appears, a successful connection has been established.
This dialog box appears every time a different RSU is connected to M CSetup.

New Connection

New Connection

& new RSU connection has been detected
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‘ RSU Identifier: Z179SNVG
\ Channel: 0

New Connection dialog box indicates a successful connection
If the Can't communicate error appears, with the details The port cannot be opened, either the wrong serial port has
been selected in the Preferences, or the seria port isin use by another program.

Can't communicate!

Dtject
quMD

Details:

Fie port cannot be opened
Frmay W be assigned to anather
dewvice such as a serial mouse of fax-modem.

.

Can't communicate - port cannot be opened

If the Can't communicate with Roadside Unit error appears, thisindicates M CSetup was able to open the selected
serial port, but did not receive aresponse from a RSU. With a RSU connected, click the RSU Status button and check
whether the RSU's Status LED comes on. If the Status LED does not come on, the most likely cause is selecting the

wrong serial port in the Preferences.

Can't communicate with Roadside Unit!

Object:

w |None

Details:
Please check cables and connectars, then retry this operation

-

Can't communicate - check the RSU's Status LED
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RSU Status

Overview

Clicking the RSU Status button on the main toolbar displays a snapshot of a RSU's current status, grouped into
separate pages. It is advisable to do a status check regularly:

» Before setup - to check remaining battery life.
« After setup - to check the setup was successful, and the RSU is active.
» During asurvey - to monitor axle statistics and memory usage.

If apotential problem existsin any of the status pages, the relevant page will be automatically displayed, along with
awarning message describing the problem.
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Note:
& Use theleft and right arrow keys to step through the RSU Satus pages.

Site Information

The Data page displays the survey parameters of the data currently in memory, as specified when the RSU was setup.

RSU Status - Channel 0 m =
Data |RSU_| Battery | Hits | Memor

Property Walue ol
Site Mame 007
Aftibute  MetroCount HO
Lane ao
Description O'Connar Claze narth of Raolinson Rd

m

Lapout Azle sensors - Paired [Class/Speed/Count)
Direction & 7 - Morth bound A3B. South bound B4, [7]
Direction B 0 - Unused ar unknoven, [0]

First Data  Unknown! [Roadside Unit start = 1335 Wednesday, 14 ..
Last Data  Unknown! [Roadside Unit finish = 18:03 Monday, 19 How... |

Debounce  A4=10ms, B=10ms

Clase

RSU Site Information
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RSU Activity

The RSU page displays information about the RSU's hardware, and the Status list at the bottom shows the RSU's
current state of activity. It also lists recent events that may impact the data currently in memory, or the RSU's

condition.
RSU Status - Channel 0 o |
- RSU | Battery | Hits I Memary
Property Value
Ident. ? M200MPRS MCS6-LS [MCS5] (c)Microcom 190ct04
RSU MCSE00
Batteries  Main=E.01, RAM=4.43, [M=E.0TV, R=4.41V]
emony Used=11.03% [223451 of 2080768) [HI=0f, LO=404b]
Setup Time  13:35 Wednesday, 14 November 2007
Start Time  13:35 Wednesday, 14 November 2007
Firish Time 18:03 Manday, 19 Movember 2007
PunTime & days 4 br 28 min
Status [0%81] Roadside Unit ACTIVE: Running normally
v DATA available to unload
M|« I ] »
RSU status information
Text Description
Roadside Unit not ACTIVE | The RSU isinitsidle state.
Roadside Unit ACTIVE: |The RSU has been setup with a deferred start time. When the start time is reached the
Waiting for start time  |RSU will switch to its active state.
Roadside Unit ACTIVE:

Running normally

The RSU isinits active state, logging data.

DATA available to unload

The RSU contains data that has not been unloaded. This will remain until the RSU is
stopped.

Memory FULL

The RSU has filled to capacity, and will have stopped logging data.

Main battery ran down

The RSU will switch toitsidle state if the main battery drops below a certain level.
This ensures that there is always sufficient power to communicate, barring battery
failure. This message indicates the RSU may have stopped logging sooner than
expected.

Roadside Unit POWER was
interrupted

Power was interrupted while the RSU was active. If power isinterrupted the RSU will
stop logging data.

Dropped to IDLE (No hits)

The RSU stopped logging because no hits were detected for seven days.

©2013 MetroCount® - - MTE User Manual
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Battery Levels

Non-rechargeable Main Battery

O
QO
For RSUs with a non-rechargeable battery pack, the RSU Status gives an estimated number of days of continuous &
use, until the pack will need to be replaced. This estimate is based on the typical discharge curve for a battery pack Q
supplied by MetroCount. =
Q
RSU Status - Channel 0 i e 2
Data | ASU | Battew |Hits | Memory|
Main battery Rém backup
6.5 Main battery - replaceable alkaline calls a5
I 3.81
EH|  statistics
These values are estimates only.
Battery life is dependent on a number
of factors including age. temperature
and amount of time the unit iz active.
See the documentation for further
details. 25
52 Active life remaining. 282 days 50
50
Percert remaining.  95%

RSU hattery status

When the battery voltage enters the yellow region of the graph, areminder to replace the pack will beissued. Oncein
the red region, the battery should be replaced before any further use.

RSU Status - Channel 0 [
|Data [RSU | A Batey |[His | Memory
Main battery RaM backup
65 Main battery - replaceable alkaline cells a5

Main battery getting lowl

Object:

w |Ma|n battery

Details:
Feplace soon!

)

Battery warning message

Even if the voltage isin the red region, the battery pack still has sufficient power for the RSU to communicate,
unload any data, and retain data amost indefinitely. The RSU will automatically shutdown below the red region to
ensure communication will still be possible.

Some RSUs have a separate RAM backup battery to retain the RSU's memory while the main battery is changed.
Thisisautomatically charged from the main battery.

©2013 MetroCount® - - MTE User Manual 11




Rechargeable Main Battery

To ensure optimal capacity and service life, RSUs with rechargeable main batteries should have their battery voltage
kept in the green region at all times. Actual days of use between charging will vary depending on the age of the

battery.

RSU Status - Channel 0 ‘

[

Data | ASU | Batt

Sty |H\ls I Memory‘

Main battery

5.5 HMain battery - rechargeable SL&

Warhing

The main baltery should be kept in the
qreen zone at all limes. Allawing the

] wvoltage to drop below this level wil

sigrificantly reduce the life of the main
battery.

RaM backup

448

Closs

RSU hattery status (rechargeable)
Running the main battery down to the red zone may result in irreversible damage to the battery, and it will probably

need to be replaced.

©2013 MetroCount® - - MTE User Manual
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Memory Usage

RSUs dedicate their entire memory to the current survey, and data must be unloaded onto a PC before the next setup.
The RSU's Operator Guide lists an approximate hit capacity for each RSU memory size. Obviously the higher the
traffic volume at a site, the shorter the survey that can be conducted. Once full, a RSU will stop logging data, and

return to its idle state.

A RSU's status reports the percentage of capacity used so far, and an approximate time remaining until full. Thisis
simply extrapolated from the amount of data logged and the Run Time (time elapsed since the RSU was setup).

RSU Status - Channel 0 ‘ ==

Data | RSU | Battey [ Hits | Memony |

O
o
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Total memory 2080768 bytes
Used so far 229451 bytes (11.03%)

Wemory used
11%
0% TI% 0% 100¢
Note: The follawing are estimates only Confidence 11.03%

Estimated time ta run 1004 hr

Estimated full ime  10:16 Wednesday, 26 December 2007

Close

Checking memory usage
When checking a RSU's status, warning messages will be issued if the unit is more than 90% full.

RSU Status - Channel 0 [ ]

[Data [ RSU_ | Battery [ Hits | D\ Memory |

Total memory 2080768 bptes

Used sofar 2015232 bytes (36 85%) | Hmm.. _
Memory used L ow memow\
7%
Object:
w |M emory
Details:
0% 5% 90% 100
b ermary is mare than 307 full -

Estimated full time 0332 Friday, 16 November 2007

Mote: The following are estimates only Confidence 96.85% —| i
Estimated time to run 35 pr E

Clase

Memory usage warning message
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Sensor Statistics

The Sensor or Hit statistics can be used as arough guide to the quality of raw datalogged by a RSU.

RSU Status - Channel 0 " o | go-
s
Data | ASU | Battery| Hits | Memon @]
Property Value %
Total & Hits 47em2 z
Registered 4 Hits 47802 [(100%) —
Rejected A Hits 0[0%] o
>
Tatal B Hits 47802
Reaistered B Hits 47802 (100%)
Rejected B Hits 00%)
Total Ratio 478 100%
Registered Ratio A/B 100%
Analysis
Sensors are matched within 5%
l 4 . ] 3
_ — )

Checking sensor hits

Parameter Description

The sensor Total counts are the total number of hits detected by each sensor.
Registered represents the actual number of hits stored in memory.

Ratios Ratios between the number of hits on each sensor.

Conclusions and warnings related to the sensor totals and ratios. Warnings will only be
issued if thereis at least 200 axle hits on both sensors.

Totas

Anaysis

When using a Classifier Sensor Layout, a 100% match between A and B sensor hitsisideal. In reality, there will bea
dlight difference due to extra or missed hits.

A variation in total counts of more than 5% will give a Sensor Imbalance warning, highlighting a potential sensor
problem at some point during the survey. The best way to examine if a problem with data quality existsisto unload
the data and examine a plot of sensor hits, to determine where the mismatch occurred. For example, if a sensor
problem started late in a survey, and there is sufficient usable data at the start, then the mismatch is not an issue.

RSU Status - Channel 0 =]
Data | ASU | Batteny| A\ Hits | Memary
l

Froperty Value e - )
Total & Hits 47802 - -
Registersd & Hits 47802 [100%] Sensor imbalancel
Rejected A Hite 00

Object:
Total B His 15042 @ ensoes
Registered B Hits 45242 100%) Details
Rejected B Hits 010z] There may be a problem with sensor balance! Please check count details, -
Total Ratio A/ 106%
Registered Ratio &/8 106% s
\ — =

Analysis

] There is mare than 5% mismatch between sensors

< i ] ’

Sensor imbalance warning
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A Sensor Imbalance warning may also be triggered if more than 10% of the total hits are being removed by the
debounce filter. For example, this can be caused by an incorrectly installed sensor, or vehicles traversing the sensors
at an angle, giving multiple, closely-spaced hits. Again, it is simply awarning that there is something unusual about
the data.

RSU Status - Channel 0 _ &

Data | RSU | Battery | /N Hits | Memary
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Property Yalue
Tatal A Hits 47802
Reaistered A Hits 47802 (100%)
Rejected A Hits 0[0%]
Total B Hits 57427
Pe %)

Rejected B Hits 9811 (17.1%)

Total Ratio &/8 832%
Reqistered Ratio A/ 100%

Analysiz

There iz more than 16% mismatch between sensors

o

Hore than 10% of sensor hits are being removed b

Close

Rejected hits warning
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RSU Setup

Overview

This section introduces the fundamental software concepts associated with setting up a RSU. For important issues
relating to physically installing a RSU, refer to the Roadside Unit Operator Guide for the corresponding model of

RSU.

Starting a RSU is an extremely simple process of describing the site viaa set of setup parameters, and specifying a
start time. For the most part, the setup parameters are purely descriptive, and do not affect RSU operation. The RSU
continues logging until stopped, or filled to capacity.

For simple, infrequent surveys, RSUs can be easily configured on site. For planned surveys, Site Lists simplify the
process even further, and minimize user error.

Setup Parameters
Site

The Site parameter is user-defined and may be up to 20 characterslong. Thisis commonly used to represent the
name or serial number assigned to the site where the RSU is placed.

The Site parameter is used as the first part of a dataset's filename when unloading data.
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Attribute

The Attribute parameter is user-defined and may be up to 25 characters long. Thisis commonly use for site
coordinates, or sub-grouping sites, for example by suburb or county. The Attribute parameter can be optionally used
for grouping datasets into different folders when unloading data.

Operator

The Operator parameter is the initials (up to three characters) of the RSU operator's name. Thisis useful for
identifying field operators if they need to be asked about a particular survey.

Start Time

A RSU becomes active once it is setup, however the logging of sensor hits can be deferred for up to 10 days. This
feature is useful for conserving memory by only logging during the specific period of interest. It is also useful when
aRSU isto be setup in the office and placed in the field some time later.
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Note that a survey end timeis not specified. The finish time of the datais set at the point the RSU is unloaded and/or
stopped. MCReport provides tools for selecting a report's period from the available data.

The default setting isto start logging immediately. To defer logging, any time in the next 10 days can be manually
specified, or several automatically calculated boundaries are provided.

"
Roadside Unit Start Time @
Set the time for the Roadside Unit to start. The unit can
be deferred for up to ten daps.
Start time:
[Start immediately VJ
16:06 Tuesday, 20 Novernber 2007
Start on next hour g
Start on next day )
Start next Monday

Start next S aturday

Deferring RSU Start Time

Sensor Layout

Layout Options

A RSU can beinstalled using avariety of Sensor Layouts, to obtain either classification data using a pair of sensors,
or event-count data from a single sensor. The Sensor Layout describes the configuration of the sensors for use by
MCReport during analysis - it does not affect the operation of the RSU. The options for Sensor Layout will change
depending on the model of RSU connected.

Roadside Unit Setup

Set site information here

Site Attribute Operatar

MCHE (32,0816 +115.753060]  GC

Start time:

Inmediately
Site dezcription

O'Canner Closs narth of Rolingon <S0kméhs

Sensol layout | Lockaut (ms)

4xle sensors - Pained [Class/5pssd/Count] 10 St Lackout

Likle
Aule
Aule senzars - Split (Count]

0 - Unused or unknown,

0 - Unused or unknoven,

0 - Unused or unknoven,

Spacing
1000 mm -3t 34 in [ SetSpacing |

Selecting Sensor Layout

Note: For Sensor Layout recommendations and limitations, refer to the Roadside Unit Operator Guide for the model
i : : of RSU.
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Axle Sensors - Paired (Classifier Layout)

Axle Sensors - Paired, also referred to as a Classifier Layout requires apair of parallel axle sensors (tube/hose or
piezo sensors) spaced a known distance apart. Thisisthe most commonly used sensor layout asit gives the best
value-for-effort in terms of the wealth of information that can be obtained from the raw data. MCReport partitions

the raw hits into vehicles, and calculates vehicle class, speed, direction, headway and so on.

Roadside Unit Setup

Set site information here

Altribute
[-32.081102 +115.753860]
Start time:
Immediately
Site description
O'Canner Close narth of Rolingon <S0km#hs

Operatar

o ]

Start time.

Senzol layout

Lockaut [ms)

[Ax\e sensors - Paired [Class/Speed/Count] -

| [EX [ SetLockou |

Direction Lane
438 [ 7 - Horth bound &2B, South bound B | 0

=

0 - Unused or unknown,
0 - Unused or unknown,

0 - Unused or unknoven,

Spacing

=
=

1000 mm -3t 34 in [ 5ot Spacing |

[ Cancel ]|

Axle Sensors - Paired

This Sensor Layout provides one Direction option (either unidirectional or bidirectional) and one Lane designator.

The Spacing between the sensors must also be specified.

Axle Sensors - Separate or Split (Count Layout)

The Separate and Split layouts can be used to obtain short-term counts of raw hits or events, but not classified
vehicles. These layouts are useful for sites where a Classifier Layout isinappropriate, such as multiple lanes with

traffic flowsin the same direction.

A Separate layout indicates the event counts on each sensor bear no relationship, such as being on opposing

carriage-ways.

Roadside Unit Setup

Set site information here

Site Attribute
MCHG
Start time:
Immediately

Site description
0'Connor Clase north of Rolinson <50kméhy

[-32.081102 +115.753860]  GC

Operatar
Start time...

Sensor layout

Lockout [ms]

[Ax\e senzors - Separate [Count)

B (EE [ setLockut

Direction Lane
4 [1.- Noth bound -1

& 3~ South bound

i

0 - Unused or unknown,
0 - Unused or unknown,

Spacing

1000 mm -3 ft 34 in Set Spacing

Axle Sensors - Separate

A Split layout can be used to differentiate event counts across a pair of lanes. Using apair of sensors (one long and

one short), the short sensor gives one lane, and the long minus the short gives the other lane. Using additional RSUS,

this method can be extended to more than two lanes.

When selecting either of these layouts, a Direction and Lane number are available for both inputs.

©2013 MetroCount® - - MTE User Manual

18

O
QO
L
V)
Q)
e
®
o
=3
o
=}




Roadside Unit Setup

Set site information here

Site Attribute Operatar

MCHE [32.007102 +115.759060]  GC

Start time
Immediately Start time.

Site dezcription
O'Canner Closs narth of Rolingon <S0kméhs

Sensol layout Lockaut [ms)
sl sensors - Spit (Sount) B [EX [ setLockout |

Direction Lane
& [1 - Notth baund -1

B (1 - Notth baund |2 B
7 = |3

0 - Unused or unknoven,
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0 - Unused or unknoven, 1

Spacing

1000 mm -3 ft 34 in Sel Spacing

Axle Sensors - Split

Vehicle Sensors - Separate (Count Layout)

The Vehicle Sensors layout is available for RSUs with vehicle sensors (loops). The layout assumes a single sensor
per lane, to provide vehicle counts. A direction and lane designator is available for each input.

Roadside Unit Setup

Set site information here

Site Attribute Operatar

MCHE (320071102 115759060 GC
Start time:

Site description
O'Canner Closs narth of Rolingon <50kméhs

Sensol layout Lockaut [ms)
Vehicle sensors - S eparate (Court) | =0 Set Lockout

Direction

4 1 - Notth baund
0B [ 1 - Notth baund

1 [1 - Notth bound ==
18 [1 - Hoth bound

Spacing

1000 mm -3 ft 34 in Sel Spacing

Vehicle Sensors - Separate

Site Description / Text

The Site Description parameter may be up to 70 characters long. It is used to identify a survey site. It is useful to
settle on a convention, such as the road name and nearby intersecting roads, landmarks or sign posts.
A site's posted speed limit (PSL) can also be entered into this field. MCReport will optionally scan for a speed limit
in the following form:

e Must be enclosed in angle brackets < >

« Default iskm/h. Append an'm' or 'M' for mph.
» The speed limit can appear anywhere in the description, but other angle brackets cannot be inserted when using

thisfeature.
Example Site Descriptions
km/h mph
Hay St <60> <40 mph> Speed test, Euston Road
<60km/h> Hay Street ACPO test, Harrow Road <40m>
Hay St, <50 km/h> study Harrow Road, PSL=<40 MPH>
Direction(s)

The Direction parameter specifies the approximate direction vehicles at the site are headed, or the overriding
direction of a carriageway of afreeway or highway. Direction is specified as north, south, east or west bound, soitis
simply a matter of selecting the compass point that best approximates the actual direction of travel.

For aClassifier Layout (pair of sensors), the direction a vehicle was travelling is determined by the sensor that was
hit first. Vehicles travelling from A to B is known as the primary direction, and vehiclestravellingfrom B to A is
called the secondary direction.

There are eight direction codes to choose from. The first four are for single lane sites, and only the primary (A>B)
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direction is specified. The second four direction codes are for bidirectional sites, and both the primary (A>B) and
secondary (B>A) directions are specified.

2-
3 - South bound, & it first

4 -West bound, & hit first

& - South bound &, Morth bound B4,
6 -*west bound 4B, East bound B4,
7 - North bound A> B, South bound BxA.
& - East bound A>B. West bound B4,
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Direction Codes

Remember that the direction code is a purely descriptive field, for reference during data analysis. For single lane
sites, vehicles travelling in the secondary direction (for example, overtaking) will still be logged. The RSU does not

filter vehicles.

When using a Count Layout, the analysis software has no concept of vehicles, so the concept of A>B and B>A is
dropped. A second direction code is provided for Separate mode, when the A and B sensors can be placed
independently.

Lane

The lane number is used to distinguish data collected from multiple lanes at one site. By convention, alane number
of zero (0) is used for single-lane or bidirectional sites.

For multi-lane sites where multiple RSUs are required, each should be setup with a unique lane number starting at 1,
through to a maximum of 15. When datais unloaded, the lane number isincluded in the file extension of the
suggested dataset name. For example, the files for a multi-lane site with two RSUs can be easily recognised as
having the same file name with .ec1 and .ec2 file extensions respectively.

A consistent numbering convention will help differentiate datasets. For example, number the lanes consecutively,
start at one (1) from the west (north-south roads), or north (east-west roads).

Lockout

For RSUs with axle-sensors, the Lockout timeis used to eliminate spurious, closely-spaced sensor hits, primarily to
avoid wasting data storage space. Extra hits that are actually logged will be filtered out by the data analysis software.

The Lockout setting specifies the time period (in milliseconds) after alogged sensor hit, for which further sensor hits
will be rejected. The recommended Lockout setting are:

e 10msif the sensor spans multiple lanes, and

« 30msif the sensor spans asingle lane.

For RSUs with loop sensors, the Lockout time is used to eliminate multiple counts for long vehicles where the loop
may "untrigger" mid-vehicle. The default setting is 350 milliseconds.

Spacing
The Spacing parameter specifies the distance between the sensors when using a pair of sensorsin a Classifier
Layout. This parameter is disabled when using a Count Layout.

MCReport is optimised for a spacing of one metre (three to four feet). A longer spacing of up to three metres (or 10
feet) can be used for improved speed accuracy.

The spacing is stored by the RSU in millimetres. During setup, the spacing can be entered in either metric or
non-metric units.

Spacing may be entered in either units

e : T ]
e JESES
T r Mehic Spacing
1000 Milimetres

Mon-metric Spacing

3 Feet 34 Inches

i) ()

Spacing can be entered in metric or non-metric units

Site Location

M CSetup provides the option to store a site's coordinates (latitude and longitude) in the Attribute field. Coordinates
can be entered manually, or read from any serial GPS unit that supports the NMEA 0183 data format. The serial port
used by the GPS unit is set in MCSetup's Preferences. USB and Bluetooth GPS devices usually create a virtual serial
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port that can be used by MCSetup, provided other GPS software it not using the port.

Site location

Lacation
Roadside Unit Setup g Deg
¥ Latiude 32081101681 0

| Set site information here

Longitude 11575386 0

Site Attribute Operatar
MEHD (32081102 +115.753860] | GC || Location.. ]] GPS - NMEA 0183C
Start ime GPRMC, 125041 00,4, 3204 8661 5 11645 2316,E.0.00,100 31,210408, D*77

Immediatels Start time... UTC time:  025041.000

Site description TR
O'Connor Close north of Ralinson <Stkm/hy Signal quality.  Valid - Diff,

Satelites: 3

O
o
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Q)
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Lackout [ms)

Sensor layout
| [ setLockout | Alitude

[ sl sensors - Paired [Class/Speed:Count] BED

Direction Lane DGRS update: 0OOO
AB [7 - Narth bound A28, South bound B V] o —_—

DGPS name:

0 - Unused or unknovn

-ty wtoms <o ] ) KB

0 - Unused ar unknowr. M ; ___________ MC: Foints; 240

[satelite view Get GPS

Spacing

1000 mm -3 ft 3.4 in Set Spacing Cancel _UK
- | Pack coardinates inta RS Attribute F\aldl K, Cancel

Using a GPS unit to set a site's location

MCSetup's GPS interface is accessed via the Location button in the Setup dialog box. The Get GPS button at the
bottom will start taking continuous readings.
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Setup Procedure

A setup operation transfers a new set of setup parametersinto the RSU's header, and sets the RSU active, effectively
erasing the previous set of data.

Note: A data protection feature prevents a RSU from being setup if the RSU has not been stopped using the normal
A unload procedure. If the RSU's data is not required, its status can be quickly cleared by performing a Factory Setup.

It is good practice to check a RSU's status before and after a setup. Before, to check the unit is successfully
communicating, and afinal check of battery levels. After, to verify the setup was successful, and the RSU is active.

When performing a setup, the initial setup values are taken from the RSU's current header. This featureis useful
when aRSU is close to or has reached full capacity, and further datais required from the same site. After the existing
data has been unloaded and the RSU stopped, restarting the RSU does not require the setup parameters to be
re-entered. Multiple datasets from the same site can be easily combined into a single report in MCReport.
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Note: RSU's do not have a real-time clock. The PC'stimeis stored in the RSU's header at setup, and the
& time-stamped hits are referenced from this time. Remember to check the PC's time regularly!

oE To setup a RSU

v . 1. Connect aRSU and click the Setup button on M CSetup's main toolbar, or type Ctrl + s.
2. Fill in each of the setup parameters as described in the previous section.
3. Click the OK button to send the setup information to the RSU.

Each of the setup parameters will be automatically checked before sending to the RSU. If any of the values are
outside of their allowable range, a warning message will be displayed, indicating the setup parameter that isin
error.

Hmm...

Walue out of range!

s

Details:
The value must be between 0 and 25 characters.

Example setup parameter warning
4. Check the RSU's status to confirm it is active.

5
RSU Status - Channel 0 ==
m‘ Battery | Hits | Memary

Property Value
Ident. 2 N2DOMPRS MCS6-LS [MESS] (cMicracom 190ct04
RSU MCSE00
Batteries  Main=B.01. RAM=3 86, M=6.01V, R=3 85/]

Memory  Ulsed=000% [0 of 2080768) [HI=01, LO=4000]

Setup Time 1334 Wednesday, 21 November 2007
Start Time 1234 Wednesday, 21 November 2007
Finish Time  13:34 Wednesday, 21 November 2007
Fun Time 0 days 0 hr 0 min

Status [0480] Roadside Unit ACTIVE: Running narmaly

< . ] 3

Close

Check the RSU is active after a setup
5. Usethe Sensor View to verify sensor operation.
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Sensor View

Overview

M CSetup provides several real-time views of the data being logged. The choice of view modes depends on the type
of RSU connected, and the unit's current configuration and setup.
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oﬁ To view sensors in real-time
g 1. Setup aRSU, and click the View button on MCSetup's main toolbar.
2. TheView mode dialog box will appear if more than one mode is available for the connected RSU. Select one
option and click the OK button.

View mode

Show sensor hits as.
@ Rolling time picture
) Vehicle list

() Axle timings

Selecting a View Mode

Rolling Time View

The Rolling Time view displays a variable-width window of recently logged sensor hits. As vehicles pass over the
sensors, the logged hits are displayed on the time-line at the top, providing confirmation of correct sensor installation

and RSU setup.
1 ' Rolling time view =)
A - upper track, B - lower track.
[ o e oo LY "
[ - (X3 (3
Time width = 3 seconds

Speed = 81.6 Km/h, 50.8 mph Last Aixle = 15:50:16

Snapshat of rolling view
[ (X
I e

Time width = 3 secands

Rolling Time View

When using a Classifier Layout, there should be matching A and B sensor hits for each axle. The offset between
matching hits is determined by the speed and direction of the vehicle. An approximate speed is displayed for the last
pair of matching hits.

The Time width slider bar determines how many seconds the rolling window represents. Increasing the display width
will increase the number of axles visible at atime, but will decrease the resolution.

Note:

& The Last axletimeis the time-stamp of the last logged sensor hit, giving the current time according to the RSU. Over
the period of a survey, this time may drift from the time of the PC used to setup the RSU. If syncing manual counts at
the end of a survey, remember to use the last axle time, not the PC's time.

The Grab button copies the current time picture to the snapshot picture at the bottom.

Vehicle List View

The Vehicle List mode provides a basic, on-the-fly partitioning from the immediate hit stream being logged by the
RSU. It includes an array of information about each vehicle and a scaled wheel picture. The Vehicle List modeis
only available when a Classifier Layout is used.

Note: The Vehicle List mode should only be used as a rough guide. VVehicles are formed by joining hits less than a
& fixed time (DeltaV) apart into a vehicle. Remember that in this mode, the RSU is logging time-stamped sensor hits -
not vehicles. MCReport uses a more advanced partitioning algorithm.
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B Traffic view ‘. 2 =0rer W
Time Dir Wel Wb Ax  Gp  Er Wheel Picture - Metic [, ol
155248 A-B E2E 260 12§ 000 000 000 OO0
156286 AxB E9.7 28 2 2 oo
155301 AxB E75 27 2 2 oo D
155305 AR 59.2 23 2 2 oo Q
155315 AxB E0.8 113 B 3 000 000 E)"
158321 AB 70.8 B8 4 2 o0 a0 5
16229 AxB Al 67 3 3 oo o Q
155337 AxB as.2 232 3 4 000 000 000 —
155356 AB E7.5 16 2 1 o0 ]
155363 AxB E45 24 2 2 oo 2!-
I 155402 AR a1.8 28 2 2 oo L4 o
156406 AxB 80,0 24 2 2 oo S
1RR4NG AR BN & EE I R an X
|
“e— —_— —t

Viewing sensor hits partitioned into vehicles

Parameter Description
Time Time of the first axle of the vehicle.
Direction (Dir) |Direction of the vehicle.
Speed of the vehicle. Units may be km/h or mph, depending on the selection of unitsin

Velocity (Vel) MCSetup's Preferences.
Wheelbase of the vehicle. Units may be metres or feet, depending on the selection of unitsin
Wheelbase (Wh) MCSetup's Preferences.
Axles (AX) Number of axlesin the vehicle.
Groups (Gp) Number of axle groupingsin the vehicle.
Error (Er) Error number indicating a mismatch in sensor hits.

Wheel Picture |Character based representation of vehicle axle groupings.

This setting is the minimum gap in the hit stream that M CSetup uses to separate vehicles. Note
that this Delta-V setting does not affect the data that is being logged.

Deltav
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Axle Timing View

The Axle Timings mode displays the raw hit information that the RSU islogging. The Axle Timings mode is only

available for a Classifier Sensor Layout. o
Q
=l
Q

B Traffic view ‘ e @)
Time Deltad DeltaB Channel %
978,222 978.222 A g
978,269 78,269 B =
976,362 0.140 A o
978,40 0140 B )
976,440 0.077 A
978,488 0.079 B
78,612 0172 A
976,659 0171 B
78,691 o078 A
978,738 0.079 B
978,768 0077 A
978,817 0078 B

Close

Viewing precise sensor hit timing

Parameter Description
Time Time in seconds since the RSU was setup.
DeltaA Offset in seconds since the last A sensor hit.
DeltaB Offset in seconds since the last B sensor hit.
Channel The sensor channel that was hit.
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Data Unload

Overview

The Unload process transfers a RSU's header and data to a proprietary-format binary data file known as a Dataset.
An Unload can be performed at any time, without interrupting logging. At the end of a survey, the RSU should be
stopped as part of the Unload process.

2 Note: Unloading data from a RSU does not erase the data from memory. All data remains until the next setup is
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performed, so data can be unloaded again if necessary, until the next setup.

Dataset Location

MCSetup uses the Base folder for unloaded data location specified in the Preferences to store unloaded data.
M CSetup al so supports automatic creation of afolder structure, based on a combination of a RSU's Site and
Attribute, and the current year and month. Refer to the section MCSetup Configuration for details.

Naming Conventions

When unloading data from a RSU, the dataset's filename will be automatically generated. Thisis based on the RSU's

Site parameter, and the current date.

The dataset's filename need only be unique. If afile by the same name already exists, an overwrite warning will be

displayed. There is no need to make the dataset filename descriptive. When browsing for datasets with MCReport,

fileswill always be listed by their key header details.

Note: The three character file extension is extremely important. Datasets are created with a file extension of .ecX
A where X is the lane number. MCReport uses this file extension to recognise MetroCount datasets. Do not change this

file extension.
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The Unload Process

If possible, unload a RSU's data before removing from the site. This provides an opportunity to view basic data
quality, and collect further datain the unlikely event of sensor failure. An Unload should complete in under 10

minutes, dependent on capacity.

0& To unload data from a RSU

g 1. Connect aRSU, and click the Unload button on MCSetup's main toolbar.
If thisisthe first connection to the RSU, the "New connection” dialog will appear. A quick status check prior
to an Unload is always good practice.

Unload options

Set the unload mode and file: name here

Stop the RSU after unloading data|

Suggested file name
CAUsers\MTE Demo UserD ocuments\M etroCountsMTE 3.214D atabCHE04)un2009.ECO

The suggested name is based on the data header from the Roadside Unit and option settings.

Start of the Unload Wizard

2. If thisisthe end of asurvey, check the Stop RSU after Unload option.
Upon successful completion of the Unload, the RSU will be set to its ldle state, ready for a new setup. With
this option unchecked, logging will not be interrupted.

3. The suggested folder and file name will be as described previously. In the unlikely event that it needs to be
changed, click the Change name button, remembering to keep the .ecX file extension.

4. Click the Next button to continue the wizard.

5. A confirmation dialog box is shown next, with any folders that will be automatically created shown in bold.
Click the Start unload button to continue.

| Confirm unload destination

The file path is shawn here

The path and file shavn in bold will be created.
@ O
2 Users
- MTE Dema User
- Documents
£ MetioCount
=@ MTE 321
2@ Data
MCHRO04AunZ009.ECO

File size = 269 bytes
Free space on diive = 34,56 byles Slatinioad

Confirmation of folders and dataset to he created
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6. During the Unload, adynamic plot of the A and B hitsis displayed as the dataiis transferred. For ideal
classification data, the A and B plots will perfectly overlay.

CAUsers\MTE Demo User\Documentsi\MetroCount\MTE 3.21\Dats\MCHO04Jun2003.ECO
O'Canner Close narth of Rolinson <50km#hs

209-

B
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Be <1335 30 May 09 1335 04 Jun 09 >

3 - Unload complete. Made: Unload then STOP.
2-Speed = 38400bps Block = 952

1-Unload started Eytes wiitten = 229254
Rate = 2841 bytes/sec

i S

Unload progress showing sensor hits

7. When the Unload is complete, click the Close button.
If the option to stop the RSU was checked, use a quick status check or the RSU's status LEDs to verify the
RSU is now inactive, to prevent unnecessary battery drain.
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Overview

Site Lists provide an excellent means of managing the process of collecting data. Using the familiar RSU setup
diaog box, site setup information can be compiled into associated lists. Field setup then only requires connection to a
RSU and selection of asite from a Site List. Thisremoves the need for any manual entry in the field, greatly
improving efficiency and accuracy of setup, especially with Pocket PCs.

Site Lists are created using MCSetup, and can be used in either MCSetLite or MCSetup. Site Listsare stored in a
simple comma-delimited text file, so they can aso be created and edited using a spreadsheset program.

2]
=
D
L
@
—~
7

£ iz |MCsetLite P & 4£ 248
Storage Cardstiring3a. sit

[ ttribute | Start -
Stirling Irnrmediately
Stirling Immediately  |_
Stirling Innmnediately
Stirling Immediately
Stitling Imnrnediately
Stirling MNesxt Hour
Stirling Mext Hour
Stirling Mext Hour
Stirling Mext Hour
Stitling Mesxt Hour
Stirling MNesxt Hour
Stirling Immediately | —

Et\rhmq‘ Irnrnediztel hd
]

HEEEEIE &
MCSetLite with a Site List loaded
M CSetup supports afew advanced Site List features not supported by MCSetL ite, including:
» Maps based on bitmap images, with support for common compressed bitmap images.

» Checklist feature for tracking sites that have been setup, and unloaded.
 Site List usage enforcement, to force RSUs to be setup from a Site List.

Note:
& A Site List window in MCSetup is split into two panes, called the List pane and the Map pane. Most Site List
operations are performed by right-clicking in one of the panes. Each pane has a different menu.

Bl stirting3n.sit

Site,lane | Attribute | D.. Start Deb Description 4l £
5 Innmediatel 0-10  Tusc

0 silng 5 ; 10 Tusc| DR
EJos.n stirling 5 Immediately - Tus| Cdtste
HJo4n sting 5 Iomedistely  10-10 Ly Fomoveske ;)
HJos.o string 5 Inmeditely  10-10  Lued 00N
¥ HJos.1 stiring 4 MextHour  30-30  Hale oeebstat®
¥ @62 stiing 2 MetHor 300 Hale OPOTTES
@ Eora string 4 HNext Hour 30-30  Hale|  Maintain maps
@ or.z stiing 2 Next Hour 30-30  Hale Road- Waf P
g JJoao stirling 6 hext Hour 10-10 Cromarky Road - '
¥ TJoa.0 stiling 6 Mext Hour 1010 Cromarty Road - E
@ &Ji0.1 Stiing 3 Immediately  30-30  Empire Avenue -N
@ &Jioz stling 1 Immediately  30-30  Empirs Avenus - N
@ %11.1 Stirling 3 Immedistely  30-30  Empire Avenus - S
[son] Egn.z Stirling 1 Immediately  30-30  Empire Avenue - 5 ¥
@ 5912.1 Stirling 3 Immediately 30-30 Pearson Street - N ¥ ¢ v
< | > < |

Site List with map in MCSetup - note the right-click menu
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Site List Construction
Creating Site Lists

Newly created Site Lists are stored in the folder specified in MCSetup's Preferences. The default location is the User
\ Sites folder located where MTE isinstalled.

A single Site List may contain thousands of sites, however small groups of related sites per Site List is much more
practical.

aﬂ To create a new Site List
g 1. InMCSetup, select File » New Site List.
2. Inthe New Site List file box, enter afilename.
3. Click the Save button and an empty Site List will be displayed.
Existing Site Lists are opened by selecting File » Open sites.
When a Site List is closed, MCSetup will ask to save any changes.

Editing Sites
Adding sitesto a Site List uses the same dialog box used for RSU setup. The default setup parameters used for the
new site can be copied from an existing site, or copied from the header of a RSU.

oE To add a new site to a Site List
" 1. Right-click in aSite List'slist pane, and select New site.
Right-click on an existing site to use its parameters as a starting point.
2. 'llj'o create anew site from a RSU that has been manually setup, check the Get initial settings from Roadside
nit option.

Hew site list entry.

MNew site entry
Optionally copy fram Roadside unit

The initial values for this new site item can be read from a Roadside Unit directly. Check.
the box below to enable this feature.

[] Get initial settings from Foadside Unit

%

Optionally copy setup parameters from a RSU

3. Click the Next button to display the setup dialog box.
4. Enter the setup parameters per normal RSU setup.
Start times such as Next hour or Next day will be automatically calculated at the time a RSU is setup.

5. When done, click the OK button.
Again per normal setup, each parameter will be range-checked, and warnings displayed if necessary.

The site'sicon indicates the type of Sensor Layout selected.

Icon Description
& Site uses Classifier Layout.
Site uses Count Layout.

0& To edit an existing site
w? 1. Right-click on an existing site, and select Edit site.
2. Edit asrequired, and click OK.
To display aread-only summary of asite, simply double-click.
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Site properties 3]

01-0

Site number - Lane

Site ‘UT ‘ Attribute |Stlrlmg | LanaE
Latiude -31.924838 | Long [115784872 | %)
Iritals Spacing 5
Direction & ‘5 - South bound 4>B, North bound B4, ‘ ‘w | Db (ms] g
Direction B ‘I] - Unused or unknown. ‘ ‘m | DebB (ms] al-

Type ‘Axle sengars - Paired (Class, Speed, Cou‘

Description ‘Tuscany ‘fay - N of Empire Ave ‘

Start time: ‘Immed\atew ‘

Displaying all site parameters

0& To change the start time for a group of sites
g 1. InaSiteList'slist pane, Shift or Ctrl select a group of sites.

2. Right-click on one of the selected sites, and select Set times.
3. Confirm changing the selected sites start time by clicking Yes.
4

. Inthe Roadside Unit Start Time dialog box, select one of the automatically calculated start times. Remember,
the actual time will not be calculated until aRSU is setup.

Roadside Unit Start Time.

Set the time for the Roadside Unit to start. The unit can
be defered for up to ten days.

Start time:

Start on nest day

10:04 Thursday, 18 November 2004
Start immediate)

Start on rext hout

Stait on nest day
Start next Monday
Start hewt S aturday

Setting the start time for a group of sites
5. Click OK to apply the new start times.

Spreadsheet Editing

Site Lists' comma-separated-values (CSV) format has been designed to provide maximum compatibility with
spreadshest programs. Importing, editing and exporting a Site List through a spreadsheet program should be a
seamless process.

The first column on each row indicates the row type. METAMAP and MAP are used for including map files, DOC for
comments, and SITE for each site. For Site Lists created by M CSetup, a comment row isincluded above the site rows
to form the column headings when imported into a spreadsheet.

METAMAF, perth. npz

MAF,Churchlands.npz

MAF,MtLawley.upz

DOC,Site,Attrib, Init,Desc,Ln,Dirh,DirE, Mode,State, Spac, StrtTn,Debi,DebB, Lat, Long,
SITE,01,5tirling, RPN, Tuscany Way - N of Empire Ave,0,5,0,0,1,1000,0,10,10,-31.924528,115.784572
SITE,02,5tirling, RPN, Tuscany Way - § of Dolomite Court,0,5,0,1,1,1000,0,10,10,-31.922364,115. 786673
SITE,03,5tirling, RPN, Tuscany Way - § of Memory Place,d,5,0,2,1,1000,0,10,10,-31.920731,115. 786814

Site List CSV format

Each column must adhere to the normal restrictions for that parameter. The following table is a quick-reference.

Column Description
Site & Attrib Site & Attribute - maximum 20 characters.
Init Operator Initials - maximum 3 characters.
Desc Site Description - maximum 70 characters.
Ln Lane Number - number less than 16.

Directions A and B - for Classifier Layout use A only and leave B as zero.
e 0- Unused or unknown.
e 1- North bound, A hit first.
» 2 - East bound, A hit first.
» 3- South bound, A hit first.
e 4 - West bound, A hit first.
» 5- South bound A>B, North bound B>A.
* 6-West bound A>B, East bound B>A.
e 7 - North bound A>B, South bound B>A.
» 8- East bound A>B, West bound B>A.
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Column

Description

Mode

Sensor Layout
» 0- Axle sensors - Paired (Class, Speed, Count)
» 1- Axle sensors - Separate (Count)
* 2- Axle sensors - Split (Count)
» 3- Vehicle sensors - Separate (Count)

State

Checklist state (M CSetup only).
* 0- No state.
e 1- Site setup.
* 2 - Site unloaded.
» 3- Site unloaded and stopped.

Spacing - must be entered in millimetres (mm). Range is 200 - 3050mm.

StrtTm

Start Time.
e 0- Startimmediately.
e 1- Start next hour.
e 2- Start next day.
e 3- Start next Monday.
* 4 - Start next Saturday.

DebA & DebB

Debounce for A and B Sensor - in milliseconds (ms). Recommended is 30 for single lane, 10
for multiple lanes.

Lat & Long

Latitude and Longitude - in degrees. South and West are negative.
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Site List Usage
RSU Setup from a Site List

Using a Site List to setup a RSU is the same as the normal setup process, except the setup parameters are derived
from the Site List, rather than manual entry.
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oﬁ To setup a RSU from a Site List with MCSetLite
g 1. OpenaSiteList by selecting Tools » Open Site List from MCSetLite's menu button. Browse for and select a
Site List, and tap the OK button.
2. Select asite by tapping it.
3. With aRSU connected, tap the Setup button.
4, Tap OK to use the selected site. Tapping Gancel will proceed with anormal setup.

Cancel

Setup Roadside Unit with Sike

List itern?

Select '‘Cancel' for manual setup.,

Confirming Site List use
5. The standard setup dialog box is now displayed with the setup parameters from the selected site. Edit any
parameters if necessary.

The Lock Site List option in MCSetLite's Preferences will prevent editing setup parameters at this point. This
featureisto discourage users from changing settings away from those specified in the Site List.

El pescription

Tuscany Way - N of Empire ]

[ Description

/5 |MCSetLite ¢ o uzzos QY| /2 Moserwice o azzoe
Cancel Cancel

Parameter | Value Parameter | Value

El site o1 [ site 01

El Lare [\l [ Lane [\l

[E] Aktribute Stirling Attribute Stirling

[l Sensor La...  Axle sensors - Paired (Classisg | || B Sensor La...  Axle sensors - Paired (Classys
El irection & 5 - South bound A =6, North b | || B Direction A | 5 - South bound A=E, North b
El Debounce  A=10ms, B=10ms [ Debounce | A=10ms, B=10ms

El operatar RPN [ operator | RPN

[El Spacing 1000 mm - 3t 3.4 in Spacing 1000 mm - 5 ft 3.4 in

El start Immediately [ start Tmmediately

Tuscany Way - N of Empire v

4] [

[ [»

4 [

[ D

=B

[=[8

RSU setup from Site List - normal and locked.

6. Tap the OK button to proceed with the setup.
7. Check the RSU's status to confirm the setup.
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oﬁ To setup a RSU from a Site List with MCSetup
g 1. OpenaSiteList by selecting File » Open sites . Browse for and select a Site List, and click the Open button.

M CSetup can have more than one Site List open at the same time.
2. Select asite.

3. With aRSU connected, click the Setup button. 2
4. The selected site's setup parameters will be displayed in aread-only form. Confirm the details and click 0K to 2
proceed with the setup. 7}
(2]
Setup 3]
Site number - Lane
Site ‘UT ‘ Attribute |Stlrlmg | LanaE

Latiude -31.924838 | Long [115784872 |

Initals Spacing | 1000 mm - 3163 4in

Direction & ‘5 - South bound 4> B, North bound B34, ‘ ‘w | Deb [ms)

Direction B ‘I] - Unused or unknown ‘ ‘m | DebB (ms]

Type ‘Axle sengars - Paired (Class, Speed, Cou‘

Description ‘Tuscany ‘fay - N of Empire Ave ‘

Confirmation of site setup parameters
5. Check the RSU's status to confirm the setup.

RSU Unload from a Site List

When thereis a Site List open in MCSetup, the Unload procedure is slightly different. MCSetup will retrieve the
RSU's header, and attempt to match it to an item in the currently active Site List. Thisis to support MCSetup's Data

Collection Checklist feature.
To unload datafor asite that does not exist in a Site Ligt, firstly close all open Site Lists, and then proceed with the
Unload.

Start e | West Hour

oE To unload data using a Site List

" 1. Openthe Site List that contains the site that the connected RSU was setup with.
2. Click the Unload button on MCSetup's main toolbar.
3. MCSetup will locate the site in the Site List and start the Unload procedure.
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Maps (MCSetup)

Overview

A map in MCSetup consists of a Map File, which uses a.mpz file extension. This file contains a pointer to the
location of the map's bitmap image, and additional information about the map, such as latitude and longitude.

A SiteList can have several attached maps, with sites distributed across them. Also, a single map can be shared
amongst several Site Lists.

Each Site List can aso have a map designated as the Metamap. Thisis usually alow detail map that encompasses
each of agroup of smaller, high detail maps.

Preparing Maps
Site Lists support maps in the form of bitmap images, including common compressed bitmap formats, such as JPEG.
Such images can be sourced from many locations, including local street directories, or exported from a vector-based
mapping system.
Suitable bitmap images should contain sufficient detail to allow sites to be placed with reasonable accuracy, based on

the screen size where MCSetup will be used. Remember that multiple maps can be associated with each Site Ligt, as
well as alow-detail Metamap.

In order to use a bitmap image, the corresponding Map File must first be generated. A Map File contains a pointer to
the bitmap image for the map, and the latitude and longitude of the bounding rectangle of the map. The Map Fileis
then attached to Site Lists as required.

Note that when generating a Map File, the latitude of the top and bottom boundaries, and the longitude of the left and
right boundaries of the image will be beneficial. These coordinates are used for a number of purposes:

« Assigning coordinates to sites placed on amap.
» Locating sites on amap.
« Displaying the bounding rectangles of each attached map on the Metamap.
 Locating and placing sites using a GPS unit.
If the bounding coordinate information is not available, it is still possible to use mapsin Site Lists, however the

functionality listed above may be limited. Alternatively, for adjoining maps, simply make up coordinates that reflect
the maps' relationships. Thiswill still allow sites to be placed and located on the map.
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1. For convenience, the images to be used for maps should be copied to the Site List folder specified in
MCSetup's Preferences. The default folder isthe User \ Sites folder located where MTE isinstalled.

2. In MCSetup, select File » Create map.

3. Inthe Open map image dialog box, select an image for the new map. Note the image-type filter at the bottom.
When done, click the 0K button.

4. Inthe Map extent dialog box, enter the coordinates for the bounding lines of the map.

Coordinates south of the equator and west of Greenwich are negative.

Hap extent 3]

Please enter coordinates in decimal dearees.
Latitudes south of the equator and west of
Greenwich are negative.

oﬁ To generate a Map File
v
v

tap name
Program FilestMetroCaunt w315\ serSitesiperth. mpz

Most west longitude:
Most north titucs
Most east langitude:
Most south titucs

i Cancel

Entering the map's bounding latitude and longitude

5. Click the 0K button. A Map File with the same name as the bitmap image, and a.mpz file extension will be
created in the Site Lists folder.

Attaching Maps to a Site List

To display mapsin a Site List, the respective Map Files must first be attached to the Site List. The Maintain maps
dialog box is used to manage the list of maps associated with a Site List.

K

Maintain maps ®

Map files attached to site list, drag to change order

1z
L awley.mpz

Meta map name

petth mpz | [Metamap.. |
Attaching maps

Note that the itemsin the list have a descending priority (the top of the list has the highest priority). When locating
sites, if the area of two or more maps intersect, the map with the higher priority will be displayed.

0& To attach maps to a Site List
= 1. Right-click inthelist pane of a Site List, and select Maintain maps from the pop-up menu.
2. Inthe Maintain maps dialog box, click the Attach button.
3. Select one or more Map Filesto attach to this Site List, and click the OK button.
4. Reorder the attached maps list as required by dragging the map items.
Note that maps can be disassociated from the Site List selecting, and clicking the Detach button.
5. Click the 0K button to return to the Site List.

Navigating Maps
When placing sites on amap, the target map will first need to be selected from the list of attached maps, and
displayed. Depending on screen size, the target map may need to panned and scrolled to locate the desired position
for asite.

oE To switch the displayed map
e 1. Right-click inthelist pane of a Site List, and select Maintain maps from the pop-up menu.
2. Select the desired map, and click the OK button. The selected map will be displayed in the map pane of the Site
List.

oﬁ To pan around a map
g 1. ThePan box dialog box displays a smaller version of the entire map. The rectangle indicates the area of the
map currently being displayed. Click and drag this rectangle to display a new area of the map.
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Pan box &=

2,
—
®
C
(]
—
(2]

Panning around a map
2. Click the Apply button.

aﬁ To toggle the Site List splitter position
. . « Select View » Toggle splitter. Thiswill toggle the orientation of the splitter bar between the list pane and the
map pane.

EE®

B! stirtingan.sit ) | BB stirtingan.sit
Stelane | Attribute | D,

.0 Stitling
Stirling
.0 Stirling
.1 Stirling
.2 Stirling
.1 Stirling
.2 Stirling

QUE‘U Skitling
o S,

[RRESCRSVE T RVL ALY ¢
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Using the Metamap

The Metamap is intended to be a map that encompasses the other maps attached to a given Site List. When the
Metamap is displayed, the bounding rectangles of each of the attached maps will be overlaid, assuming the correct
coordinates have been entered for each map. Detail maps can be selected directly from the Metamap.

0& To set the Metamap for a Site List

g 1. Right-click inthelist pane of a Site List, and select Maintain maps from the pop-up menu.
2. Inthe Maintain maps diaog box, click the Metamap button.
3. Select the desired Map File, and click the Open button.
4. Click the OK button to return to the Site List.
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03 To display the Metamap

w * Right-click in the map pane of a Site List, and select Show metamap from the pop-up menu. Note that if a
Metamap has not been designated, this option will be unavailable.

0& To select an attached map from the Metamap

v « With the correct latitude and longitude entered for each map, the Metamap will contain black rectangles for the
bounding area of each of the attached maps. Right-click within arectangle, and select Find detail map to
display that location.

BBl stirting3n. st

Sike.lame  Atbri,, D, Stark Deb Description ~ Mithoed Bamch — i = i I -~
EQDI‘U Stiving 5 Immediately  10-10  Tuscany Way - Nof ) 3 W h %
FJo2.0 Sting 5 Immediately  10-10  Tuscany Way - Sof - [ ot ey
HJos.0 sString 5 Immediately  10-10  Tuscany Way - S of Bpacn i
QEHB Stiting & Immediately  10-10  Lucca Skrest - Sof ¢— ol B‘h“ ' | - —
Fdoso string 5 Immediately  10-10  Lucca Street - Sof b e a Skl LLL
W Egom Stiting 4 Mexk Hour 30-30  Hale Road - E of Lu = § ' gl
@ 9Jo62 Stilng 2 MextHow  30-30  Hale Road-E of Luc Searbeuy T
@ WJoz1 stding 4 MextHour  30-30  Hale Road - W of Pe | z
@ Moz stiding 2 MestHour  30-30  Hale Road - Wof Pe
g JPoao strlng 6  MextHow 1010 Cromarty Road- W P es
@ ZJoao stiing &  MextHow 1010 Cromarty Road-E¢ T =
@ @J10.1 Stilng 3 Immediately  30-30  Empire Avenue - N ¢ N I
@ Bz siling 1 Immediately 30-30  Empirs Avenue - Mo Y J ey o
@ E;h 1.1 Stiring 3 Immediately  30-30  Empire Avenue - 5¢ v —
[sen] 931 1.2 Stiring 1 Immediately  30-30  Empire Avenue - 3¢ CatnabpBeach | I‘L . 'r\)! !
[s:n] 9312‘1 Stiring 3 Immediately  30-30  Pearson Street - N ™ ! N p.; Lil ]A > 2 Pl
£ | b4 £ | ?

Example Metamap - the bounding rectangles are the attached maps
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Placing Sites on a Map

Each sitein a Site List has an associated latitude and longitude for placing and locating the site on amap. The
location of a site can be set in anumber of ways:

» Create anew site directly on amap.

» Drag an existing site onto the map.

¢ Manualy enter asite's coordinates.

» Use a GPS unit to automatically set a site's coordinates.
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Using the first two methods described above, the site's coordinates are derived from the map's bounding latitude and
longitude coordinates.

Using the last two methods where the coordinates are specified, if one of the attached maps contains these
coordinates, MCSetup will automatically display the site on that map.

0& To create a new site on a map

v 1. Display the map that will contain the new site, and scroll to the desired location.
2. Place the mouse pointer at the precise location, right-click and select New site from the pop-up menu.
3. Follow the usua procedure for adding a site.

0& To place an existing site on a map
v 1. Display the map that will contain the existing site, and scroll to the desired location.
2. Inthelist pane, locate the site to be placed on a map.

3. Click-and-drag the site onto the map, dropping it at the precise location. Note that a group of sites can be
selected and dragged to place them at the same location, such as multi-lane sites.

4. Confirm the site location by clicking the OK button. The selected site(s) will appear.

oﬁ To manually enter a site's coordinates
w? 1. While creating or editing a site, click the Location button.

2. Enter the coordinatesin the Latitude and Longitude edit boxes. To enter the coordinates using Universal
Transverse Mercator, click the UTM button, and enter the site coordinates using Eastings, Northings and the
UTM zone.

Site location %] UTH converter 3]
Location
South and ‘West are negative degress. UTh locstion

Deg Min Sec Elipsoid: | WiE584

Latitude ‘-31.91?835 ||u | |D | Northing:

— b ]
Longitide | 115733065 | [0 |[o | Eastng: 0|
e

Zone:

“
m
m

GPS - MME& 0183

GPS signal quality

Number of satellites in use:

Antenna altitude:

Seconds since last differential update:

Ditferential reference station name:
Take reading

Setting the coordinates for a site
3. Click the OK button to update the site's coordinates.

Locating Sites

Using a Site List's attached maps is the simplest method for locating the correct list item for agiven site. Once a site
has been located on a map, MCSetup can automatically select the corresponding item in the list pane, which can then
be easily setup. Conversely, MCSetup can automatically display the map location for a selected site in the list pane.

03 To toggle the site highlight

e » Double-click amap, or right-click a map and select Flash sites from the pop-up menu. Thiswill shade the map
to make visually finding sites easier.

0& To locate a site from a map

v » » Locate asite on amap, right-click on top of the site, and select Locate site from the pop-up menu. The
corresponding site will be selected in the list pane. Note that if there are multiple sites extremely close together
at the point selected, all of those sites will be selected in the list pane.
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oﬁ To locate a site's location on a map
= 1. Inthelist pane of aSite List, right-click asite to be located, and select Find on map from the pop-up menu. If
the site can be found within one of the Site List's attached maps, M CSetup will display that map with the
selected site centred in the Map pane. The selected site name will also be displayed in red.
2. MCSetup will automatically enable the site highlight feature that will shade the map. If necessary, double-click

the map to turn the shading off.
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Data Collection Checklist (MCSetup)

The Checklist feature provides a basic means of tracking the setup and data collection of a group of sitesin
MCSetup. An icon next to each site indicates the current state of the site. Initially, the Checklist icon will be blank.

M CSetup will automatically change thisicon when a site is setup, and then when the site has been unloaded, and ]
ultimately stopped. 0}
L
Icon Description &
Site has been setup. (Survey started)
¢ Site has been unloaded, but not stopped. (Mid-survey
inspection)
@ Site has been unloaded and stopped. (Survey compl ete)

oﬁ To reset the Checklist icon for a group of sites
e 1. InaSiteList'slist pane, Shift or Ctrl select a group of sites.
2. Right-click one of the selected sites, and select Reset states from the pop-up menu.
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Enforce Site List (MCSetup)

The Enforce Site List feature only allows RSUs to be setup from a Site List, by disabling the Setup and Unload
buttons when there is no Site List open. Enforcing the usage of a Site List ensuresthat a given site existsin a Site

List, and that a RSU was setup adhering to that information.

When the Enforce Site List feature is enabled, a Site List must be open to make the Setup button available. When
unloading data from a RSU, M CSetup will attempt to match the RSU's header to a site in the currently active Site

List. Unloading of the datawill only continue if the site is found.

M HCSetup.

File ¥iew Roadside Unit Technical Window Help
fcomt [ Pus | Single channel 7 E45127D' MC56-5 [MCSS] (c)Micranom 02/03/01

Use Chrl (r,5,u, v, c) keys to access toolbar, Alk key to enter menu,

Effect of the Enforce Site List feature

A further option exists to prevent accidental editing of Site Lists. In order to change a Site List this option must be
toggled.

Both options can be found in MCSetup's Preferences.

Preferences 3]

Cammunications part
[com v

Falder for site listz and maps
[EAmTES kes | [ Browse... |

Bage folder for unloaded data
|D:\ProgramFiIes\MelroCounl w315\ sertData | [ Browse. . ]

Subgroup by. .
L ear “ Month JL Site “AttrihuteJ

Sample: |[un\oads] ‘

Use metric urits

Use long file names
152 bighepaadload
Allow editing of site list
Enforce site list use

Enforce Site List option in MCSetup
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Overview

MCReport is the data analysis component of MTE. The power of MCReport liesin the time-stamped raw data
produced by MetroCount RSUs. MCReport takes the raw sensor-hit stream stored in MetroCount data files, also
known as datasets, and interprets the data to produce almost any conceivable report.

This section introduces the process of generating a report using the Report Wizard.
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New User Options
Starting MCReport

M CReport has a huge array of options relating to classification, binning and filtering of vehicles, and to the
formatting of reports. Most options have generic default values, however the default units of measurement and
default classification scheme are highly region-specific. MCReport also requires alocation to create folders for
working files, such as datafiles, Profiles and saved reports. The first time MCReport is run after anew installation,
two dialog boxes will be displayed, providing an opportunity to set these options.

oE To start MCReport

v’ 1. Run MCReport from the Start Menu by locating the MetroCount v3xx folder, and selecting MCReport. If thisis
the first time MCReport or MCSetup have been run, the New User File Setup dialog box will be displayed.
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New user

|| Setworking folder

MTE needs to create a set of folders to stare Samples. Profiles and Templates.

Location to copy files
Documents

The sub-folders in bold will be created
= CAUsers\MTE Demo UsersDocuments
(5 MetioCount
=2 MTE 3.21

{0 Assembly
L Data
{2 Dutput
L[ Profiles

{7 Samples
{3 Script
i[O Sites
{0 Software
Loyl

Setting a working folder location

2. MTE needs afolder location to store working files, such as MetroCount data, Profiles and templates. The
default working folder location will be the current user's Documents folder. Thisis highly recommended as it
is guaranteed to be accessible under all versions of Windows. To select a different folder, click the ... button.

Click the OK button, and M CReport will create the list of folders shown in the sub-folders tree, and copy a set
of default working files. When copying is complete, the New User Options dialog box will be displayed.
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New user

|| Setinitial preferences here

5 e
All user options have been set to default values, however units of measurement and
classification spstems vary in different localities. These values may be set now. These and
mary more aption settings can be changed at any time in the Tools menu.

Use metric measursment units

Please select a vehicle classification system used in your locality.

| [class 12, moves all other classes up by one, and inserts a
short two-awle class as class one.

The following line wil appear at the tap of al reports

MetraCaunt Traffic Erecutive

[] Show ll the options
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MCReport's New User Options
3. Leavethe Use metric measurement units option checked for metric (km/h), or uncheck it for non-metric
(mph).
This only affects the values in reports - MCReport always performs calculations using Sl units.
4. Select aClassification Scheme from the list provided.

The list of schemesis MCReport's built-in OEM classification schemes. A range of user-editable External
Schemes can be selected from later.

5. Thefinal option isthe Header Page text, which appears at the top of every report. A company, council or
county name may be appropriate.

6. The Show all the options check box at the bottom will display the Default Profile after the OK button is
clicked. Again, this can be easily accessed later.
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Generating a Report
The Report Wizard

Generating areport with the Report Wizard is an incredibly simple process, illustrated by the following diagram.
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Generating a Report with the Report Wizard

The File Management List is atemporary list of datasets that have been loaded, ready for analysis. Datasets can be
loaded into the File Management List via M CReport's File Tree window, or from alist of recently used datasets.
Datasets can then be selectively tagged for inclusion in the report being generated.

The Report Vortex containsthe list of available reports, firstly grouped by their mode of analysis (Classification or
Event Count) and then by the format of the report (Tables, Charts or Special).

A Profile in MCReport encompasses the set of vehiclefilter, classification, statistical and formatting options for each
report. When anew report is generated, a copy of MCReport's Default Profile is attached to the report and is referred
to asthe report's Local Profile. Thisis displayed as part of the Report Wizard, with the most frequently used vehicle

filter settings easily accessible.

The end result is an automatically formatted report, that can be printed or saved. Note that the Local Profile, or list of
tagged datasets can be easily accessed via the report's right-click menu, without repeating the entire Report Wizard.
Many reports also have interactive tools for examining detail.
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n& To generate a report
. » 1. Start MCReport, and if necessary set the New User options as described in the previous section.
2. Click the New Report button on MCReport's main toolbar.

4 MCReport
File View Tools Window Help

Heh Baas[alreirenesaocs0aem
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Starting the Report Wizard

3. For thissimple example, load the urbanhwy.ec0 sample dataset that is aways available in the Recent Files
drop-down list at the bottom. Loading files using the File Tree is covered in the next section.

Oncethefileisloaded, note the red arrow next to the dataset, indicating it istagged for this report. Click the
Next button to continue.

File Management List

Load and tag files here...

Dataset name Site Siee  Start End Type  Description
I TJourbantwy 35291.0 240k 1300205ep93 142427 Sep 93 DemaFB GRT.MNORTHERN HWY SOUTH OF WEST

Load a dataset
4. Select areport, such as Weekly Vehicle Counts, and click the Next button.

Report Vortex
Select the kind of report here...

@;l Classification reports Ewent count reparts

= Ci User Defined Yehicle Reports
[ 3 Custom List Report
- Forpattad-e eparts

Tables

O e 3
v 34 vehicle Caunts
H v 3 Wehicle Counts (wirtual Day)
o 2 Daily Classes
Chartg

~w 2 Dally Classes by Diection
v 34 Daily Classes [Estimated Mass)
ﬁt v i Class Speed Matriz

v Speed Separation Matrix
Special o 2 Raling Day Totals
v 2 Individual Vehicles

Table of howrly vehicle counts, peaks and averages. One Remember last position

week per page.

Select a report
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5. Thereport's Local Profile is now displayed. Natice that each setting is a button, which will open another dialog
box for editing that setting. Also note the Advanced button at the top, which leads to numerous, but
infrequently accessed options.

For this example, simply accept the defaults by clicking the Next button.

i -—

Vehicle and report settings

“ehicle fitering and ieport settings are here

i |
| [Advanced... |
]

Mame: [Defau\l Profils

Speed [ Include vehicles with speeds between 10 kmh and 160 km/h,

Separation [N filter on Separation - [Headway]

Direction [Narth, East, South, West bound

Classes [ Include class 1,2,3,4,5,6,7,8,9,10,11,12

]

1

]
Scheme (Classiied veicles - AR J

Time
[ From 13:00 Monday, 20 September 1993 to 14:24 Monday, 27 September 1993 ]

View Local Profile

6. The selected report is now generated and displayed, ready to be printed or saved.

Try right-clicking anywhere within the report, and note the optionsin the pop-up menu. Local Profile will
display the report's current Profile, then recalculate. Datasets will display the File Management List, where the
tagged datasets can be changed and the report regenerated.

i MCReport - [WeeklyVehicle-2] _ =R
File Edit View Graph Tools Window Help [-]=]x
| H8R|EnuE|@dFp 3EDFAvcr00eE

| Wesklyshicle-2 |

Weekly Vehicle Counts

WeeklyVehicle-2 Recalculate
Site 35291.00 Local profile...
Des: on: GRT.HORTHERH HWY SOUTH OF WEST SWAH RD I}
Filter ti 13:00 Monday, 20 September 1993 == 14:24 Mon| Datasets.,
l Scheme: Wehicle classification (ARK) P +
| Filter: Cis(1 234567891011 12 ) Dir(NESW) Sp(10,16l (e
Cut Tl
Hon Tue Wed Thu T
20 Sep 21 Sep 22 Sep 23 Sep 24 Sep 25 Copy
Houx Paste
1000-0100 * 10 12 10 19
0100-0200 * 5 [ 4 1
0200-0300 * 1o [ 1z 7 Page setup...
0300-0400 = E] Kl Kl 8 Typeface
0400-0500 = zz 18 16 1z !
0500-0600 * 52 EL 52 23 Page break 3
1600-0700 * 130 141 159 148
0700-0500 * 247 z23 zas 218 Tabs
0800-0800 = 260¢ 250¢ z62 226
0300-1000 = z10 227 zal 245 zz0 211 | zzs.s  2zs.s
1000-1100 * 235 211 zz2 Y 279 334<] 228.%  254.3<
1100-1200 * 208 z4q 2692 226 2892 274 | 2360 25L.2
1200-1300 * 222 187 zaz 213 274 32041 2163 242
1300-1400 za9 z19 197 zaa za5 z60 z87 | zze.n  2al.7
1400-1500 255 212 220 z56 240 z02 216 | 6.8 zes.m
1500-1600 222 3462 331 336 249 21z 230 | 338.8<  3iz.3<
1600-1700 209 211 219 219 250 222 254 | 2216 299.1
1700-1800 297 209 a1s za5 392< 1s2 206 | 22lE 2852
1800-1800 179 217 215 217 zs1 102 1s2 | zzls 1991
| 1300-2000 97 1z0 0e 164 zaa 92 sz | 145.3  lso.s
2000-2400 &7 a6 a0 104 107 ] 671 &gz s2.2
2100-2200 3 50 £2 104 LH az a9 1 a2 £5.2
2200-2300 a2 55 52 L] 29 a7 46 1 L3 57.4
2300-2400 20 5 21 2a a8 52 17 =Lz 2z_2
1
Totsls 1
1
0700-1800 = 2992 za29 214z 2229 z627 2756 | 3061.3  2956.9
0600-2200 = save zazz 2672 2800 2352 @020 | 3512.0 a0
1600-0000 * 247z 2208 2766 2945 2052 2082 | 3607.0  2449.9
1000-0000 * asaz 28518 2875 2089 2181 3197 | 37216 2566.0
|
BM Paak * as00 000 1100 0900 1100 1000 1
* 280 250 z89 245 269 224 |
1
PH Peak * 1500 1500 1500 1700 1z00 1200 |
= 246 a2l 236 292 z7a az0 | -

The generated report, showing right-click menu
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File Tree Basics

MCReport's File Tree window is the primary tool for browsing, searching and auditing MetroCount datasets. Files
are listed, and sortable, by their key header details, rather than their physical file attributes. Folders containing
MetroCount datasets are marked with a special greeniconin the folder tree for easy identification. The File Treeis

also the best method for loading datasets into the File Management List.

p
File Edit View Tools ‘Window Help [-]=]=
e mhan @ame | eEmEa|ecr0ueH
|| T Fies s New file tree
MetroCount Tn this folder - C\UsersyMTE Derma UserDocurments\MetroCountiTE 3.27\Samples (Data Files = 3
£ ). MTE Dema User “ | File N Site Dir Attr Size Op  Start End Type Description
B B”:“’“‘ Fdpontypool Roadiecd 008910 SN 92k JDW 150027 Feb 98 1109 11 Mar98 Derno FB RS9 PONTYPOC
% DE’ top " urbanhwy.ecl 352010 N 240k KAT 130020Sep93 142427 Sep 93 DemaFB GRTNORTHERI
-8 Documents U5 SR-805.ech SRoB05.0 W §28k MAP 114733 Mow 99 1950 29 Mow 38 Demo FE  SR-905 W0 He
= L MetraCount
B MTE32L |
Lol Assembly [
=8 | Data 1
H Qutput
o L Profiles
le:>Y

Script
Sites
Software

o HML

m | ¢

File Tree Window

Double-clicking a dataset in the Fil

e Tree displays the dataset's header details and properties, grouped into several

pages. The Hits page is extremely useful for rapidly ng basic data quality.

urbanhwy.ecl A E Tube Up End.ecO ‘& ﬂ
[ Detach propesty sheet [ Detach property sheet
Dats |RSU | His | Spectnm | Raw Header| Fie | Deta | RSU | Hits | Spectum | Row Header|
Praperty Walue -l 1158
Site Name 35291
Attribute
Lane ul]
Description GRT.NORTHERM Hw/Y' SOUTH OF WEST SwidM RD ..
Layoul sl sensors - Paed [Clsss/SpeeddCount) Buthr
Direction & 1 - Morth bound, & hit first. [1]
Direction B 0 - Unused ar unknavn. [0]
First Data 1200 Monday, 20 September 1993 0
Last Data 0721 Monday, 27 Seplember 1853 0919717 Sep 57 112325 5ep 37
A sengor hits: 84212
Debounce  A4=10ms. B=10ms B sensar hits: 71372 Showd
Spacing 1000 mm- 3k 34in Tatal sensar hits: 165564 Show B
Mrarsbar KAT Sensor balance [A/B] 117.99% [[IDeta+-1)
fl

@)
o)
=
>
Q@
»
e
o
=3
®
o
=
=
=y
O
o
=
©
>
=]
o
<
@D
»

Dataset Properties

To load files into the File Management List
1. Open aFile Tree window by clicking the New File Tree button on M CReport's main toolbar.

2. Tolocate some sample datasets, click the Favourites button, and select MTE Samples. This automatically
selects the Samples folder in MTE's working folder location.

[E] File Edit View Tools [= =[]
EXEL Y LY-]

Ue=eet ]l 0 Organize favorites..

MetroCount erma Lser\D ocuments\MetroCount\MTE 3.21\Samples (Data Files = 3)

51 MTE Demo User W Gte Wk P Diry| Attributer [ Sizer [ Opr | Start End Type  Description
;E‘E“”:“t‘ LMTE Samples s §32k JOW 1500 327Feb 83 1109 11Mar9 DemoFB R99PONTYPOOL
El D” t”pt W urbanbuy.ecl 352910 M 240k KAT 130020 Sep 93 142427 Sep 93 DemoFB  GRT.MORTHERN
E'“D °cr:|m:"cs . A US SR-005 ech SR-005.0 W 633k RSP 1147 33 Mow99 195028 Mow89 DemoFB  SR-005 WO Herit

- etrol oun
-0 MTE32L [
| Assernbly
- || Data
- Lo Output
Profiles
®
| Seript
- B} Sites
Ly Software
XML

] r

Locating the Samples folder

3. Select acouple of the sample files (hold down the Ctrl or Shift key to select multiple files), and click the New

report button.
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EEETTEgSS - W W ==

[El File Edit Wiew Tools WWindow Help
EERLTYE P R EREE R T
=] Files 1

In this folder - CAUsers\MTE Derno User\Documentsihdetro CountthWTE 3.21\Samples iData Files = 3)
“0 MTE Demao User i Site Dir Atbribute Size Op Start End Type Description
1B Contacts E 692k IO eb 9% 110811Mar%8 DemofE R
-l Deskeop 1300 20 Sep 93 142427 Sep 93 Demno FB
= E Docurments = = o— Z
2 147 99 195 Dermo FB
o MetroCount
D00 MTEZ2L @
o Bssernbly
-3 | Data
L Qutput
1. Profiles
~§% | Samples
L. Script
w1 Sites
| Software
o XML
] [ I |

Make 3 new report

Loading the selected files
4, Click the Yes button to load the files.

5. The Report Wizard is now started, with the sel ected datasets loaded. Notice files are not tagged by default.
Simply double-click them to tag for the next report.

File Management List

Load and tag files here. ..

Dataset name Size  Start

e & a 1 1109 11 Mar
| 0 628k 1147 23Mov 99 1950 29 Mov 99

Ll 3

[[:lRecentFMes.‘. vH Spans. .. l

Add files ‘ Inputs... Autoscale columns

Tag files and continue the Report Wizard
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File Management List

Overview

The File Management List contains alist of datasets that have been loaded into memory, ready for analysis. Datasets
are tagged for inclusion in areport, as indicated by the red arrow icon. The File Management List is displayed as part
of the Report Wizard when generating a new report, or when swapping datasets on an existing report.

The File Management List isatemporary list. Loaded datasets remain in the list for the current session of MCReport,
or until they are explicitly removed. The list may contain up to 16 datasets.

Most reports support tagging of multiple datasets. This may be required for combined, multi-lane analysis where a
single RSU was used per lane, and for time-contiguous datasets for asingle site.

File Management List

Laad and tan files here. .
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Dataset name Site: Size: Skart End Type Description

Tag/Untag
Ferove ¥

Load algorithm...

il
1185k 1252 12 Wl 07 1622 20 Jul 07

Edit algarithm..,

.. GFF Tunnel Westbound,
o GFF Tunnel Westhound,1 1382k 161020 Jul 07 1258 27 Jul 07
... GFF Tunnel Westhound.z 941k 1632 20 Jul 07 1306 27 Jul 07

Froperties..,

Show full paths

M|« 1 | +

|21 Recent Fils... [ spans.. |

iz ot ] Bl utoscae cobs

File Management List, with right-click menu

Adding Datasets

There are several methods for loading datasets into the File Management List:

 viatheFile Tree,

« using the Recent Files list, or

« drag-and-drop.
The File Tree is the recommended method. Selecting filesin a File Tree window, then clicking the New Report
button will load them into the File Management List, up to a maximum of 16 datasets.

The Recent Files list, located at the bottom of the File Management List, contains the 10 most-recently loaded
datasets.

Dragging files from another application is also supported. Files must be dropped on the title bar of MCReport's main
window.
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Tagging Datasets

Tagged datasets are indicated by the red arrow icon next to their file name. At least one dataset must be tagged to
generate a report.

To toggle the tagged status of a dataset, simply double-click it. To toggle a group of datasets, select them, and then
select Tag/Untag from the right-click menu.

Note that some reports do not support multiple datasets. Selecting one of these reports in the Report Vortex will
display awarning, and return to the File Management List.

Removing Datasets

Manually removing datasets from the File Management List is only required if thelist isfull. Simply select at least
one dataset, right-click and select Remove.

A dataset can not be removed if it istagged, or it isin use by an open report (indicated by the blue bar icon). To
remove, firstly close any reports using that dataset.

Dataset Spans

The Spans button in the File Management List displays a chart of the relative time-spans for the loaded datasets. The
chart is scaled from the earliest start time to the last finish time, with each dataset represented by ared bar. Each
dataset's blue line represents the time between the first and last sensor hits.
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A File spans Gl (oo e

Close

GFF Tunnel Eastbound.! Graham Farmer Freeway Tunnel Eastbound <3Dkmih>

GFF Tunnel Eastbound.2 Graham Fammer Freeway Tunnel Eastbound <8Dkmihs

GFF Tunnel Eastbound.1 Graham Fammer Freeway Tunnel Easthound <0kmeh

GFF Tunnel Eastbound.2 Graham Fammer Freeway Tunnel Easthound <30kmeh>

GFF Tunnel Westbound.! Graham Farmer Freeway Tunnel Westbound <20kmh >

GFF Tunnel Westbound 2 Graham Farmer Freeway Tunnel iestbound <80kmih>

GFF Tunnel Westbound.1 Graham Fammer Freeway Tunnel Uliestbound <80kmih>

l GFF Tunnel Westhound 2 Graham Farmer Freemay Tunnel iestbound <S0kmih>
< 12:32 Thursday, 12 July 2007 13:06 Friday, 27 July 2007 »

N— Sm—

L

Time-spans of datasets in the File Management List
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Report Types

Overview

The Report Vortex is the report selection stage of the Report Wizard. Reports are primarily grouped by their mode of
analysis, Classification or Event Count, represented by the two pages at the top. Reports are then sub-grouped by
output format:

- Tables - pre-formatted, paginated text reports, and continuous text reports with user-definable columns and
export options.

« Charts - graphical reports, such as pie charts, time-based plots, dispersion plots and data-audit charts.
« Special - generic and "standard" report formats.
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e -
Report Vortex

Select the kind of repart here...

AT Classification reparts Event count reports

i User Defined Yehicle Reports -
BWEN [ stom Report
=HZ Formalted Yehicle Reports
v 2 wieskly Vshicle Counts

v ekl Vehicle Counts [Vitual Week]

v 1 Vehicle Counts
H Jﬂ Wehicle Counts [Vitual Day]
-+ 24 Dally Classes ]

m

Chats v 2 Dally Classes by Dirction
v 24 Daly Classes (Estimated Mass)
@ v 3 Class Speed Matix
Jﬂ Speed Separation Matrix
Special -+ 2} Roling Day Tolals

oo 24 Individual Vehicles =

Custom built reports. € /| Remember last positio

Selecting a report

Note: The Remember last position option automatically selects the last report that was generated - useful when
A generating several of the same report.

©2013 MetroCount® - - MTE User Manual 53




Classification versus Event Count Reports

Classification Analysis

Classification analysis requires datasets collected using a Classifier Layout, where the A and B axle sensors are
placed in parallel and aknown distance apart. From this, MCReport derives vehicles.

Firstly, MCReport performs the complex task of examining the raw data and partitioning groups of sensor hitsinto
likely vehicles. Thisis based on a number of time and distance parameters determined by M CReport.

The next step is to determine the axle configuration of each vehicle. Thefirst A and B hit pair in the group
determines the direction of the vehicle, and the speed of the vehicle, based on the sensor spacing. From the speed, the
time between the remaining hit pairs determines the spacing between axles.
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Thefinal step isto apply a classification scheme, based on the axle spacingsin the vehicle. MCReport offers a choice
of standard and special-purpose classification schemes, called 0EM Schemes. Other classification schemes can be
added to MCReport using user-definable External Schemes.

From here, the set of vehicles can befiltered, and formatted into avast array of reports.

Event Count Analysis

Event Count analysistreats the raw A and B sensor hits as user-sel ectable events - usually counts. MCReport refers
to the definition of an event as the Count Method, which may be one of the following:

* raw counts,

counts divided by 2,

 countsdivided by a custom factor,

 gaps above a certain length (in seconds), or

« following gaps, defined as a starting gap and a following gap.

Datasets collected using a Count Layout should only be analysed using Event Count reports. Attempting to analyse
this type of data as vehicles will produce meaningless results.

Classifier Layout datasets can be optionally analysed with Event Count reports. These may be useful for obtaining
approximate counts for periods where one sensor has failed, or for gap analysis.
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Multi-file Reports

Most reports support inclusion of multiple datasetsin asingle report. This may be necessary for combining results
from multi-lane sites with one RSU per lane, and for time periods spanning multiple datasets.

There isan icon next to each report in the Report Vortex, indicating multi-file support as shown in the following

table.
Icon Description
g Report supports single dataset only
A Report supports multiple datasets

@
o)
=
5
@
»
L
S
=3
)
ot
z
—
=y
O
o
)
)
=
=]
o
<
@D
o

Dataset Signatures

MetroCount datasets contain adigital Signature, which controls access to reports in the Report Vortex. A dataset's
Signature typeis inherited from the RSU that created it, such as Plusand Regular. The Signature type is one of the
columnsin both the File Tree and the File Management List.

Icon Description
v Report available
8 Report unavailable due to incompatible dataset
Signature type

Reports that are unavailable due to an incompatible Signature type are indicated by alock icon next to the report
name. Selecting one of these reports and clicking the Next button will display a message indicating the required
Signature type to use that report.

Hmm...

Report is unavailablel

Object

w Tagged datasets.

Details:

Thig repart iz only available for datasets of the fallowing types:
- Phase

- Plus

| -Demo L

1 [l

Signature type incompatible
When tagging multiple datasets, report availability will be determined by the lowest Signature type.
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Profiles

Overview

A Profilein MCReport is the set of vehiclefilter, classification, statistical and formatting options common to all
reports. Each report has its own Local Profile, which is copied from the Default Profile when the report is generated.
A report's Local Profileis presented as part of the Report Wizard, and can be accessed at any time viathe report's
right-click menu.
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Report Profile

Profiles are designed to be only as complex as they need to be. There is an enormous amount of information that can
be derived from time-stamped raw data, which means alot of options. MCReport logically groups these options into
the more frequently accessed vehicle filter settings on the primary page, with other options categorised under the
Advanced options. The Advanced options tend to be those that will be set once in the Default Profile, then rarely
modified.

M CReport uses a reasonable set of values for the Default Profile after a new installation. These settings are based on
the classification scheme and units of measurement selected in the New user options when MCReport isrun for the
first time.

Working with Profiles

Profiles can be saved to create alibrary of commonly used filters and options. Profiles can also be easily copied
amongst open reports to ensure a consistent set of vehicles are included. These features are accessed viaa Profile's
menu button in the top right-hand corner.

.
T ﬂ&

Vehicle and report settings

Wehicle filtering and repart settings are here.

e

| [Advanced... | @
|

Mame [Default Frrofile

File b Load profile...

Edit » Save profile... I}
Update Profile..

Speed [ Include vehicles with speeds between 0 km¢h and 200 km/h.

Separation [N fiker on Separation - [Headway) T

Ditection [North, East, South, West bound )

Load default profile

Classes [Include class 1,2,3,4,5,6,7,8,9,10,11,12,13 1

Load factory profile

Scheme [Classiliad vahicles -AFE il

e

l From 00:00 Tuesday, 21 September 1993 to 00:00 Monday, 27 September 1993 ]

Save to default...

Time

Profile menu

Saved Profiles are stored in files with a..ini extension, and located in the Profiles folder under MTE's working folder
location. When a Profile is saved, al of the options are written to the file. When loading a Profile, different groups of
option can be selectively loaded.
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oﬁ To modify a report's Local Profile
g 1. Right-click on areport and select Local Profile from the pop-up menu.

—
—
F& MCReport - WeeklyVehicle-2] P =R &

File Edit ‘iew Groph Tools Window Help [-]=]= 3

HE&&IM@@I@@\%Em&ﬁll«u—-}eﬁo o

| B wesldyvehicl2 | s

= =
Weekly Vehicle Counts =)

weekhyVehicle-2 Recalculate Q

ite: —

ster 35291.08 el sl o

Deseription: GRT.HORTHERH HWY SOUTH OF WEST SWAN RD I}

Filter time: 13:00 Monday, 20 September 1993 => 14:24 Mon| Datasets... >
' Scheme: Wehicle classification (ARK) P + =
| Fitter: ClsH 234567591011 12 1 DirtNESW) Sp(1 0,16 (I o

Cut Tl <

Hom Tue Wed Tha P
20 Sep 71 Sep 3% Sep T3 Sep 4 Sep  ¥5 Copy &,
ep ep ep ep ep 7]

Houx Paste

0000-0100 * P 12 10 19

0100-0200 * 13 £ 4 11

0200-0300 = 10 I3 1z 7 Page setup...

0300-0400 - s a b 8 Typdiees

0400-0500 * 22 18 15 1z p

0500-0500 * 52 .21 52 B Page break 3

0E00-0700 * 1z0 141 159 148

0700-0800 B 247 223 248 215 Tabs

0800-0900 - 260c  2s0c  zse 225

0800-1000 * 210 ez 231 246 20 Z11 | 2z8.5 225.8

1000-1100 * 35 211 222z 2495 9 34| ZEE.Z 254, 3=

1100-1200 * Z0E 244 2E9< ZZE 259= 74 | EIE.0 Z5Ll.2

1200-1300 B 222 187 2a2 213 2142 32061 215.3  zazz

1300-1200 229 219 197 244 a5 2860 2e7 | ezglo zaL7

1400-1500 255 21z ezo 258 240 202 zls | 22E6.8 zzd.r

1500-1800 1z 46 331< 336 49 21z ZE0 | 335.8< 312 3=

1600-1700 209 21l 219 219 250 E3E Z84 | 2ZL1.E€ 2291

1700-1800 297 209 a1s 295 se2c sz 205 | szlE 2852

1800-1900 179 217 215 217 201 122 152 | ezle 199l

1900-2000 an lzo pLLY 154 248 a2 9z | 145.8 Lx0.&

2000-2100 &7 5 &0 104 107 &2 E7 | 3.2 BZ.2

2100-2200 13 ED L1 104 Te k3 %2 1 7.2 B5.2

2200-2300 as 58 s 59 99 az a5 | ELs s7.a

2300-2400 20 25 21 34 a5 52 oLz sz 3

1

Totals I

1

0700-1900 +  esva zea9 e1az ez eeaT o755 | 90613 2955.9

0600-2200 * 2292 2302 BT 2500 z952 2020 | 3514.0 2RE0.2

0E00-0000 * 247z 2206 TEE 2945 0EE 205 | 2E07.0 24499

0000-0000 * a5z 2518 EE G0EF 2LEL 2192 | 3MEL.E EEE.0

1

LH Peak * 0500 0500 1100 0200 llo0 1000 |

* ZEO 250 ZES z4E 59 340

I

FH Feak * 1500 1500 1500 1700 lzo0 1zo00 |
* 2485 221 228 92 214 20| -

The generated report, showing right-click menu
2. Modify the Profile as required, and click the OK button. The report will be automatically regenerated.

/l\ Note: Regenerating a report, such as by editing the Local Profile, will lose any manual text editing.

aE To set a Profile as the Default Profile
" 1. Edit areport's Profile, and select File » Save to default from the Profile's menu button.

2. To make the current Profile the permanent default, click the Yes button. Clicking No will change the Default
Profile only for the current session of MCReport.

MCReport ﬂ

lew Make this Brofile the permanent Default?
@

Permanently save changes
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oﬁ To save a Profile
v 1. Edit areport's Profile.
2. Select File » Save Profile from the Profile's menu button.

3. Enter adescriptive file name for the Profile (the name of a Profile can optionally be displayed in the header of
areport), and click the Save button.

0& To load a Profile
e 1. Edit areport's Profile, and select File » Load Profile from the Profile's menu button.
2. Select aProfile, and click the Load button.
3. The Merge Profile dialog box lists the groups of options that can be selectively loaded.

The default isto include all options, except the time range. Thisis because the start and finish timesin the
saved Profile are from the datasets that were tagged when the Profile was originally saved, and usually need to
be ignored.

Click the Load button to apply the selected options.
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Merge profile ﬁ

C:A\Users\MTE Demo Usert\DocumentsitetioCountWTE 3.214Pn

IF you want to load only part of a profile you can uncheck the parts
you dan't require below.

[] Time range of filter
Wehicle fiter parameters
Advanced - General
Ldvanced - Colors
Advanced - Report style
Advanced - Class scheme
Advanced - Speed
Advanced - Mass
Advanced - Separation
Advanced - Adjustments

Selectively loading parts of a Profile

aﬂ To copy a Profile

™ 1. Edit the source report's Profile, and select Edit » Gopy from the Profile's menu button.
2. Exit the Profile by clicking the Gancel button.
3. Edit the target report's Profile, and select Edit » Paste from the Profile's menu button.
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General Features

Report Layouts

MCReport has two report layouts:
e Text reports, with completely editable contents and manual formatting options.
 Graphical reports, combining a chart and text report in a split window.
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This section introduces concepts common to all reports. Concepts unique to text reports and graphical reports can be
found in following sections.

The Right-Click Menu

A report's right-click menu is one of the keys to MCReport's flexibility. Both the report's Local Profile and tagged
datasets can be changed on-the-fly, without the need to regenerate the report. Reports may also have customisable
options accessible via this menu.

& MCReport - [WeeklyVehicle-2] E@&ﬂ
File Edit View Graph Tools Window Help N EE
|H8R | Esnz® @@p a8 0FR|rcr0ueH|
| WweeklyVehicle-2 |
-
Weekly Vehicle Counts
WeeklyVehicle-2 Recalculate
Site: o 35291.00 Lacal profile..,
Description: GRT.HORTHERH HWY SOUTH OF WEST SWAH RD %
Filter time: 13:00 Monday, 20 September 199F => 14:24 Mon| Datasets...
| Scheme: “ehicle classification (4R4) —_—
Filter: Clsi1234567 69101 12 ) DINNESW) SpC10,16 =
Cut B
Hon Tue wed Thu Fri
20 e Copy
p 21 Sep 22 Sep 23 Sep 4 Sep 28
Homx Paste
0000-0100 - 0 13 10 19
0100-0200 * 13 [ Y 1
0200-0300 * 10 & 1z 7 Page setup...
0300-0400 * 2 7 ? & Typeface
0400-0500 - ez 18 16 12
0500-0600 - s2 51 52 13 Page break 5
0600-0700 * 130 141 159 148
0700-0500 * za7 zz3 245 z18 Tabs
0800-0300 * 260 250< z62 226
0g00-1000 - z10 227 za21 246¢ 220 211 | zzs.s  2zs.s
1000-1100 - zas 211 zez 745 27y 334<| 2.8 254.3<
1100-1200 * zas zaa 2692 226 2892 z74 | 236.0  efl.z
1200-1300 * zz2 187 242 212 M4 320<) 2163 243.2
1300-1400 229 z19 197 zaa 246 280 z87 | 2280 24l.?
1400-1500 255 212 2z0 258 za0 03 z18 | zas.s  eze.a
|| 1500-1800 a2z 346 331< 3362 249 21z ze0 | 335.8¢  312.3<
|| 1s00-1700 209 211 219 219 250 222 z54 | 2216 299.1
1700-1800 297 209 215 295 3322 183 06 | 2216 288.3%
1500-1300 179 z17 215 217 231 122 182 | 2zl 199.1
1900-2000 27 120 10e 154 zaa 23 ez | las.z  130.8
2000-2100 57 85 50 108 107 52 67 | 89.2 sz.2
2100-2200 &2 &0 [ 104 (H az as | wr.z £5.2
2200-2300 43 55 52 59 29 a7 a6 | Bl 57,4
2300-2400 20 25 z1 24 16 52 7 3Lz 22,2
|
Totals |
|
a700-1300 * 2994 2929 alaz az2e 2827 2756 | 3061.3  2956.9
0600-2200 - 229z 2022 272 as00 zasz 2020 | asla.0 2380z
0600-0000 - 2avz 2406 2766 EEE) 2052 208z | 3607.0  2249.9
0000-0000 * 2582 2518 278 2089 2181 2192 | 3721.6  25EE.0
|
RH Feak * 0500 0s00 1100 ago0 1100 1000 | i
- z60 250 269 246 a3 239 | |
|
FH Feak - 1500 1500 1500 1700 1200 1z00 |
- 2a8 221 228 asz zra sz | -~
=

The right-click menu

Note that any changes to areport's Profile or datasets will result in the report being automatically recalculated. Any
manual editing of the report will be lost.

When changing tagged datasets, remember that the report's signature and multi-file restrictions will still apply.
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Header Sheets

MCReport includes a detailed header sheet with most reports, giving essential details about the datasets and Profile g
used to generate the report. Reports may also include an abbreviated header at the start of the data, or the top of each 3
page. When the details are too large to be compressed (such as when multiple datasets are included) the abbreviated =)
header will refer to the main header sheet. ik
>
MetroCount Traffic Executive 8—
Weekly Vehicle Counts 3
(0]
WeeklyVehicle 620 -- English (ENA] 2_
Datasets: 3)—)
Site: [35291] GRT.NORTHERN HWY SOUTH OF WEST SWAN RD <90km/h>
Direction: 1 - Morth bound, A hit first., Lane: 0
Survey Duration: 13:00 Monday, 20 September 1993 == 14:24 Monday, 27 September 1993
File: D:AProgram Files\WetroCount v31B\senSamples\UrbanHwy ecO (Demo FB)
Identifier: (355 Rev 8.02 B/3/1993 (c) 1993 Microcom
Algorithm: Factory default
Data type: Auxle sensors - Paired (Class/Speed/Count)
Profile:
Filter time: 0:00 Tuesday, 21 September 1993 => 0:00 Monday, 27 September 1993
Included classes: 1,234 56,7,8910 11,1213
Speed range: 0 - 200 kmdh
Direction: Marth, East, South, West (bound)
Separation: All - (Headway)
Name: Factory default profile
Scheme: Veh\_c\e classwﬁc_at\nn [ARX)

Units: frtetre={rreter . Lm/h, kg, tonne)
@ Vehicles = 21438 £ 23718 (20.32%

Sample header sheet

The In Profile line is the number of vehicles or eventsincluded in the calculations of areport, versus the total number
of vehicles or events available in the tagged datasets. Thisis extremely useful for highlighting the effect of vehicle
filter settings, especially when alarge percentage of excluded vehiclesis unexpected. Note that for sequentially
generated reports such as the Individual Vehicle or Custom List reports, the In Profile line appears at the end of the
report.

Thefieldsincluded in areport's header sheet can be selected in the Header items tree in the Header page of the
Advanced Profile options.

e
General | Folmal‘ Header ‘ Colars | Scheme I Speed | Mazs I Separation | Ad\ustl
Header items
52 Tille block .| Giraphic loga ta display above headsr
-1, Show graphic F
[V Tile
916, Reportiane (Lt Lo poin
[, Saveblame
1%, Show full path
- Datasets
{43, Site:
13, Attribute:
~[¥]%, Directior:
3 Input &
Input B Repart title
Survey Duration: MehioCount Traffic Executive

9%
£
3, Zone:
Ed
9%

HENEE

File Report name template

=

Identifier
13, Algorithm:
% Data type
ofile
12 Filter time:
9, Exchusionr
3 Filter

% Included classes

A Dl | mmman

Use standard report name:

o
ER=4 [] &llaw reports to be edited

Put headsr on separate page

IOy

Changing the Header Sheet format

The header sheet includes an invisible page break to ensure the report data starts on a new page. To turn this off,
toggle the Put header on separate page option.
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Thefirst line of the header sheet title can be changed via the Report title option. Thisis commonly set to the name of
acompany, council or county.

MetroCount Surveys g
eokiyYeitcle Colnts o
o
WeeklyVehicle 138 - English (ENA] =k
Datasets: E-I
Site: [35291] GRT.NORTHERN HWY SOUTH OF WEST SWAN RD <90km/h> S
Direction: 1 - Morth bound, A hit first., Lane: 0 o
Survey Duration: 13:00 Monday, 20 September 1993 =»> 14:24 Monday, 27 September 1993 Q
File: D:vProgram Files\MetroCount v316WserSamplesiUrbanHwy.ecl (Dema FEB) 3
Identifier: 355 Rev 9.02 6/3/1993 (c) 1993 Microcom 0]
Algorithm: Factory default >S5
Data type: Auxle sensors - Paired (Class/Speed/Count) E)"
Profile: 2]
Filter time: 13:00 Monday, 20 September 1993 => 14:24 Monday, 27 September 1993
Included classes: 1,2,3,4,5,6,7,8,9,10, 11,12 13
Speed range: 0- 161 km/h.
Direction: Morth, East, South, ¥West (bound)
Separation: All - (Headway)
Name: Factory default profile
Scheme: “ehicle classification (ARX)
Units: Ietric (meter, kilometer, m/s, km/h, kg, tonne)
In profile: Wehicles = 23717 / 23718 (100.00%)

Changing the Header Sheet title

A company logo can also be added to the top of the Header Sheet in the form of a bitmap image. Thisis specifiedin
the Graphic logo to display above header option, and enabled with the Show graphic option in the Header items
tree.

The tab position between header sheet labels and datais adjustable, to cater for changes in font size. Simply
right-click in areport and select Tabs, then click the mouse at the desired location. This can also be set using the Tab
Position option in the Format page of areport's Advanced Profile options.

Report Name

Each report generated by M CReport has a unique Report Name, which appears in the report'stitle bar and header
details, and is the suggested filename when saving reports. By default thisis a combination of an abbreviation of the
report type, and an incrementing serial number, such as WeeklyVehicle-1. The report serial number can be reset at
any point by selecting Tools » Settings from MCReport's main menu, and changing the Next report index option.
The Increment report index on recalculate option causes the serial number to increment whenever areport is
recalculated, such as editing a report's Profile or tagged datasets.

e z
il 1 » Mext report index
1

v
— — —| Increment report index on recalculatel

[ [

Changing report serial number options
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The format of the Report Name can be changed in the Header page of the Advanced Profile options. Unchecking the
Use standard report name option enables the Report name template. Thisis acomma separated list of fields, which
can be selected from the menu button next to the template. Fixed strings can be added inside double-quotes. The
incrementing report serial number will be automatically appended to the end of the generated name.

Py
()
o
o
=3
o
C
=
o
o
3
o)
=
=L
o
»

Repoart name template
| SITE." - " DATATIME." - " REPNAME

[] Use standard report name »

Changing the report name format

Page Setup

MCReport uses the page size of the currently selected printer to generate reports. The page orientation (portrait or
landscape) is automatically selected based on the type of report being generated.

The automatic page orientation can be overridden at any time by using the Page orientation option in Format page of
areport's Advanced Profile options.

The default page margins are set in MCReport's Global Settings, accessed by selecting Tools » Settings from
MCReport's main menu. Margins may be set independently for portrait and landscape pages. Existing reports will
need to be recalculated for the global page marginsto take effect.

encasesi 120 1| [Printer margins For portrai pages [mm]
f Left=10, Top=10, Right=10, Bottom=10 C]

Printer margins for landscape pages (mm)
Left=10, Top=10, Right=10, Battom=10 [—

Ve e S

uuuuuu

] (bt

Setting default page margins
Page margins may also be set locally in areport, by right-clicking areport and selecting Page setup.

Report Header / Footer

The default page header of reports includes the Report Name and page number, right-aligned.

The Format page of areport's Advanced Profile options includes a Printer header and Printer footer option for
adding asingle line of left-aligned text to the top and bottom of each page.

The tokens <DATE> and <TIME> may be used to insert the current date and time. The operating system’s current long
date and time format will be used.
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Text Reports
Editing

All text reports have fundamental word-processing properties:
e Textiscompletely editable.
« Fonts and colours may be changed.
» Objects, such asimages can be inserted.
» Text can be copied into other programs.

Py
()
e,
o)
=
i
C
>
o
o
3
o)
>
=
o
(2]

The font used in areport can be set via the Report font option in the Format page of the report's Advanced Profile
options. MCReport uses a non-proportional font (such as Courier) to construct columns in tables, so they will be
unaffected by this option.

Font and colour can be changed locally in areport by selecting a block of text, right-clicking and selecting Typeface
from the pop-up menu. Thisis useful for manually highlighting certain figuresin areport.

The normal view of areport is a continuous stream of text. MCReport automatically inserts hidden page break
characters at appropriate places, such as the end of the Header Sheet. Manual page breaks may be inserted into a
report at the cursor, by right-clicking and selecting Page break from the pop-up menu. Use the Print Preview to view
how a report will be paginated when printed.

Note: Remember that any manual editing of a report will be lost when a report isrecalculated. Areport is
& automatically recalculated when any changes are made to the report's Local Profile or tagged datasets.

Saving

Text reports can be saved by selecting File » Save report as from MCReport's main menu. Reports can be saved in
Rich Text Format (RTF), which includes all the font and formatting information, or plain text (TXT).

The Save file dialog always defaults to the Folder for report output option in MCReport's Global Settings, accessible
by selecting Tools » Settings from MCReport's main menu.
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Zooming

Text reports can be zoomed on-screen, without affecting the actual font size or printed output. Simply click the Zoom P
button on MCReport's main toolbar, and select the desired zoom level. Note that only a zoom level of Actual Size 3
will display a page outline. For atrue indication of printed output, use the Print Preview. =
d
T MCReport - WeekiyVehicle-l] [E=AEE e =
Fil g s T g e v [-]=]= Q
|BER|Bna @80 eencBlecsnnam %
|67 weekyvehicls-1 | :Ej; g..
MetroCount Tr :2; El &
Weekly Veh Act:a\ Size
WeeklyVehicle-1 - English (ENA) 110% %
120%
Datasets:
Site: 135291] GRT.NORTHERN HWY SOUTH 150% Dkm/h>
Direction: 1 - Morth bound, A hit first. Lane: 0 200%
Survey Duration: 13:00 Monday, 20 September 1993 == Tezermomray; premiber 1993
File: UrbanHwy.ecO (Demao FE)
Identifier: (355 Rev9.02 B/3/1993 (c) 1993 Microcom
Algorithm: Factory default
Data type: Auxle sensors - Paired (Class/Speed/Count) -
< n ]
Ready

Zooming a text report
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Graphical Reports
Split Window

MCReport displays charts and graphs in a unique dual-pane window, with a chart in one pane, and atext report in the
other. For reports grouped into the Charts category in the Report Vortex, the chart is presented on the left, with the
report's Header Sheet on the right. The Custom List report presents a chart on the right.

F& MCReport - [VehicleFlow-2] - ‘ ‘ [ B o]
File Edit View Graph Toaols ‘Window Hel — & x
P P
| HER(EM2H 8D BENIA|~+«+0 4eHE
J & vehicleFlow-2
MetroCount
* Vehicle Flow :
= § VehicleFlow.2 (MeTS Site: GFF Taiel ExEona.IE Recalculate : MetroCount Traffic Executive
Deseription: Gralan Famer Freeway T el E2rbond 0 4 -
e | Filter fime: [DID FIDy, 1382 —> (DD F iy 200500 Local profile... : Wehicle Flow
S0 | Filter; Ce(I 27456783 1011 12 13) DIQNESW SPOAT) Heakayol) % : D
S Seheme: Veilok obsoatin 4R Datasets... i | VehicleFlow-2 -- English (EHA]
= O Friday, 13 vy 007 (D3) 1
Properties | Datasets:
o - 1| site: Graham Farmer Freeway Tunnel Eastbound <80kmih:>
i opy i | Direction: 2 - East bound, & hit first. Lane: 1
2 i | Survey Duration:  12:32 Thursday, 12 July 2007 == 15:44 Friday, 20 July 2007
o] Page setup... | File: GFF Tunnel Easthound20.ui2007 EC1 (Plus)
¢ | Identifier: 12530 MCST-X20 (cidetroCount 01MovDs
E i | Algorithm: Factory default
g E Data type: Axle sensors - Paired (ClassiSpeed/Court)
H . el ‘| Profile:
= . . ! | Filter time: 00:00 Friday, 13 July 2007 => 00:00 Friday, 20 Juby 2007
4 w I 1| Included classes: 1,2, 3,4,5,6,7,8,9,10,11,12,13
.| Speedrange: 0 - 200 kmih.
B - . . | ! | Direction: Morth, East, South, West (bound)
e d 1 L . L - ! | Separation; Al - (Heacheeay)
o . " - 7 7 1 | Hame: Default Profile
| seneme: “ehicle classification {ARX)
! | Units: Metric (meter, kilometer, mis, km/h, kg, tonne)
e e e e eo o2 Inprofile: Wehicles = 176975 /194760 (30 87%)
— — —d

Split-window graphical report

The left pane is always the primary pane. Its right-click menu contains access to the Local Profile, included datasets,
and report properties. The secondary pane's right-click menu contains the other usual functions.

The blue MetroCount bar at the top indicates the currently active pane. Certain functions, such as zooming, can relate
to either pane, so only the active pane will be affected. A pane is made active by clicking anywhere within its region.

Zooming

The default zoom level for agraphical report is fit-to-window, which will maximise the size of the graph for its pane.
Moving the splitter bar to one side will dedicate the entire window to the graph.

The zoom level may also be set to afixed percentage. For values larger than 100%, the scroll bars can be used to
move around the report.

For finer resolution in the data itself without changing the size of the report, consider changing the Display Span or
Integration Time.
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Rendering

Many of the graphical reports have multiple rendering options. Reports generally default to the most appropriate

rendering option, however experimenting with the available options may give better results for a given application. 3
=
= - \ . -
B8 wreponspess i W N [T Z
File Edit Wiew Tools Window Help a
J [=W=2rY | Rendering 3 Paints TY-IFL S ‘ )
Wert, I 3 Li
[® o | ert, scale v Lines % %
— Grid 3 Impulse S
| B Speed3 propertes. Delta bars o [E] | B speed s SlfErEE] g
=» Bars/Blocks MetroCount a
g Speed
Sh a5 ety e GFF Thiel Msstonaan | Polygons/Radar Spand-d QU Sits” GFF TH el Botad 20
CBICMPHON: Grkam Famer Fresumy THibe| Esbot - . Dacrpton: Graiam Famer Freenm; Turke ks bonid <SHmA:
Jn it tima: OO0 F iy, 13.J A4/ 2008 = CEH0 F it 20 Pie RS ime: (DSI0 F 133, 13 J ) 200 === (D10 F 1633, 20.J 1) 200
AIter: CEQ1 234567 B 1011 12 13) DIRN ES) Sp), AItr CE(123 456783 1011 12 13) DINNESN) Spll M) HeaMaye-0
SclsMa e bk CIEES MGoN (AR Strata Schams: e hick oMt (ARX)
[ speed I spee
W mmam, W nwm i, nzmm
= 01 Fridsy, 134k 200 (D3 = D0 Friday, 131l ZIF (03)
]
1=
16 !
z‘”|ﬁWfWAW P PR :
5 =L A e AW 5
PR | Y b
L = Yo \"mw i
L] \Ur
it
o Frl mm sat o sa oom Mo om Tee om Wed mmTin mmFl mm sat mmsa O Mor O The oomikd mmTi
130 AL 150 1801 ATl 120 R=s Tl -l 150 1E-In1 AT-dnl 1301 10l

Same report showing different renderings

To change the rendering of a graphical report, activate its pane, and select Graph » Rendering from MCReport's main
menu. The available rendering options will vary depending on the type of report.

The line-thickness used to draw a graph can also be changed in the Format page of the Advanced Profile options.
Thickness can be set independently for on-screen viewing and printing. In general, one-pixel thicknessis fine for
on-screen viewing, however thicker lines may be required for the higher resolution of printers.

G Foone o | Gk [ Schomn | Ssmed M | st | st
Fasaton

a1l

Graph axis [pixels] Graph line [pixels]
creen Frinter creen Frinter

b s e [

Changing graph line thickness
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Colours

Almost every colour used in agraphical report can be customised viathe Golours page of the Advanced Profile
options. To change a colour, select it from the list on the |eft, and use the red, green and blue sliders. The Custom
button will display the standard Windows colour-picker.

The general groups of colours are:
* Class- used for class and speed bins.
e Trace- primary colours used by most reports.
 Limit - used for horizontal markers such as speed limits, and vertical markers such as percentiles.
¢ Glide - used by density plots.
 Phase - used by Phase reports.

Py
()
o
o
=3
o
C
=
o
o
3
o)
=
=L
o
»

Profile =)

‘ General | Format | Headel‘ Colors ‘ Scheme | Spesd | Mags | Separation | Ad|usl‘

Class28 | Insome charts, properties are represented by color. These colors can be changed

B 29 here

Solids Lines

B PhaseBa 0 Red

== Ul D
I Trace3 135 Green

W TS d I L
WL 189 Blue

] ] 3

| |
[=
2
&
m

(I Lt [T Lock RGB siders tagether

GraphM arker
GraphB ackground

GraphShad
,:.rizn acon = | [] Piint white backgrounds

Customising report colours

Vertical Scale

There are several options for calculating the vertical scale of a graph. Graphical reports default to the most
appropriate method for the type of report. An appropriate number of tick-marks will be automatically selected.

To change the vertical scale of agraphical report, activate its pane, and select Graph » Vert. Scale from MCReport's
main menu. The available options will vary depending on the type of report.

Option Description
Auto Maximum value of the y-axis will be set to the peak data value.

Maximum value of the y-axis will be set to the next integer power above the peak data
Integer power value. For example, for apeak of 390, the maximum y-axis value will be 400. For 8421, the
maximum y-axis value will be 9000, and so on.

Maximum value of the y-axiswill be set to the next 1, 2 or 5 integer power above the peak
datavalue. That is, 1, 2, 5, 10, 20, 50, 100, 200, 500, and so on.

C A dialog box will be displayed, where the y-axis minimum and maximum values can be
ustom entered.

125 power

Crosshairs and Markers

Time-based plots can be inspected with a pair of crosshairs to examine points of interest. The crosshairs are activated
by clicking on the grey bar at the top of the report grid, and dragging across the report. As the crosshairs are moved,
the current coordinates are displayed next to the pointer.
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[MetroCount

Vehicle Flow

VehicleFlow-20 (Metric) Site:GFF Tunnel Eastbound.1.0E
Description: Graham Farmer Freeway Tunnel Easthound <80km/hz
Filter time: D000 Friday, 13 July 2007 =: 00:00 Friday, 20 July 2007

Py
®
IS
Filts 11234567 8910 11 12 13 ) DifNESW) Sp(0,200) He adway(=0] :_
Scheme: Vehicle classification (ARX)
T
W Frofile c
=}
< 00:00 Friday, 13 July 2007 (Day) Marker 10:57 Wednesday, 18 July 2007 o
214987 m
n 3
Ao o
1719 J‘\ \ [!;11'12 Wednesday, 18 July 2007, 1597 A ﬂ ,?,.
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Using the crosshairs on a graphical report

The crosshairs are also used to place a marker on the graph. When the mouse button is released, a vertical marker
will be placed at that point. The location of the marker is specified on the top right of the graph. The marker is
primarily used for changing the Display Span of a graph.

To clear the marker, simply double-click the grey bar at the top.
Display Span

The Display Span is the subset of the available data currently shown by atime-based plot. By default, time-based
plots are scaled to display the entire data time span. The Display Span may aso be changed to aweek, day, or hour.

= = 9
& MCReport - VehicleFlow-6 - [E=E
File Edit “iew Graph Tools ‘Window Help
HER Baas|dap Ramaal Y
& vehicleFlow-5 | vehicleFlow-7
. B VehicleFlow-6 [ =) | B vehicleFlow-7 [EI=ErE=]
MetroCount MetroCount
L
Wehicle Flow ! Vehicle Flow H
el Exrbond1E GFF Tane| Earbond 1€ 1 iollale FovT (Metrkh Site: GFF Tunnel Exrbond1E L | Exrbonnd1E
bk 1 kee thor £ 1 descriptions H Dwaription: Mtk & fes - See Headr ¢ keethrs e descrpting
Entire data i = (01D F iy, 27 J iy O 1 RAltsr timo: 0000 Morday, 16 J 1y 200 == D00 Morday, 23 J 1l 2000

1) 0inH By SPOAT) Heatvaye O : :ubar.cmzatss1as|un@;ﬁz)|gaj DINHESIY Spl M) Heavaye O
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Da i Dan Marker O7 23 Friday, 204 vy 30T 3 - 0000 Friday, 0 J vl ZOW (Hoviy
¥ 7 I

Hour Ly

Row d=1r

Example of Display Span set to a week, and a day, for the same report

Changing the Display Span requires a marker to be placed at the point on a graph where the new Display Span will
start. The new Display Span will actually start on the boundary to the left of the marker. So, for either aweek or a
day, the marker can be placed anywhere in the day where the new Display Span is required to start. For an hour, the
marker may be placed anywhere within the desired hour.

Once the marker has been placed, the desired Display Span can be selected by clicking the Span button on
MCReport's graph toolbar, and selecting from the pop-up menu. The new Display Span will automatically appear. To
step backwards and forwards through the data at intervals of the Display Span, use the Back and Forward buttons also
on the graph toolbar.

The Display Span can be set to start precisely at the marker location by holding down the Ctrl key when selecting the
Display Span from the graph toolbar. Note that this may result in odd times for the tick marks on the x-axis. To set
the marker with greater precision, hold down the Ctrl key when dragging the crosshairs.

Integration Time

The Integration Time of atime-based plot determines the period of data used to calculate a point on the graph. For
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example, aVehicle Flow graph with an Integration Time of one hour will place one point per hour of total vehicles.

The Integration Time is closely related to the Display Span. For instance, with a Display Span of aday, an
Integration Time of an hour will give 24 points on the graph. An Integration Time of 10 minutes on the same Display

Span will give 144 points, showing much more detail. &
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Example of smaller integration time providing more resolution

The Integration Time for atime-based plot can be changed by clicking on the Integration Time button on

MCReport's graph toolbar, and selecting from the pop-up menu. The graph will automatically redraw with the new
Integration Time.

Note that when using a smaller Integration Time the vertical size of the graph will change since fewer vehicles are
integrated into each point. Also, selecting asmall Integration Time relative to the Display Span may result in an

unreasonable number of pointsto be plotted. In this case a message will be displayed, suggesting a larger Integration
Time,
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Background

Flow dt=1hr

Graphical reports can optionally display an image in the background, such as a colour gradient or watermark. §
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Displaying a background image

The background image can be set in the Format page of the report's Advanced Profile options. The intensity of the
background image can be adjusted using the Alpha blend percentage. The selected image is automatically scaled to
fill the graph area.

Printing

Printing split-window reports requires two print operations. Selecting File » Print from MCReport's main menu will
only print the currently active pane, indicated by the blue MetroCount bar at the top. To activate the other pane, click
anywhere within its window.

Saving

Graphical reports can be saved as vector-based Enhanced Metafiles (EMF) or as an image file (PNG, GIF, JPG or
BMP). To save agraphical report, select File » Save report as from MCReport's main menu. Remember that the
graph must be the active pane, indicated by the blue MetroCount bar at the top.

The output format is determined by the Save as type drop-down list in the Save dialog box. Note that the Save dialog
always defaults to the Folder for report output option in MCReport's Global Settings, accessible by selecting Tools »
Settings from MCReport's main menu.

Enhanced Metéfiles are a vector-based format, making them ideal for inserting graphs into other documents. When
an Enhanced Metéfile is scaled, everything is redrawn at the new size, producing a high-quality image. The fileitself
isnormally very small.

Image files are more widely supported by other software, however they have an inherent size, and rescaling them can
often produce unsatisfactory quality. When saving as an image, MCReport displays adialog box where the
dimensions of the image can be set. The required size will depend on the intended use of the image. Only the width
needs to be set, so that the correct aspect ratio is maintained.

Save bitmap

|

Size
 pivels
1000

2812000

Y pivels
703

Est. size [bytes]

Cancel

Setting the output size of a bitmap

A graphical report can aso be transferred to another application using copy-and-paste. Simply right-click on a graph,
and select Copy from the pop-up menu. The graph will be pasted as an Enhanced Metdfile if the target application
supports it. Otherwise the graph will be pasted as a bitmap at the size shown on screen.
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Report Cloning

Report Cloning is an extremely efficient way to rapidly generate a group of reports. Cloning an active report é?
automatically generates a new report of the same type, with the same datasets and an identical Profile. The new o
report's Profile or datasets can then be easily changed via the right-click menu. To clone the currently active report, ﬁ
simply click the Clone report button on MCReport's main toolbar. =
o
FE MCReport - ClassMatrix-18 =) %
File Edit “iew Graph Tools ‘Window Help g
WSk MEs & |@mcm.ﬁx| ¢ o
ClassMatrix-16 ClassMatrix-19 Cn&re — &

Classhatric-18 ] [o =] - Classhdatri-14 [EEE=]

Class Speed Matrix

Cloning a report

Changing areport's datasets via the right-click menu is the fastest way to process a group of datasets. Load as many
datasets as possible into the File Management List, then step through them via the Datasets option in areport's
right-click menu, printing or saving for each iteration.

Report cloning makes common tasks, such as extracting each direction from bidirectional data, even more efficient.
For example, generate areport filtered for the primary direction, cloneit, then right-click and change the Local
Profile to the secondary direction. Tile the reports on-screen, then apply the dataset swapping method described
above for each report.

Another common task is comparing datasets, and it isimportant to start with an identical Profile, especialy the
vehicle filter settings. The simplest way to achieve thisisto clone an existing report, right-click the new report and
change the Datasets. Thisis much faster and more reliable than generating two reports via the Report Wizard.

options (such as aligned hours or aligned days) is highly recommended. This ensures the start and end times will be

2 Note: Remember when toggling datasets on an existing report, using one of the Profile's time filter auto-wrap
automatically recalculated for the new datasets.
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Daylight Saving Adjustment

MCReport provides optional support for Daylight Saving transitions, by adding or removing raw data. Data files
containing a Daylight Saving transition will have an empty period of data added at the beginning transition, and a
period of overlapped data removed at the ending transition. Files without a Daylight Saving transition are unaffected.

The Daylight Saving zoneis set in MCReport's Global Settings, by selecting Tools » Settings from MCReport's main
menu. The selected zone will be applied to all datasets. Each zone has an entry per year, to allow for years with
exceptional changes.
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MCReport settings

Folder far report autput
C:\Users\MTE Demo User\DocumentstMetioCounttMTE 3 21400 C]

Printer marging for partrait pages (mm)

European Union
Left=10. Top=10, Right=10, Bottom=10 |

Bias Transition date Local time:

:O: +3600 Sunday, 26 March 2000 01:00
E—asao Sunday, 29 October 2000 02:00
T +3600  Sunday, 25 March 2001

[@-s500  Sunday, 28 October a1

T 43600 Sunday, 31 March 2002

Printer margins for landscape pages (mm)
Left=10. Top=10, Right=10. Bottom=10

T et file encoding
[amsi

Daylight adjustment zane

u-asuo Sunday, 27 October 2002
L 43600 Sunday, 30 March 2003
@00 sunday, 26 October 2003
Y 43600 Sunday, 25 March 2004
E-EGUU Sunday, 31 October 2004
;()’l 430N Sundaw 27 March 2005

European Union

Mext repart index
0

r

[ Increment report index on recalculate
[] Show translation tokens instead of test
Recyele help windows

[¥]Wam befare Interet cannection

Daylight adjustments are only applied when datasets are intially loaded.

Adjusting for Daylight Saving

The selected Daylight Saving zone is displayed in each report's header. Transitions that occur within the duration of
the report will be listed next to the zone.

Datasets:

Site: [Narrows Loop South] Narrows Bridge South

3 - South bound. - Lane= 1, Added to totals. {/1.000)
3 - South bound. - Lane= 2, Added to totals. (/1.000)
s

o rrtE-Berember desdTuasday 31 March 2009
Australia (WWA) [03:00 Sunday, 29 March 2009 - -3600
. PETTRIE

P s
Identifier: AG1EFBMI MCE805-:20 (c)MetraCount 160ct03
Algorithm: Binned events, 5 minute steps (Interpolate On)
Data type: “ehicle sensors - Separate (Count)

Daylight Saving transitions are indicated in the report header
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Report Assemblies

Report Assemblies are afeature in MCReport for automatically regenerating an active report. Saving a report as an
assembly creates afile with references to everything required to regenerate the report, including:

e Thetagged datasets.

e Thelocal Profile.
 Algorithm settings.

e Custom List properties.
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When an Assembly is loaded, the referenced datasets are loaded into the File Management List, and a new copy of
the original report is generated - all without interacting with the Report Wizard.
Report Assemblies have a number of important uses:

« Saving the source files to recreate an exact report for future reference, rather than just the report output.

» Grouping source files together for copying to another user, so that they may generate the same report.

« Asastarting point for regularly generated reports, whereby a group of datasets can be rapidly processed by
swapping datasets via the right-click menu.

Assembly Load and Save functions can be found in MCReport's File menu. Selecting File » Save assembly will save
the currently active report. MCReport initially defaults to the Assembly folder under MTE's working folder location.

Report state

Report assembly

Current repart state can be seen here...

= WeeklyVehicle-20
E-@ Datasets

L 3
A File = CAUsers\MTE Demo User\Documents\MetroCount\MTE 21818 amplesturbanty,

- B Algorithm = Factory default
@ Input A =1

: -8 InputB =0

S Profils

A} Friendly Name = MCReport

w2 File = C:\Users\MTE Demo UsersDocumentsiMetioCountMTE 318\Softwars\MCReportini
[0 Parameters

<« i, »

Make a new copy of data files

Make & new copy of cunent Profile and Algorithms.
\ —

Saving a report Assembly

Saving areport Assembly creates atext file with a .stx extension. By default, references to datasets, Profiles and
other resources will have absolute paths. This means when loading an Assembly, it expectsto find al filesin their
original location.

There are two options when saving an Assembly - to copy datasets, and other support files, to the same folder as the
Assembly file. With these options checked, file references will have arelative path, and can therefore be copied
around as a group, even to another PC.
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Vehicle Filter Settings

Overview

Profile vehicle filtering is used to exclude certain vehicles from a report and specifically target others, based on the
key vehiclefiltering criteria of class, speed, separation and direction. For example, the direction filter is used for
bidirectional sites to give separate reports for each direction.

These settings are grouped into the main Profile dialog box, where each is a clickable button that leads to the
available settings for that criteria. Note that these settings are only relevant for Classification reports, and are
disabled for Event Count reports. Time filtering is covered in detail in its own section.
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Wehicle and report

Wehicle filtering and report sett

Speed | Include vehicles with speeds between 10 kmdh and 160 kmvh

Separation [No fiter on Separation - [Headway] ]

Dircction [Harh, Esst, Sauth, West bound ]

Classes | Inchude class 1.2,3.4,5,6.7.8,9,10,11,12.13

Profile vehicle filter settings

Speed Filter

The Speed filter excludes vehicles outside the specified range. The default rangeis 10 to 160 km/hr, or 10 to 100
mph. This may need to be changed for sites with an expectation of significant numbers outside of thisrange. The
upper limit is 200 km/h or 140 mph.

Speed range ===

[Speed units are km/h

Include vehicles.
Below

160 %
s 45

RIE I

[ Default ] | Ok H Cancel ]

Speed filter range
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Separation Filter

Separation for avehicle isthe time since the last vehicle travelling in the same direction. Separation can be defined

as Headway (first axle to first axle) or Gap (last axle to first axle) in the Advanced Profile options. For example, a oy
separation of "more than four seconds" will only include vehicles with more than four seconds in front of them. o
=1

Separation lg‘ U

Include vehicles with separations. 8
() Less than :_"b

@ More than (0]

0 Seconds @

Bnn

[ MNosepaation | [ Cancel |

Separation filter

Direction Filter
Manual Setting

The Direction filter includes and excludes vehicles based on their direction of travel, derived from the direction
specified in a dataset's header. The default setting is all directions included.

Direction filter compass examples

The black arrows in the compass indicate the combined direction codes of the tagged datasets. The first example
above indicates at |east one tagged dataset with a unidirectional code of North-bound. The second example indicates
datais available for both East and West-bound traffic. This may be from a bidirectional dataset, or separate east and

west datasets.

Remember, the direction code specified when a RSU was setup is simply a descriptive field. Data may still be
available for directions other than those indicated by the compass.

b 9
Direction filter @ Direction filter @

Directions included in reports Directions included in reports
FS Marth -~ Marth
= 4 =2
H

South South

N
‘ Wm E ’ Elack amows in compass circle are the Wm E Elack amows in compass circle are the
Kj available directiors. Kj available directiors.
& &
~] T ~] T

Direction modifier

Dirgction modifier
[None v] [None v]

Toggling included directions
Directions are included and excluded by toggling the four buttons around the compass, the effect of which can be
seen in the Directions included in reports box at the top. A black crossin a button indicates that direction will be
excluded from the report.

Automatic Setting

The Direction modifier drop-down list at the bottom provides a number of automatic direction filtering options. The
Auto-select options automatically set the four direction buttons per the compass directions. The Primary direction is
the A>B direction, and Secondary is B>A. Where multiple datasets are tagged, the A>B direction of the first tagged
dataset is used. Note that the four buttons are disabled when using these options.
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Direction filter & u

Directions included in reports
o North
. . .
x W’m E x Black amows in compass circle are the
J &/ J svailsble diestions
s

Direction madifier
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[Aulo-se\ecl primnary direction -

tion
Auto-zelect primary and secondary combined
Only A-B vehicles
Onily B-4, vehicles

Auto-selecting the primary direction

The last two optionsin the list filter vehicles based on their A>B or B>A direction of travel, before the normal
compass direction filtering is applied. This can be used for entering and exiting filtering where several RSUs are
used to cover asite, and a consistent A>B layout is used for each RSU.

Class Filter

The Classfilter lists the vehicle classes for the classification scheme selected in the Advanced Profile options, with a
check box to include or exclude each class.

Each classification scheme specifies the classes that are included by default. For example, schemes normally exclude
the unclassifiable vehicle class by default. Thisis usually the last classin a scheme (designated ??7?).

Class zero isaspecia class, which consists of groups of hitsthat can not form a vehicle (usually fewer than four
hits), such as hits detected while the sensors are being setup. This classisfor diagnostics only.

Included vehicle classes ﬂ
Scheme
R
Classes
1M
25y
ISVT
4782
5783
&
7ARTS
BART4
|| [@94RT5
| 104RTE Check all
118D Uncheck al
2 R T
13777
Canesl
[ Include unknow axle groups [Class 0)

Class filter
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Time Filtering

Overview

Profile time filtering controls the start and finish time of areport, with arange of options to automatically set
common time filtering requirements. Selected periods can also be excluded based on time of day, and day of the

week. All adjustments can be made to any 15-minute boundary.

Time:
From 00:00 Tuesday, 21 September 1993 to 00:00 Monday, 27 September 1993

Profile time filter settings

The time filter options are accessed by clicking the button showing the currently selected time range. The chart
above the button represents the available time range for the tagged datasets. The blue line in the centre represents the
range of actual data, from the start time to the last detected sensor hit. The red bar represents the selected time range.

The default behaviour of aLocal Profileisto select the entire time range. Time filtering is primarily used to avoid
partial time bins at the start and finish of reports, and for including integral numbers of complete hours or days for

statistical analysis.
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Time Range
Manual Setting

The time range of areport can be manually set using the controls in the Include vehicles after (start) and Include
vehicles before (finish) blocks. The buttons, or spin control under the time adjust the time in hourly steps, or 15

minute stepsif the Allow 15 minute granularity option is checked. The date spin control stepsin days.

Auto-Wrap

The Auto-wrap options automatically adjust the time range to a selection of common filtering requirements. If the

{[F= 00 horday. 20 Seplember 1953

14:24 Monday, 27 Saplamha 1553

<< Set o start

Include vehicles after..

bl oooo Tue 21 Sep 1943

Include vehicles before...

Settoend »>

iifili) ton 27 Sep 1933

Exelusion tin

[T Use exclusion

Autowrap

['wrap to actual data
[ Align reports to start of ime rangs

Allow 15 minute granularity|

(or [ cononl ]

Manually setting the Profile time range

selected wrap type cannot be applied to the available data, the time range chart will flash.
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Time range ﬁ
12:32 Thursday, 12 Julyp 2007 12:44 Friday, 27 July 2007
Include vehicles after Include vehicles before.
<< Set to start Settoend >

o0:.00 Fil3 Jul 2007 o0:.00 Fiz0 Jul 2007

Exclusion times Autowrap

[Filsl seven aligned days 'J
None

[[1Use exclusion Entire dataset
Aligned hours
Aligned days
Aligned weeks

—

Unaligned days [24-hour periods)
Unaligned weeks (168-hour periods)

First unaligned day [24 hours)

First bwo unalighed daps [48 hours]
First sewen unaligned days (168 hours]
First eight unaligned days (192 haurs)

First masked day [24 hours]
First bwo masked daps (48 haurs)

Time Filter Auto-Wrap options
Aligned Auto-wrap options adjust the time filter to the maximum number of the selected time increment (hour, day
or week), aligned to the selected time increment. Put ssimply:
« Aligned Hours wraps to complete hours.
 Aligned Days wraps to complete days, starting at midnight.
» Aligned Weeks wraps to complete weeks, starting midnight Monday (or Saturday for alternate weekends).
Unaligned Auto-wrap options adjust the time filter to the maximum number of the selected time increment (hour, day

or week), but only aligned to hours. For example, First two unaligned days (48 hours) will select the first two days of
data, aligned to the first complete hour.

Masked Auto-wrap options select the maximum number of contiguous time increments not masked by the Time
Mask. For example, the first 48 hours of weekday data can be selected by masking weekends with the Time Mask,
then selecting First two masked days (48 hours).
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12:32 Thursday, 12 Julyp 2007 12:44 Friday, 27 July 2007]

lAutowrap
First twa masked days (48 hours)
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Auto-wrap with weekends masked

The Wrap to actual data option aligns the Auto-wrap options to the last hour, day or week containing sensor hits, as
represented by the blue line. The time of the last sensor hit may differ from the dataset finish time if the RSU was

removed from the field before unloading.

13:00 Monday, 20 September 1333 14:24 Monday, 27 September 1333

Wiap to actual data)

Wrap to actual data option aligns to last sensor hit
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Time Exclusions

The Time Mask is used to exclude particular times of the week (with 15 minute resolution), or selected dates from
the time range of the tagged datasets. Some common uses for the Time Mask:

» Excluding weekends.
» Targeting "school hours" for variable speed limits.
e Excluding holidays.

The Time Mask settings are accessed by clicking the Mask button. Note that the Use exclusion option must be
checked for the Time Mask to take effect. The masked times will be represented by black regions in the time range
chart.

12:32 Thursday, 12 July 2007 12:44 Friday, 27 July 2007]

1232 Thu 12 Jul 2007 1244 Jul 2007

(| | (T T .

Use exclusion

Excluding time using the Time Mask

The Time Mask uses a grid representing a week divided into hours. Shaded hours will be included in the report, and
white hours excluded. Each hour can be toggled by clicking on it, or rapidly toggled by clicking and dragging. Entire
rows and columns can be toggled using the + and - buttons.

Exclusion

Clear all Inwert

Feport is generated for shaded arsas

Fri
Sat
Sun =

E B EdEBEEHEEHEEEDEEHBEEDBEEBREEEBD

Exclude checked days [maximum of seven)
[] Thursday, 12 July 2007

[ Friday, 13 July 2007

[] Saturday. 14 July 2007

[]Sunday. 15 July 2007

[T Monday, 16.July 2007

[T Tuesday, 17 July 2007

[]'wednesday, 18 July 2007
[] Thursday, 19 July 2007 Cancel

Time Mask with weekends excluded
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Right-clicking on any hour displays adialog box with 15 minute resolution. The Repeat on all days option will copy
the selected hour across the entire week.

2 Note: For reports where data is binned into hours, excluding part of an hour in the Time Mask will exclude the entire

hour.
Py
3
Quarter hours @ o
pm i
Y
=
o
=
7:00 715 7:30 745 8:00 6
n
Fiepeat on all days

Setting partial hours

Specific dates can be excluded from areport by checking them in the Exclude checked days list at the bottom, up to a
maximum of five. Use this feature for excluding dates that may adversely affect statistics, such as holidays.

Time Alignment

The Align reports to start of time range option changes the beginning of reports to the first time step (option
checked), or the natural division (default unchecked). Take for example the Weekly Vehicle or Daily Classes
reports. The natural division of these reports is weeks, starting at Monday (or Saturday for aternate weekends).
Checking this option will start the report at the first day in the selected time range. Thisis extremely useful for
printing a complete week of data on a single page.

5
& MCReport - WeskiyVehicle-55 =[@] = ]
File Edit View Graph Tools Window Help
HEREmu? | d8p 200 e =
‘ Weekly\ehicle-55 Weekly¥ehicle-56 |
Wfeeklyehicle-55 = ]=] WeeklyWehicle-56 [S=r=]
Mon Tue Ted thu  _Fri ) sat Sun ~ C Fri_ )  sat Sun Mon Tue Wed Thu =
09 Jul 10 Jul 11 Jul 12 Jul 13 Ju 14 Jul 15 Jul 13 0ul 14 Jul 15 Jul 16 Jul 17 Jul 18 Jul 19 Jul
Hour Hour
0000-0100 * * * * 194 414 549 0000-0100 194 414 549 172 141 193 226
0100-0200 i i # # 125 z52 z99 0100-0200 125 252 299 106 ] 114 130
0200-0300 4 . - = 91 171 232 0200-0300 91 171 232 &0 73 81 91
0300-0400 i i # # 123 143 200 0300-0400 123 143 200 125 1zl 126 130
0400-0500 % . = Fr A 351 310 333
0500-0600 * * M (e 705 700 696
0600-0700 i i # 1431 1486 1519
0700-0800 B » » 12:32 Thursday, 12 July 2007 12:44 Friday, 27 July 2007 1963¢ 1981«  1863<
0900-1000 % . = 1554 1549 1583
1000-1100 * * » Include vehicles after Include vehicles before 1487 1478 1508
1100-1200 N N N << Sel to start Sel toend >> 1572 1622 1532
1200-1300 4 . - 1611 1568 1571
1300-1400 * * * 00:00 Fii 13 Jul 2007 00:00 Fii 20 Jul 2007 1593 1530 1593
1400-1500 % . = 1614 1581 1625 |=
1500-1600 * * * . 8 . 8 . 8 . 8 1888 1843 1773
1600-1700 i i # 2052<  2008<  1923<
1700-1800 " " " Exclusion times Auto-wrap 2044 1999 1912
1800-1900 i i * [First seven aligned days - 1426 1515 1473
1900-2000 % . = [Flwhrep to agiugl data 926 1049 910
2000-2100 * * * [T Use enclusion ey ok o
2100-2200 i i # 773 920 51
3208-2308 N N N [ Allow 15 minute aranulanty 5o 03 ea
2300-2400 i i # oK Cancel 359 401 366 -
< m \ - — ] '

A Weekly Vehicle Report, aligned to the first day (weekends underlined)
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Units of Measurement

MCReport can display reports in either metric or non-metric units. MetroCount RSUs simply time-stamp sensor hits,
so the raw data has no concept of units of speed or length. MCReport performs all internal calculations using Sl
units, and a report's Profile determines the units to be displayed.

The option to use metric or non-metric units can be found in a Profile's Advanced options, under the General page.
The various units of measurement that will be used are displayed immediately below.
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General | Farmat I Header | Colors | Scheme I Speed | Mass I Separation | Ad\ustl
Profile file path
Default Profile

Culture

Use metic measurement units
Units - [meter. kilometer] (més. kmdh) (ka, tonne])

[Saturday -Sunday = | weskend

Arithmetic rounding Test Fiesult
[Pround half up ~] 3500000 = Plus =4, Minus =3

Selecting units of measurement

The units of measurement option also affects other optionsin a Profile, such as the speed range filter and speed bins.
When the units of measurement are set via MCReport's New user options these other settings will be set to standard
valuesin the Default Profile.

When toggling the units of measurement in a Profile as described above, other settings will be directly converted
between metric and non-metric, which may result in non-standard values. Most options have a Default button
available to quickly return to standard values.
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Classification Schemes

Overview

MetroCount's time-stamped raw data collected using two parallel axle sensors enables M CReport to apply any
axle-based classification scheme. Multiple schemes can be applied to the same data for different applications. As
new standards and schemes are developed, they can be applied to existing data.

M CReport provides several built-in, highly optimised classification schemes called OEM Schemes, which are
commonly used around the world. A range of user-defineable External Schemes are also provided.

Every scheme has two special classes: an unclassifiable vehicle class, and an unknown axle-group class. The
unclassifiable vehicle class, usually designated as the last class, isagroup of partitioned sensor hits considered to be
avehicle, but not matching any of the scheme's classes. The unknown axle-group class, designated as class zero, isa
group of sensor hitsthat isn't considered a vehicle - usually fewer than two matching AB sensor hit pairs.

Every scheme has a set of classes that are enabled by default in a Profil€'s class filter, which usually includes all
classes, except the two special classes. The unclassifiable vehicle class may be of interest for checking data quality,
or suitability of a particular class scheme. A high percentage in this class may indicate a problem. Class zero can be
generally considered as noise, and isonly ever used for diagnostic purposes.
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Selecting a Scheme

A classification schemeis selected in the Scheme page of a Profile's Advanced options. A shortcut to this pageis by
clicking on the Scheme button in a Profile's main dialog box, where the name of the currently selected schemeis

displayed.
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Scheme |Classified wehicles - ARX

Shortcut to the Advanced option's Scheme page

The available schemes are presented in atree, divided into OEM and External schemes. Selecting a scheme will
provide a short description. Note that changing between schemes will reset the Profile's class filter to the selected

scheme's defaullt.

General | Formal | Header | Colors | Scheme | Speed | Mass | Separation [ Adjust |

Class scheme Class scheme description
=-{z OEM schemes | |Scheme AR iz a modification of AustRoads94. |t removes class 12,
P @ moves all other classes up by one, and inserts a shart bwo-axle class as
&, Sohams £ + class one
B, Scheme F2 +
-8 Scheme F93+
9, dusiFoads34 +
- 8 NAKSRA +

B Swedich + Agaregate the selected class scheme

B, Swedishz +
8 TNZ 1999 + Species=4
{ L, Scheme Aule
=i External schemes
-3 5720 Cycle +
3, Akansas F99+
- 3 AR Cpcle +
§, Chelsea
- & DIT-UK
-5 Eul3+ il

Event count method
[Count events divided by setup divisor

Interpolate binned data

Selecting a Classification Scheme
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Aggregating a Scheme

Most classification schemes define a grouping of classesinto similar types of vehicles. For example, schemes
commonly group passenger vehiclesinto light, rigid trucks and buses into medium, and articulated vehicles into
heavy.

Schemes that define a set of Aggregate classes have a+ character after their name in the scheme tree. Selecting the
Aggregate the selected scheme option will produce reports with the Aggregate classesinstead of the base classes.
The Profile's class filter will be automatically set to the defined aggregate classes.
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General | Foimat | Header | Colors | Seheme ‘ Speed I Mass | Separation I Ad|ust|

Class scheme Class scheme description
E@ DEM schemes | [5cheme 4R is a modification of &ustRoads34. It removes class 12,
[ g AR + || |moves all other classes up by one, and inserts a short bwo-axle class as
H B Scheme F + class ane. Globals | Mames
- B Scheme F2 +
H @ Scheme F39+ Class  Class Mame Agaregate Agaregate Hame
fee B AustRoadsH + A0
& NAASRA + L

% gwej\s:g [/] Aggregate the selected class schemel Lo
wedish2 +
H B TNZ 1999 + Species=4 -
B Scheme Axle =
=& aclemal schemes e
5720 Cycle +
Med
B Arkansas FI9+ edium
B 4RX Cycle + Haauy
-3 Chelsea oo
- 3 DITUK
% Euold + 8

[T R T A

Haavy

=Y

Heavy
Yo

Event count method

[ Count events divided by setup divisor

Interpolate binned data

Combining classes using Aggregates

The mapping of base classes into Aggregate classes can be viewed by clicking the Details button. The Names page
lists al of the base classes for the selected scheme, and the Aggregate classes they map to. For the following
example, base classes 1-3 map to Aggregate class 1, base classes 4-6 to Aggregate class 2, and 7-12 to Aggregate
class 3. Asageneral rule, the unclassifiable vehicle class will map to the same Aggregate class number, in this case
13.

A report's header also displays the Aggregate class map in condensed form. For example, (ARX Aggregate (01112
22333333 13)) represents the previous example. Count along for the base class (starting at zero), and the
number isthe Aggregate class.

Aggregates, just asthey do the individual classrules. External Schemes are user-editable, and contain a section that

2 Note: The Aggregate mapping for OEM Schemesiis not editable. Most classification scheme specifications define the
sets the Aggregate mappings.
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Speed Bins
Editing Speed Bins

Speed binsin MCReport are completely flexible. Given the raw datain MetroCount datasets, vehicles are binned
during analysis, per the speed bins set in areport's Profile. A maximum of 30 speed bins can be set, and each can be
enabled and disabled as required.
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| Generel | Fomel | Headen | Colos | Scheme | Speed | Mass | Seperalion | Adist|

x| Wil

Speed Multiplier =+
0 Addbin L

010
10:20

2030
30-40
1050
50-60
BO70

a Bin multiplier

~ Speed limits [km/h)

0
i
1
1
0
i
i #  Scale(¥)  Offset(kmhl Name
v 7080 i o 1m PaL
v 030 0 @1 1m
|| 30100 0 @2 10
0
i
1
1
0
i
i
1
1
0

[wI100110 2 1m0
[w]110:120 @ 1m0
[¥l120130 s 100
|| 130-140
|| 140150
|| 150160
Wl 160-170

100

=

Gt posted speed limit from data
=11} Fosted speed limit

- Speed statistics (km#h]

170-180
180190
190200

Percentile 1 Percentile 2

Default o T | *

Modifying speed bins

Speed bin settings are located in the Speed page of the Advanced Profile options. The speed units (km/h or mph) are
per the option in the General page. Speed bins are defined in the list on the left, with the check-boxes used to
determine which binswill appear in reports. Vehicles falling in hidden bins are till included in statistical
calculations.

Thelist of speed binsis contiguous. Each speed bin includes its lower bound, but not its upper bound. For example,
the bin 50-60 includes all vehicles travelling 50 and above, but less than 60.

Speed bins are added by using the slider bar at the top. Moving the slider to the desired value and clicking the Add
bin button will split the bin that contains that value, creating two new bins. For example, given the bin 10-20, adding
ahin at 15 will result in the bins10-15 and 15-20.

Selecting a bin and clicking the Delete bin button will remove the bin, and join the upper bound of the preceding bin
to the lower bound of the following bin. For example, given the bins 10-20, 20-30 and 30-40, deleting 20-30 will
leave 10-30 and 30-40.

The Default button at the bottom will return the speed bins to atypical set of values.

Speed Bin Multipliers

Each speed bin has a user-defined weighting value called a Multiplier. Multiplying the total vehiclesin each speed
bin by the bin's multiplier, and summing the results gives a value called the Speed Rating. This value can be used for
comparing sites, such as by the severity of speeding.

Changing abin's multiplier is ssimply a matter of selecting the bin, and entering a number in the Bin multiplier box.
The bin's multiplier will automatically update.
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Speed Limits and Statistics
Posted Speed Limit

The Posted Speed Limit (PSL) is the speed limit at the site where data was collected, and is used as the basis for
speed statistics such as the number of speeding vehicles. The PSL can be settings are located on the Speed page of
the Advanced Profile options.

— =
Speed (mits (km#h]
# Scale (%] Offzet (knsh]  Mame |~
o 1o i PsL
{81 100 5 PSL+5 =
faz 110 0 PSL+10%
2 RIEER] 0 4

=
&4 100 i
s 1m0 i
s 100 0 il
FRo aon o
Get posted speed limit from data

: &0

e
Speed limits

The PSL can be automatically derived from the tagged datasets. With the Get posted speed limit from data option
checked, MCReport will scan the Description field of the tagged datasets headers, looking for a PSL in the following
form:

* Must be enclosed in angle brackets < >

« Default iskm/h. Append an'm' or 'M' for mph.

* The PSL can appear anywhere in the description, but other angle brackets cannot be inserted when using this

feature.
Example Site Descriptions
km/h mph
Hay St <60> <40 mph> Speed test, Euston Road
<60km/h> Hay Street ACPO test, Harrow Road <40m>
Hay St, <50 km/h> study Harrow Road, PSL=<40 MPH>

With this option checked, if MCReport does not find a valid speed limit, or there are multiple tagged datasets with
conflicting PSLs, the PSL will be set to zero.

The best time to insert the PSL into the Description field iswhen a RSU is setup, and when creating Site Lists. For
existing datasets the PSL can be inserted into the description using the Transform data file feature in MCReport's
File Tree.

When the automatic PSL option is unchecked, the PSL can be manually entered in the Posted speed limit box
provided.

Speed Limits

The Speed limits list allows up to 10 additional speed thresholds to be set based on the PSL, using the formula (PSL
* Scale/100) + Offset. The Scale column is a percentage, and Offset can be a positive or negative amount, in the
same units as the PSL. Each additional limit can also be uniquely named.

To edit a speed threshold, simply double-click. Note that the first limit in the list is always the PSL, and cannot be

changed.
Speed limits [
Limit = PSL * Scalef/100 + Offset
110 Scale (percent)

a OFfset kfh

PSLHI0%  Mame

Editing speed limit thresholds

For example, given aPSL of 80, a scaling percentage of 110 will result in a speed threshold of 88. For asimple
offset, leave the scaling percentage at 100 and use the Offset field.

Thresholds which are |eft as the same as the PSL (100% + 0) will not be displayed in reports.
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Speed Percentiles and Pace

The nth speed percentile is the speed below which n% of vehicles were travelling. For example, the commonly used
85th percentile is the speed bel ow which 85% of vehicles were travelling. MCReport supports two speed percentiles,

which can be set in 5% steps.

The speed pace is a continuous band of speeds n km/h or mph wide that contains the largest number of vehicles. The
speed pace is a measure of the dispersion of speeds at a site, based on the number and percentage of vehicles within
the pace. The speed pace can be set in 5 km/h or mph increments.
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Speed statistics [kmdh)
Percentile 1 Percentile 2 Pace
85 - 595 - 20 -

Speed statistics

For example, given a speed histogram, the 85th speed percentile will be avertical line, with 85% of vehiclesto the
left. A 20km/h pace is aband 20km/h wide that contains the most vehicles.

Conceptual speed histogram examples showing 85th percentile, and 20km/h pace
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Speed Statistics Block

Many speed-related reports combine the above speed limits and statistics into a compact block. An example of the
form of thisis provided below.

Vehicles = 125765
Posted speed limit= 80 km/h, Exceeding = 84352 (67.07%), Mean Exceeding = 86.88 km/h
Limit 1 (PSL+10%) (80 * 110%) + 0 = 88 km/h, Exceeding = 27223 (21.65%)
Maximum = 174.7 km/h, Minimum = 0.0 km/h, Mean = 83.2 km/h
85% Speed = 90.0 km/h, 95% Speed = 95.8 km/h, Median = 82.4 km/h
20 km/h Pace = 73 - 93, Number in Pace = 107015 (85.09%)
Variance = 60.72, Standard Deviation = 7.79 km/h
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Separation

Headway vs Gap

Separation isthe time in front of avehicle to the last vehicle travelling in the same direction. The Separation pagein
the Advanced Profile options provides the option to define separation as:

« Headway - time between the first axles of two vehicles.
« Gap - time between the last axle and first axle of two vehicles.

-~

L(wﬂh overhang)
Separation definitions

When using gap, the Estimate vehicle overhang option makes a reasonable adjustment to the actual value to account
for the distance between the detected axle and the physical end of the vehicle.

‘ General | Format | Header | Calors I Scheme | Speed | Mags | Separation | Adjust

Separation Multiplier | 11 of 30 used
@005 i Breakpoint

@051 0 Addbin

@12
24

%4'9 0 Bin multiplisr

I ®816

@163

@ 3264

(®64128

(&1128-1000

(% 5top at 1000

(@ Separation is Headway
() Separation is Gap

[ Estimate vehicle overhang|

coocoooocoo

< [0

| Canesl

Separation definition
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Separation Bins

Editing Separation Bins

Separation bins, like speed bins, are user-definable up to a maximum of 30 bins. The separation unit is seconds, and
uses the separation definition option described above.

Thelist of separation binsis contiguous. Each separation bin includes its lower bound, but not its upper bound. For
example, the bin 1-2 includes all vehicles with a separation of one second and above, but less than two.

Separation bins are added by entering a value in the Breakpoint box, and clicking the Add bin button. Thiswill split
the bin that contains the entered value, creating two new bins. For example, given the bin 0-0.5 adding abin at 0.25
will result in the bins 0-0.25 and 0.25-0.5.

Selecting a bin and clicking the Delete hin button will remove the bin, and join the upper bound of the preceding bin
to the lower bound of the following bin. For example, given the bins 1-2, 2-4 and 4-8, deleting 2-4 will leave 1-4 and
4-8.

The Default button at the bottom will return the separation binsto atypical set of values.
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Separation Bin Multipliers

Each separation bin has a user-defined weighting value called a Multiplier. Multiplying the total vehiclesin each
separation bin by the bin's multiplier, and summing the results gives a value called the Separation Rating.

Changing abin's multiplier is simply a matter of selecting the bin, and entering a number in the Bin multiplier box.
The bin's multiplier will automatically update.
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Estimated Mass

MCReport provides basic support for estimated pavement loading calculations, based on the volume and class
distribution of traffic. The Mass page of the Advanced Profile options provides a table to enter estimated standard
axles, freight mass and gross mass, per class of vehicle.

pte o =
| General | Format | Header | Colors | Scheme | Speed| Mass | Separation | Adjust |

Class  ESA  Freight mass (kg)  Gross mass [ka) il
0 0 0 0

1 0 il il

2 0 0 0

3 0 0 0

4 06 2000 2000 E
5 15 5000 13800

] 36 9000 19300

7 13 4000 13600

8 17 5000 16800

3 26 11000 24300

10 31 15000 31000

1 53 22000 42000

12 57 33000 57200

12 0 0 0

14 0 a a

15 0 0 0

16 0 0 0 o

|

Estimated Mass table

To edit arow in the table, simply double-click. Unitswill be kilograms (kg) or pounds (Ib) per the units option in the
Advanced Profile's General page.

Mass edit bax =]

4 Wehicle class

06 Equivalent standard asles

2000 Average freight mass (kg)

] Average gross mass (kal

—

Editing mass table rows

Note that thistable is closely linked to the selected classification scheme, and may differ between regions and
counties that use the same classification scheme. Values are normally derived from weigh-station data of regional
vehicle types, and their freight and gross mass.

Reports that use the Estimated Mass table include the Custom List report, and Daily Classes (Estimated Mass).
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Weekly Vehicle Counts

Continuous

The Weekly Vehicle Counts report lists traffic volumes by hour in aweekly format, with one week per page. Each
row represents a single hour time step, and the columns represent days of the week, with the actual dates shown.

Mon Tue Wed Thu Fri Sat Sun Averayes
16 Jul 17 Jul 18 Jul 19 Jul 20 Jul 21 Jul 22 Jul 1-5 1-1
Hour |
0000-0100 172 141 193 226 218 413 5zz | 1s80.0 268.3
0100-0200 108 89 114 130 113 252 Zg2 | 110.4 155.1
0200-0300 a0 73 gl a1 119 177 216 | 88.8 113.6
0300-0400 125 121 lz26 130 139 148 120 | lz28.2 138.9
0400-0500 318 351 310 333 264 215 173 | 315.z 281.3
0500-0600 728 705 700 EL) 63z 398 276 | 63z.z 590.4
0600-0700 1562 1491 1486 1519 1483 574 345 | 1508.2 1208.6
0700-0800 1915< 1963< 1981< 18363C 1338 785 591 | 1911.6< 1%62.0
0800-0900 1877 lgz7 1841 1762 1844 1038 g5l | 1830.2 1577, 3<
0900-1000 1433 1554 1549 1583 1578 1152 91l | 1549.4  1401.4
1000-1100 1461 1467 1478 1505 1521 1233 1088 | 1486.4  140Z.9
1100-1200 1560 1579 1622 1532 1602 1466 128%<| 1579.0 1521.1
1200-1300 1555 161l 1588 1571 1g4l 1362 1369<| 1589.2 1525.3
1300-1400 1518 1593 1530 1593 1563 1350 1280 | 1560.6 1430, 4
1400-1500 1601 1614 1581 lgz5 1657 1343 1288 | 1615.6 1529.9
1500-1600 1761 1633 1543 1773 1658 1z36 1zal | 1784.6 1641.4
1600-1700 1955 2052< 2008 1923 1999 1252 1236 | 1987.4 1777.9
1700-1800 1989 2044 1999 191z 2001< 1422< 1273 | 1989.0< 18505.7<
1800-1900 1316 l4z6 1515 1473 1552 1128 924 | 1456.4  1343.4
1900-2000 540 9z6 1049 M) 1063 1014 735 | 957.6 933.9
2000-2100 718 798 847 g1l% §14 1036 660 | 79G.0 Glz.3
2100-2200 711 773 20 851 806 1098 613 | 8lZ.zZ 824.7
2200-2300 515 656 703 B854 T8z 794 519 | 658.0 657.6
2300-2400 281 353 401 366 611 677 303 | 403.6 428.3
|
Totals |

|
0700-1900 19331 20624 20515 20115 z045z2 14344 13410 [20338.4 18578.7
0600-2200 Z38B20 24612 24817 24210 24618 1B6RET 15763 |24415.4 22358.1
0600-0000 24616 25627 259zl 25230 25991 20133 16555 [25477.0 23444.0
0000-0000 26145 27107 27445 26836 27476 21738 16249 |27001.8 24999.6

|
AM Peak a700 a700 o700 0700 0300 1100 1100 |

1315 1963 1961 1863 1844 1466 1za7 |

|

PM Peak 1700 Lle0o 100 16500 1700 1700 Lzoo |
1989 Z052 2008 19235 2001 1422 1369 |

Weekly Vehicle Counts report

Five-day and seven-day averages are provided on the right side of the report. The five-day average is the average
vehicle flow across week-days. The seven-day average is the average vehicle flow across the entire week. Note that
weekends are underlined.

12 hour (0700-1900), 16 hour (0600-2200), 18 hour (0600-0000) and 24 hour (0000-0000) totals are included at the
bottom of the Weekly V ehicle Counts report. Also included are the AM and PM peak hours for each day, and their
respective hourly totals. Note that the AM and PM peaks are also indicated in the hourly totals by a bold typeface
and a < character.

An asterisk * in the report matrix represents an hour where datais not available for the entire hour, or has been
excluded in the report Profile. Note that thisis different to a zero vehicle count for an hourly period, which will be
correctly displayed with a 0.

The Weekly Vehicle Counts report does not include totals where there is missing data for any period covered by that
total. This prevents results from being displayed that are misleading due to missing data. If totals for partial days of
data are required, consider using another report, such as the Vehicle Counts report.

All averagesin the Weekly Vehicle Counts report are correctly calculated when there is missing data. For example, a
five-day average where two of the days contain no data (asterisks) will be correctly averaged over the three days of
actua data.

Note also that the five-day and seven-day averages next to the totals at the bottom of the report are calculated from
the al available data. This may not be the average of the daily totalsif partial days are included.

Time Filtering

The default behaviour of the Weekly Vehicle Counts report is to align to the first weekday. For a dataset that starts
mid-week, asingle week of datawill span two pages.

To align the report to the start of the dataset, select the Align reports to start of time range option in the report's
Profile. To restrict the report to a single week, consider using the First seven aligned days Auto-Wrap option.
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5
& MCReport - WeskiyVehicle-55 =[@] = ]
File Edit View Graph Tools Window Help
HESR(EiAxD| 80 REMEAee0 0 H o
‘ Weeklyehicle-55 Wesklyvehicle-56 | )
n
e eklyfehicle-55 [ =E=E] Weekbadehicle-56 [SI=E=] (723
Mon Tue Wed Thu Fri sat Sun 4 Fri sat Sun Mon Tue Wed Thu = g‘
09 Jul 10 Jul 11 Jul 12 Jul 13 Ju 14 Jul 15 Jul 13 0ul 14 Jul 15 Jul 16 Jul 17 Jul 18 Jul 19 Jul &
Hour Hour —
0000-0100 * * * * 194 414 549 0000-0100 194 414 549 172 141 193 226 o
0100-0200 i i # # 125 z52 z99 0100-0200 125 252 299 106 ] 114 130 =}
0200-0300 * * * L a1 171 Z32 0200-0300 a1 171 232 &0 T3 81 a1 m
0300-0400 i i # # 123 143 200 0300-0400 123 143 200 125 1zl 126 130 )
0400-0500 * * = & S — 318 351 310 333 S
0500-0600 * * M (e .& l 705 700 696 o
0600-0700 i i # 1431 1486 1519 =
0700-0800 B » » 12:32 Thursday, 12 July 2007 12:44 Friday, 27 July 2007 1963¢ 1981«  1863< 7
0900-1000 x . = 1554 1549 1583
1000-1100 * * » Include vehicles after Include vehicles before 1487 1478 1505
1100-1200 " N N << Sel to start Sel toend »> 1573 162z 1532
1200-1300 ] " " 1611 1568 1571
1300-1400 * * * 00:00 Fii 13 Jul 2007 00:00 Fii 20 Jul 2007 1593 1530 1593
1400-1500 x . = 1614 1581 1625 |=
1500-1600 * * * . 8 . 8 . 8 . 1888 1843 1773
1600-1700 i i # 2052<  2008<  1923<
1700-1800 " " " Exclusion times Auto-wrap 2044 1999 1912
1800-1900 i i * [First seven aligned days - 1426 1515 1473
1900-2000 x . = [Flwhrep to agiugl data 926 1049 910
2000-2100 * * * [T Use enclusion ey ok o
2100-2200 i i # 773 920 51
3208-2308 N N N [ Allow 15 minute aranulanty 5o 03 ea
2300-2400 i i # oK Cancel 401 366 -
4 . »

A Weekly Vehicle Report, aligned to the first day (weekends underlined)

Virtual Week

The Virtual Week version of the Weekly V ehicle Counts report merges multiple weeks of datainto asingle,
averaged week.

Each hourly total in thisreport is the sum of the same hour from each week, divided by the number of weeks that
datais available for that period. Asthisreport is a mathematical representation of average vehicle flow, totals are
displayed as floating point numbers.

The layout of the Virtual Week version isidentical to the continuous Weekly Vehicle Counts report, with the
exception that dates are not included at the top of each day column.
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Vehicle Counts

Continuous

The Vehicle Counts report is based on a 24-hour format. Each day of datais represented by 24 hourly totals, with a
user defined hourly breakdown, called time drops. For example, atime drop of 15 minutes will produce an additional
four totals below the hourly totals, for each 15 minute period.

Time drops that do not contain compl ete data are represented by a hyphen (-). These include time drops excluded by
the time filter, and partial drops where the dataset starts or ends mid-drop. Hourly totals will not be displayed if there
are any missing drops.
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Each day in the report includes aday heading, with the date and the total vehiclesin the report Profile for that day.
Days containing complete data also include a day summary, with the AM and PM peak hours to the resolution of the
time drop, and the total vehiclesin that hour.

The AM and PM Peak Hour Factor is a measure of flow variation within the peak hour. It is calculated as the total of
the peak hour, divided by the peak bin total multiplied by the drops per hour. Therefore, if the peak hour total is
spread equally across the time drops for that hour, the Peak Hour Factor will be equal to 1. The Peak Hour Factor
normally ranges between 0.7 and 1.0.

The last column on aVehicle Counts report is simply the first column from the next day. Thisisfor highlighting a
peak hour that spans across a day boundary. Note that these figures are not included in the daily total.

The Vehicle Counts report has a number of formatting options, including the size of the time drops. These are
accessed via Properties in the report's right-click menu.

* Monday, 16 July 2007 - Total=26145, 5 minute drops
i 0100 000 0200 400 ASHD DERD 0700 0E00 0200 Leau 1Low Lra 1ped Lded LS00 LE0a 1700 1é0d L300 foud fled five $ee

172 16 50 125 315 726 1562 1915 1577 1463 1861 1560 1555 1515 1601 1761 1855 1968 1516 G40 716 711 515 261

T+ 1% 6 & 10 23 &0 15z 15z 106 10# 1rl 1s 14 10 Le0 les 1s9 130 35 & 50 55 0 16
I 16 4 & a0 37 1em 150 185 134 118 16 131 150 10 137 165 1% 118 ™M G657 5T I3 14
111r 4 & @ 4 %% 15% 157 L3S 119 Lis Lis Li6 LiS Lt 166 156 146 st S5 6 39 &8 L6
L 6 7 4 e Sp 1Ly 159 180 Lil Lir L:l L3S Lrt Lit Lre Lis 156
14 ¢ L 6 22 64 137 151 159 Lie Lle Lid Lpd LeS Lie léd LeS 179 Recalculate
16 s 11 6 4 55 127 15% 156 113 1:l 176 12 178 1ré 1x3 163 1s0 .
1* 6 1n 15 25 76 15® 156 158 126 10 13 17 117 141 14z 159 157 Local profile...
18 Lo 7 @ a7 1SL 152 1S5 Li6 L Llr LiS Li 1S 15 165 171 Count format
34 r la om0 L 4L 171 16 LEF 125 L5 1p Lir lék 160 L6T 173 Datasets..
76 & 15 #1155 175 166 17 1r4 13 lir 119 137 15 165 161 em——— Time drops
37 7 1r 35 75 137 161 155 1m0 11§ 1e5 17 1zl ler 150 155 150 P
S s U s dm ww Lw dm i i o i be dmoan e Iy
MM Peak 0720 - 0520 (1944), AM PHF=0.93 FM Peak 1645 - 1745 (2028), FM PHF=0.30 Cut
v
* Tuesday, 17 July 2007 - Total=18073 (ncomplete) , 5 minute drops Copy [ lebrlope e
Wi L LR A2 WA BSR0 RER0 AT G0 000 Tode 11ed Lrad Lred Led 1Se0 1ed 17ed L [7] Show peak hour in calor
181 8 73 121 351 705 1801 1963 1627 1554 1467 1578 1611 1508 1614 1668 - - Faste Use wide (3¢ char.] fislds
16 11 5 7 1& 0 67 1s7 150 113 114 1zl 1rs 141 1x7 147
4 s 3 7 g5 28 7a 153 175 1as 113 oo 158 s s 1se - - Page setup..,
L6 8 6 L 4 #4170 LS4 Ler L6 L Lls L Low 187 - -
09 B 10 fl s L0 182 1rr L 119 1xl 151 137 L4 1% - - Typeface
L6 4 6 2l 44 L35 15T ISL LeS Lid 1ls lét 147 Ll 1&1 - -
6 4 1r 5 6 Lr 157 Les Lsn L3 135 lme L9 1w e - - Page break
T 1 1r 3 7L les 181 15¢ 1m0 136 117 136 1rl 1e9 156 - -
£ 10 5 1t 77 155 18 155 li4 117 Led 14l 139 L6 1t - - Tabs
L& 6 5 Lo 27 7 1e 176 1e L6 L9 L L6 L6 Lé LT - - mmmmer
L 4 & 1o 69 15T 17 174 Lir Le6 e Lé Le? ISt 1St - - - - - - - - -

65 10 75 14t 155 les lrz 107 1z 135 lér 133 176
w7 s 17 23 B 1s0 152 145 13 14z lp4 136 1zl 13 166
MM Peak 0710 - 0210 (1388), AM PHF=0.94

Vehicle Counts report, with format options

Option Description
Time drops Specifies the interval for each time drop.

Includes the day summary row with AM and PM peaks. This line will not appear if a
day does not contain complete data.

Drop totals that are part of the AM and PM peak hours will be displayed in red. Note
Show peak hour in colour | that the peak hour is calculated to the resolution of the time drop, and may span two
columns.

Include pesk line
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Virtual Day
The Virtual Day version of the Vehicle Counts report merges multiple days of datainto asingle, averaged day.

Each drop total in thisreport is the sum of the same time drop from each day, divided by the number of days that
datais available for that period. Note that al totals are rounded to the nearest integer.
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Daily Classes

Standard

The Daily Classes report provides a class breakdown of daily traffic volume, with one week per page.

Each day is displayed with the total daily volume, and the volume and percentage for each vehicle classincluded in

the report Profile.
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The end of each page includes the five-day and seven-day averages. Note that days with incomplete data are not
included in the average calculations.

Sunday, 28 April 2002

1 2 3 4 5 13 1 8 9 10 11 12 13 Total
Sun 62 1BEZS8 E24 ld4 30 2z 11 13 3 ) 1 1 u] 18120
%) 0.4 9&.3 1.4 0.3 0.z 0.0 0.1 o.o o.o 0.1 0.0 -0 o.o
Mon @0 zz4dz 28z 8le 13 2?7 50 38 &7 107 7 0 & z40z4
%) 0.3 93.4 l.z 3.4 0.6 0.1 0.z 0.1 0.2 0.4 0.0 -0 o.o
Tue 78 ZZBZE Z58 g00 144 40 5z 41 47 99 ) o 4 Z4335
%) 0.3 93.86 1.1 3.3 0.6 0.z 0.z 0.z 0.z 0.4 0.0 -0 0.0
Wed 71 23340 243 785 140 Ze 3z 49 £z EL 9 z 2 24848
%) 0.3 93.% 1.0 3.2 0.8 0.1 0.1 0.z 0.2 0.4 0.0 -0 0.0
Thu 61 Z3ZZ5 243 801 141 31 37 53 43 98 10 a 3 24752
%) 0.2 938 1.0 8.2 0.6 0.1 0.1 0.z 0.2 0.4 0.0 0 0.0
Fri B0 23474 E70 207 147 34 a4 47 31 107 ] a 7 ZE0Z4
%) 0.2 93.8 1.1 3.2 0.8 0.1 0.z 0.z 0.1 0.4 0.0 -0 o.o
Sat 70 18436 278 @0 sz z0 13 17 2E &% 4 0 1 19388
%) 0.4 955 1.4 1.8 0.5 0.1 0.1 0.1 0.1 0.z 0.0 -0 o.o
Rverage daily volume
Entire weesk

E7 Z134E 257 B35 11= 25 34 38 35 79 a 3 ZZE4E
%) 0.3 94.3 1.1 z.8 0.5 0.1 0.z 0.z 0.z 0.3 0.0 -0 o.o
Weekdays

&8 Z3I061 259 801 laz 21 43 45 43 o1 o 4 24508
%) 0.3 93.7 1.1 3.3 0.8 0.1 0.z 0.z 0.2 0.4 0.0 -0 0.0
Weekend

€6 17061 251 2z &l 1l lz 11 14 2% 2 0 o 17738
%) 0.4 96.2 1.4 1.2 0.2 0.1 0.1 0.1 0.1 0.1 0.0 -0 o.o

Daily Classes example

Split Direction

The Daily Classes by Direction report includes additional rows where the daily class totals are split into vehicles
travelling in the A>B and B>A directions. The AB% and BA% rows are the directional split percentages, not percentage
of total.

Monday, 29 Rpril 2002

1 z 2 4 5 L] 1 ] 2 10 11 1z 13 Total
Mon 143 43648 544 1654 304 43 EE} 94 73 Zlo 1z 1 e 46838
[£3] 0.3 $3.z 1.z 3& 06 01 0.2 0.2 0.2 0.4 00 0.0 0.0
nB 80 22433 z8Z 8lz 138 z7 50 36 37 107 7 [z} &  Z40ls
AR 55.5 S51.4 51.8 4% 1 454 56.3 S0.5 38.3 50.7 51.0 55.3 0.0 75.0 51.3
B 63 Z1Z1E ZEZ g4z 166 2l 4% £ 26 103 £ 1 z Z2BE3I
BAR 44.1 48.6 48.2 50.9 54.6 43.8 45.5 61.7 48.3 49.0 4l1.7 100.0 25.0 48.7

Daily Classes by Direction sample
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Estimated Mass

The Estimated Mass version of the Daily classes report includes an additional line for each day that lists estimated
standard axles, freight mass and gross mass totals. These values are cal culated from the mass table defined in the

report Profile.
Monday, 29 April 2002
1 2 3 1 k] [ 1 8 9 10 11 12 Total
Hon 80 22433 z82 812 138 27 50 36 37 107 7 a 24009

(%) 0.3 93.4 L.z 3.4 0.6 0.1 0.z 0.l 0.2 0.4 0.0 0.0
E34=1362.6, Freight=5210000.0, Gross mass=14754500. 0kg

Daily Classes (Estimated Mass) sample

Time Filtering
The default behaviour of the Daily Classes report isto align to the first weekday. For a dataset that starts mid-week, a
single week of datawill span two pages.

To align the report to the start of the dataset, select the Align reports to start of time range option in the report's
Profile. To restrict the report to a single week, consider using the First seven aligned days Auto-Wrap option.

N -— s

12:32 Thursday, 12 July 2007 12:44 Friday, 27 July 2007

Include vehicles after. Include vehicles before.

<< Set to start Settoend >

ooon Jul 2007 Jul 2007

Exclusion times AutoWrap

[First seven aligned days

| [[]Use exclusion

Wian tn achual data

| V] &lign reports to start of ime ranae >
|| Allow T minute granularity

Aligning the start of reports
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Class Speed Matrix

The Class Speed Matrix report provides a speed-by-class matrix of traffic data over the entire period of data, in aone )
page format. This report provides an excellent summary of traffic behaviour. 73
=
Vehicles are grouped by class, and by speed as defined in the speed bins in the report Profile. Speed bin totals and §
percentages are given down the right of the report. Class totals and percentages are given along the bottom of the g'
report.

ep 2
D
S‘pllaed (Jansh) S‘peed‘Tutals -8
| Class | =
| 1 2 3 1 3 6 1 8 9 10 11 12 13 | »

10 - 20 | 70 - . z - . . 1 . 11 kL 0.0%

20 - 30 | 1 836 5 14 1 . . 1 . . . . - 858 0.1%

30 - 40 | Z 1657 20 39 4 1 1 1 1 1 . . 2zl 1729 0.2%

40 - 50 | 5 7243 28 233 34 8 7 18 20 3z 4 3 El 7690 0.7%

30 - 60 | a6 34740 457 1156 laz 47 30 &7 45 127 10 5 171 36929 3.3%

60 - 70 | 274 150091 1976 5080 84z 157 240 300 246 555 34 ] 501 159851 14.2%

10 - 80 | 1207 455374 5260 13479 2469 538 664 944 Blz 1587 lze 27 G2l 482249 42. 7%

80 - 90 | 1903 349450 3027 TZ17 1346 283 363 419 430 887 13 13 371 365441 32.4%

90 - 100 | o84 59081 411 13 84 35 31 27 33 60 3 1 3 61422 5.4%

100 - 110 | 383 8337 31 62 3 3 . 1 1 3 2 . .l 8832 0.8%

110 - 120 | 150 1568 2 21 . 1 | 1742 0.2%

120 - 130 | 76 4239 - 4 . . . - . . . . | 509 0.0%

130 - 140 | 32 152 . 1 . 1 . - . . . . -1 186 0.0%

140 - 150 | L& 538 | ki 0.0%

150 - 160 | 4 2l | 25 0.0%

} 5083 1069107 11270 27975 4970 1074 1336 1678 1388 3235 246 55 1941127611
|

0. 5% . 8% 1.0% 2.5% 0.4% 0. 1% 0. 1% 0.1% 0 1% 0.3% 0.0% 0. 0% 0. 0%|
Class Totals

The Profile is wider than the displaved bm
Class Speed Matrix sample

Note that some vehicles may be in speed bins that are disabled in the report Profile. If thisis the case, a message will
be displayed at the bottom of the report, indicating the number of vehiclesthat are hidden. To view these vehicles,
enable all speed bins.
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Speed Separation Matrix

|
1466 133687 414960 270120 161140 87516 36066 14151 444§ 2006 1127560
0.1% 11.9% 36. 8% 23.9% 14.3% 1. 8% 3.4% 1. 3% 0.4% 0.2%|

Separation.To =
The Profile is wider than the displayed bins€ 547 wehicles are hidden.

Speed Separation Matrix sample

The Speed Separation Matrix report provides a speed-by-separation matrix of traffic data over the entire period of o
data, in a one page format. 7
=
Vehicles are grouped per the speed bins and separation bins defined in the report's Advanced Profile options. Speed §
bin totals and percentages are summarised down the right of the report, and separation bin totals and percentages S
along the bottom. 2
D
Speed (kmsh) Speed Totals ©
| 1 o
| Headway (Second) | =4
| 0.0 0.3 1.0 2.0 4.0 8.0 16.0 3z.0 64.0 128.0 | (2
| 0.5 1.0 2.0 4.0 8.0 16.0 32.0 64.0 128.0 1000.0]
10 - 20 | 1 1 1z 34 a g 4 . . 2l ks 0.0%
20 - 30 | 3 Z Z55 485 70 16 18 & . - 857 0.1%
30 - 40 | 1 36 853 652 100 55 23 & 3 o 1729 0.2%
40 - 50 | 1 622 4866 1851 227 75 31 10 4 3l 1690 0.71%
50 - 60 | 1z 5576 23518 6636 819 239 77 29 14 1] 36923 3.3%
60 - T0 | 1as 27524 87750 3133z 791 30z7 856 z73 17 351 159650 14.2%
m - 80 | 658 63558 190791 120782 BZE32 28748 10314 3270 934 G360 482247 42.7%
40 - 90 | 523 33280 26781 92800 71303 41894 18909 EA62 2094 879 3695434 32.4%
90 - 100 | 69 2854 2443 13763 14349 10845 6024 2657 949 4611 61414 5.4%
100 - 110 | 9 194 62l 1477 z119 1967 1342 11 253 132 8830 0.8%
110 - 120 | z 23 62 2z4 365 450 2387 lsz 79 571 1m41 0.2%
120 - 130 | B T 15 59 104 133 =) 56 26 131 509 0.0%
130 - 140 | 2 5 & & 33 38 a7 25 a 10] 186 0.0%
140 - 130 | . 3 4 3 11 15 23 4 5 3l M 0.0%
150 - 160 | 2 3 z 3 & 5 3 1 o 25 0.0%
|
|
|

Note that some vehicles may be hidden by speed bins that are disabled in the report Profile, or by separation that is
beyond the last defined separation bin. If thisis the case, a message will be displayed at the bottom of the report,
indicating the number of vehiclesthat are hidden. To view these vehicles, enable al speed bins, or expand the last
separation bin.

Remember that the definition of separation, as either headway or gap, can be modified in the report's Advanced
Profile options.
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Rolling Day Totals

The Rolling Day Totals report provides hourly vehicle volume and speed statistics, with 15-minute totals.

This report uses a unique, 24-hour rolling format. Each 24-hour group alignsto the start of the time filter in the
report Profile, not necessarily the start of a day.

The last four rows in each group are 12 (0700-1900), 16 (0600-2200), 18 (0600-0000) and 24-hour totals for the
preceding 24 hourly steps.
* Saturday, 27 April 2002 - Sunday, 28 April 2002

Time Drop Drop Drop Drop Total | Mean Vop
--00 --15 --30 --45 85

O
)
73
(2]
=)
a
&
=
o
=}
X
)
XS,
o}
=+
7

‘ 5:00 AM ’ a6 58 104 77 285 | 85.0 90.7
T 76 115 152 153 496 | 83.2 88.9
7:00 AM 118 168 162 196 645 | 83.2 88.9
G:00 AM 176 171 219 229 795 | 80.4 8&.0
9:00 AM 208 240 258 ZB6 973 | 79.6 85.3
10:00 AM 260 266 284 297 1107 | 8.4 84.2
11:00 AM 309 299 309 31z 1229 | 6.6 B83.2
1Z:00 PM 317 324 341 315 1297 | 76.7 B3.2
1:00 PM 306 316 324 315 1261 | 76.9 B83.5
Z:00 PM 285 287 303 303 1178 | 7.8 83.9
G:00 PM 275 284 27z 303 1134 | 78.4 85.0
4:00 PM 297 293 371 398 1358 | 77.1 B83.5
5:00 PM 427 357 33z 299 1415 | 78.0 84.2
&:00 PM 276 266 270 251 1063 | 80.1 86.0
7:00 PM 244 223 216 182 865 | 80.8 86.8
&:00 PM 178 170 150 151 649 | 81.7 87.5
9:00 PM 134 136 171 139 580 | 82.1 87.5
10:00 PM 157 168 160 166 651 | 81.3 86.4
11:00 PM 164 160 127 114 565 | 82.2 88.2
12:00 AM 142 115 110 11 455 | 82.0 87.1
1:00 AM 75 69 58 51 253 | 85.3 9.5
Z:00 AM 37 4z 29 34 14z | 86.0 94.7
G:00 AM 33 27 33 33 126 | 87.4 95.8
4:00 AM 23 31 37 34 125 | 86.1 94.3
07-19 3256 3271 3445 3484 13456 | 8.3 84.6
06-22 3883 3915 4134 4109 16046 | 73.85 85.3
06-00 4209 4243 4421 4389 17262 | 79.0 #85.3
00-00 4565 4585 4792 4706 18648 | 719.4 86.0

Rolling Day Totals sample

The Rolling Day Totals report is actually a shortcut to a Custom List Report. Selecting the Properties of this report
will display the standard Custom List options.

©2013 MetroCount® - - MTE User Manual 101




Individual Vehicles

The Individual Vehicles report displays speed, wheelbase, headway, class and a scaled wheel picture for every
vehicle. Each line of the report represents a single vehicle, with the time and date the vehicle was logged by the

Roadside Unit.
DS fixle Hum Ht YYYY-MM-DD hh:mm:ss Dr Speed Th Hiwry Gap Ax Gp Rho C1 Hm Vehicle
0l 0000Zb45 04 2002-04-27 07:07:17 B 75.8 2.8 1.0 0.9 2 2 1.00 2 000000zZ0 oo
0l 0000Zb49 04 2002-04-27 07:07:18 AB 76.8 3.0 1.3 1.1 2 2 1.00 2 000000z0 oo
0l 0000Zb4d 10 2002-04-27 07:07:19 AB 73.4 9.3 1.3 1.2 5 3 1.00 9 00000010 ARTS o oo L]
0l 0000ZbS7 12 2002-04-27 07:07:35 4B 79.6 14.1 15.3 14.9 & 3 1.00 10 000000L0 ARTE o oo ooo
0l 0000Zb&3 04 2002-04-27 07:08:05 AB 92.5 2.8 29.9 29.3 2 2 1.00 2 0000OOLO oo
0l 0000Zb&7 04 2002-04-27 07:08:10 AB 75.7 4.9 5.2 5.1 2 2 1.00 4 00000020 TEZ o o
0l 0000Zb&b 04 2002-04-27 07:08:13 B 79.7 2.4 3.4 3.2 2 2 1.00 2 000000zZ0 oo
0l 0000Zb&E 04 2002-04-27 07:08:17 B 78.8 2.2 3.7 3.6 2 2 1.00 2 00000010 oo
0l 0000Zb73 06 2002-04-27 07:08:27 B 72.2 6.5 10.2 10.1 3 3 1.00 3 00000020 ST oo o
Individual Vehicle report sample
Column Description
DS Tagged dataset index.
Axle Num Dataset axle index.
Ht Number of axle hitsin the vehicle.
Date and Time Date and time of thefirst axlein the vehicle.
Dr Direction of travel of the vehicle.
Speed of the vehicle. Units of measurement are determined by the report
Speed .
Profile.
Wb Wheelbase of the vehicle. Units of measurement are determined by the
report Profile.
Hd Headway - time since thefirst axle of the last vehicle travelling in the
same direction.
G Gap - time since the last axle of the last vehicle travelling in the same
P direction.
AX Number of axlesin the vehicle.
Gp Number of axle groupsin the vehicle.
Rho Sensor correlation factor.
cl Class of the vehicle.
Nm Not defined - technical purposes only.
Vehicle Class name and scaled wheel picture of the vehicle.

A graphical representation of the axle events for each individual vehicle may be obtained using the Axle Inspector.
Thisisatimeline of sensor hits that MCReport has partitioned into a vehicle, based on the selected classification
scheme. To display, simply double-click any row in the report.
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#  Inspector Gadget e |
DS 4mlc Nun Ht YUVY-MM-DD hhonn:ss Dr Speed Wb Hdwy  Gap Ax Gp Rho CL N
00 000002ec 12 1993-09-20 13:16:01 AB 84.4 13.9 28.6 28.5 6 3 1.00 10 ¢C
Anchor Delta Offset
[483ms, 11 B meler  [8me, 130 meler  [538ms, 12,63 meler g)—j
(2]
s 3 g BB OB @,
=
Q
B : =-
2 s 5 & | S
n Offset Delta Time o %
000002E7] 5 3403.483 0342 18330920 131631 o
[000002E5] -4 3105133 28832 13830920 1215:33 o
00000223 3 HO5240 28505 19330920 1315:33 =+
000002E4) 2 05295 28530 19930920 1215:33 @
[000002EE] 1 B2 083 19530920 121533
[A]100000zEC) O 3433825 oom 18830920 131601
|| [BJ1oooanzeD] 1 3133888 0osz 13830920 131601
| | (Al jooonozzE 2 33955 0140 13930920 131601
B (n0000zer] 3 334008 D183 19930920 1:16:02 1
(A (o0000zF0] 4 3028 0200 19530920 1216:02 s
(B j00000zF11 5 3434088 vz 19530920 1216.02 1
Al oa000zF2] 6 3134309 0483 13830920 1216:02 i
(B (no000zF3] 7 34351 052 13930920 1316:02
A (oo0n0zFa] 8 334354 053 19930920 1:16:02
Bl jvoon0zrs) 3 3407 ns8l 19530920 1216:02
A jo0000zFE 10 3434417 oesz 19830920 1216:02
[B{000002F7] 11 3434481 083 13830920 1215:02
[000002F8] 12 HIETE 1935 19930920 116:03
[000002F3] 13 HIBAS 1580 19930920 1316:03
[000002F2] 14 a8 2088 19530920 121603
0000027E] 15 43I 210z 19530920 1215.03 i
4 | - A‘A-‘f;\'. S ‘ e L3

Examining individual vehicles using the Axle Inspector

The two sensor hit streamsin a dataset are represented by the black lines, marked A and B. A circle indicates axle
hits on each sensor and are labelled with the time in milliseconds since the first hit. A lineis drawn from each hit at
an angle determined by the speed of the vehicle. Since the speed of each vehicle is determined by thefirst A and B
hits, then thefirst A and B hit lines will always overlap.

Subsequent hit lines are drawn at the same angle, and under perfect operating conditions the corresponding A and B
pairs will overlap. Any gap between these pairs of hitsindicates alateral movement in the sensors, or achangein

vehicle velocity.
The black triangles on the X line represent "axles' used by M CReport, after processing and filtering, to classify the
vehicle

The time and distance between sensor hits can be measured using the inspector's time markers. Moving the mouse
over the timeline moves the Offset marker. Clicking will move the Anchor marker to the current location. The Delta
field at the top is the difference between the anchor and offset markers.
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Queued Vehicles

The Queued Vehicles report is a variation of the Individual Vehicles report. Vehicles are grouped based on the
Separation vehicle filter setting in the report Profile. For example, with a Separation filter set to less than four
seconds, all vehicles travelling less than four seconds apart will be listed, followed by ablank line. Thisis useful for
examining queues of vehicles.

DS Axle Hum Ht YYYY-MM-DD hh:mm:ss Dr Speed
04 2005-03-29 10:59:

oo
0o
0o

o0
oo
oo
oo
oo
oo
oo

oo
0o

000004ce
00000442
00000446

000004ec
000004£8
o00004fe
aooonso0
o00ons04
a00o00s08
000o00s0c

oooons51a
0ooo0szo

04 2005-03-29 10:53

04 2005-03-29 10:59:

12 2005-03-29 10:59:
04 2005-03-29 10:59:
04 2005-03-29 10:59:

04 2005-03-29 10:59

04 2005-03-29 10:59:
04 2005-03-29 11:00:
04 2005-03-29 11:00:

06 2005-03-29 11:00:
04 2005-03-29 1l:00:

W Hdwy  Gap Ax Gp Rho
19 AB 69.2 2.4 10.5 10.4 2 2 1.00
12z 4B 63.6 4.2 3.1 3.0 2z zl.00
24 B 61.5 2.6 1.6 1.4 2 zl.00
52 AB 56.1 14.8 9.0 7.9 6 3 1.00
53 AR 55.2 Z2.2 1.6 0.6 & 2 1.00
55 AR AL.T 3.0 1.6 1.4 & 2 1.00
156 AR RO.0 Z.8 1.4 1.2 & 2 1.00
59 AR  59.2Z 4.9 Z.4 2.3 & 2 1.00
o0 AB &L.O Z.8 1.5 1.2 & 2 1.00
04 AB  A3.5 4.8 3.5 3.3 & 2 1.00
53 AB 65.3 11.9 23.5 23.4 3 3 1.00
2.5

56 AB B2.5

Queued Vehicles Sample

€1 Hm

2 00000020
4 00000020
2 00000010

10 00020042
2 00000020
2 00000020
2 00000020
4 00000020
2 00000020
4 00000010

T 00000020
2 00000010

Vehicle
S¥oo
TEZ o [}
ELC]

ARTG 0 o0
5V oo
5V oo
5V oo

TEZ o a
5V oo
TEZ o a

oo

ART3 o o o
§¥ o g
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Speed Statistics

Overview

The Speed Statistics report provides a table of speed bin distribution with multipliers, in asingle page format for the
entire tagged data.

Thefirst block is MCReport's standard speed statistics block, which shows all speed limits and percentiles per the
Speed page of the report's Advanced Profile options.
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Vehicles = 1127611

Posted speed limit = 50 kmh, Exceeding = 438231 (38.66%), Mean Exceeding = 59.52 kmh
Limit 1 (PSL + 5) (80 * 100%) + 5 = 85 km/h, Exceeding = 191266 (16 95%)

Limit 2 (PSL + 10%) (30 * 110%) + 0 = 88 kmh, Excesding = 107025 (9.49%)

Maximum = 159.6 kmh, Minimum = 10.2 kmvh, Mean = 77.3 kmh

85% Speed =55 3 km/h, 95% Speed = 81 1 kmh, Median = 77 8 kmh

20 km/h Pace = 53 - 556, Humber in Pace = §60375 (77 .06%)

Variance = 5007, Standard Deviation = 9.43 kmh

Speed Statistics Block Sample

The Speed Bins table provides bin totals, plus cumulative totals above and below the upper limit of each bin
(highlighted in bold).

Speed Bins

Speed 1 Bin 1 Below 1 Above 1 _Energy 1 wMult | n * vMult

o- 10 | o 0.0% | o 0.0% | 11276ll 100.0% | .00 | .00 | 0.oo0
10 - 20 | 74 0.0% | 74 0.0% | 1127537 100.0% | o.89 | o.o0 | o.00
Z0 - 30 | 858 0.1% | azz 0.1% | 1128673 35.3% | 3.62 | o.o0 | 0.o00
30 - 40 | 1723 0.2% | Z661 O.Z% | 1124350 93.8% | Z5.14 | o.o0 | o.00
40 - 50 | TE20 0.7% | pRukc-3 0.%% | 1117260 323.1% | 334,038 | 0.00 | 0.00
50 - &0 | jel-elad) 3.3% | 47zg0 4.2% | 1020331 95.82% | Z445.95 | .00 | 0.oo0
€0 - 70 | 153851 14 2% | Z07131 18.4% | 9z0480 81.6% | 1501Z_14 | o.o0 | o.00
70 - B0 | 4BZzZ43 4Z.8% | 623380 &1.1% | 438231 38.3% | £4137.10 | o.o0 | 0.o00
80 - 90 | 365441 3Z.4% | 1054821 33.5% | 72790 6.5% | 36517.89 | 1.00 | 36544100
20 - 100 | &£l42Z £.4% | lllez43 99.0% | llzeg 1.0% | FEET.EE | Z.00 | lZZg44.00
100 - 110 | 8832 0.2% | LLZ5075 99.8% | 2536 0.2% | 387.99 | 4.00 | 3L52zg.00
110 - 120 | 1747 0.2Z% | 11Ze217 93.3% | 794 0.1% | 24._03 | g.00 | 13936_00
1lz0 - 130 | s03 0.0% | LLlE73Ze 100.0% | z85 0.0% | 19,10 | lg.00 | Sl44.00
130 - 140 | 186 0.0% | 1127512 100.0% | 23 0.0% | zo.z4 | 3z_00 | E35z_00
140 - 150 | 74 0.0% | 1127586 100.0% | 25 0.0% | 0.00 | €4.00 | 4726.00
150 - 160 | Z5 0.0% | ll27cll 100.0% | o 0.0% | .00 | lzg. o0 | 3z00.00
10 - 170 | u] 0.0% | 1127611 100.0% | a 0.0% | o.o0 | o.o0 | o.00
170 - 180 | o 0.0% | llz7&ll 100.0% | o 0.0% | o.o0 | o.o0 | 0.o00
180 - 19%0 | u] 0.0% | 1127611 100.0% | a 0.0% | o.o0 | o.o0 | o.00
130 - 200 | o 0.0% | 1127ell 100.0% | a 0.0% | 0.00 | 0.00 | 0.00

Total Speed Rating = 558581 .00
Total Moving Energy (Estimated) = 11271673

Speed Statistics Speed Bins Sample

The Energy calculations use the standard formula: e=2mv2 where m is the estimated vehicle gross mass from the
Advanced Profile masstable. The value is always reported in MegaJoules.

The vMult column is each speed bin's multiplier, with n * vMult the product of each speed bin'stotal volume and
multiplier. The total gives the Speed Rating for the entire data.

Thefinal block in this report summarises the cumulative totals for each of the speed limits specified in the Advanced

Speed limit fields
1 Limit 1 Below 1 Rbove
0 | 80 (PSL) | 685380 61 1% | 438231 38.9%
1| 85 (PSL + &) | 936345 23.0% | 181266 17.0%
2 | 88 [PSL + 10} | 10zoSss 90.5% | 107025  9.5%

Speed Statistics Limits block sample
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By Hour

The hourly variant of the Speed Statistics report provides all speed statistics grouped by hour of day, in asingle page @)
format for the entire tagged data. Additional column ded for total vehicl eedin h of the speed %
ol or the entire tagg a onal columns are appen or to clesexc g each of the sp 7
limits defined in the Advanced Profil i 2
imits defined in the Advanc ofile options. =
o
N Q
Hour Bins (Partial days) —
o
Time | Bin I Min | Max | Mean | Medianm | 85% | 5% | *PSL 1 Limit 1 1 Limit 2 1 >

1 1 1 1 1 1 1 1 80 Jm/h 1 85 J/h 1 8 kfh 1
1 1 1 1 1 1 1 1 1 PSL + % 1 PSL + 10% 1 ;U
0000 | 11601 1.0% | 1.3 | 188.3 | 81.7 | 8l.0 I BI.E | 7.6 | BE70  E7.EB% | 3E4Z  30.5% | ZZEE  19.E5% | CD
0100 | 7286 0.8% | s0.5 | 183.5 | g4.0 | BZ. 4 I 91.4 | 101.2 | 4733 65.0% | EZ673  36.8% | 1814 24.8% | -O
0zon | 4827 0.4% | 147z | 169.2 | 83.7 | Bz.8 I z.5 | 101.5 | 3163 65.6% | 1837 39.3% | 1299 Z26.9% | o

0300 | 4731 0.4% | 0.0 189.6 | 84.8 | 82.2 | 22.6 | l0z2.2 | FEZZE e8.1% | 1371 41.7% | 1383 Z9.2% |
0400 | BEld 0.e8% | 5.5 | 189.5 | 85.0 | 22.5 I 93.2 | 1o0.8 | 4c7e  70.7% | 2824 432.6% | 199z 20.1% | m

0500 | 17887 1.8% | E.9 | 143.7 | 24.9 | Bz.9 I 2Z.8 | 9.0 | 1lz81s 72.9% | 77EE 44 1% | EZOE Z9.6% |

0500 | 46035 4.1% | 2.8 | l42.Z | 81.9 | Bl.4 I BE.8 | 4.3 | 27224 £53.1% | 13804 30.0% | 8lle 17.8% |

0700 | 78743 7.0% | 0.0 | 133.9 | 5.7 1 6.3 I 83.9 | 88.6 | 25545 3Z.4% | 9743 1Z_4% | 4826 6.1% |

0800 | BEER7T 7.6% | 3.1 1822 | 7z.7 | TM4.2 | BZ.4 | 87.5 | 20843 E24.3% | 7793 0% | 3948 4.6% |

0900 | BE6800 £.9% | 2.4 | l45.6 | 7.1 77.4 I 24.6 | S20.0 24130 3J6.1% | 9902 1l4.8% | 5zZe5 7.9% |

1000 | E41EE 8. 7% | 3.7 1 1427 | 7.2 1 77.4 I BE.O | 0.0 | Z3ZBE  36.3% | SE33  15.0% | 5174 8.1% |

1100 | BE37E £.9% | E.3 1 138.2 | 7.001 77.0 I 8.8 | g8.6 | 23861 35.5% | 8399 14.z% | 4918 7.4% |

1200 | 70013 6.2% | Z.4 | 150.5 | 6.6 | 6.7 I Ba.Z | 89.6 | 23682 33.8% | 9534 13 7% | 5086 7.3% |

1300 | &73e0 6.0% | 0.0 145.3 | 77.0 1 77.0 | @4.6 | 20.0 | 2387z 3E.6% | 2660 14.3% | £147 T.6% |

1400 | B9LlE7 6.1% | 0.0 | l44.9 | 7.2 1 77.4 I 24.6 | S20.0 24924 3J6.0% | 10049 14.5% | 5421 7.8% |

1500 | 79571 7.1% | 0.0 | 183.0 | 7E.9 | 763 I Bd.Z | 89,3 | ZEETO0 3Z.1% | 10z 1zZ_9% | 5473 E.9% |

1500 | 9zoz? 8.2% | 0.0 172.8 | 5.0 1 5.8 I BE.5 | 88.6 | 27730 30.2% | logses  11l.6% | 5358 £.8% |

1700 | 92431 8.2% | 0.0 | 140.7 | 3.8 | 5.6 I 83.5 | 88.2 | 27793 30.1% | 10540 11_4% | 5261 5.7% |

1800 | &z081 E.8% | 0.0 1el.4 | 73.1 1 73.2 | 28.4 | 21l.4 | 28462 4E5.8% | 12128 12.6% | 6608 10.6% |

1900 | 3LBE3L 3.4% | 3.7 | 1s0.0 | 81.1 | en.g I e7.8 | 94.0 | 20947 54.2% | 9972 ZL.g2% | L£7gg  15.0% |

2000 | 283388 Z.B% | E.7 1 174.8 | 8Z.1 | Bl.4 I BE.S | 5.2 | 16308 58.5% | 83EE  ZB.9% | EO2E 17.6% |

z100 | ZEELE Z.4% | 3.8 | 183.3 | 81.8 | Bl.0 I BE.8 | 4.7 | 15311 £57.5% | 7447 ZB.0% | 4421 1l6.6% |

zz200 | 2ZBZ3 Z.0% | 4.1 | 171.4 | 81.7 | 8l.0 I BE.6 | S5.0 | 12841 56.3% | BZ15 EZ7.Z% | 3808 16.7% |

2300 | 17470 1.8% | 0.0 | lgs.0 | 80.8 | &L.0 | @8%.6 | Se&.8 | 1008l E7.8% | £314  30.4% | 3373 19.3% |

—---- 1 1128127 100.0% | 0.0 | 185.0 | 7.2 1 7.8 1 85.3 | 91.1 | 439244 38.8% | 191279 17.0% | 107038 9.5% |

Speed Statistics by Hour sample
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Separation Statistics

@)
- Q
Overview @
(2]
=
The Separation Statistics report provides a table of separation bin distribution with multipliers, in asingle page 2l
format for the entire tagged data. Remember that separation can be defined as headway or gap in the Advanced 2
Profile options. -
D
Separation Bins -8
i =i
5 1 Bin 1 Belowr 1 Above 1 sMult | n T sMult U)

o.00 - .50 | 128752 11.8% | 123782 11.8% | 363884 38_2% | 2.00 | 102201&6.00

0.50 - 1.00 | <¢03430 3&.7% | E33Z4Z  4B8.5% | 565334 51.5% | 4.00 | lel33s0.00

l.00 - 200 | 26327z Z4.0% | 796514 T7Z2.5% | 30212z Z7.5% | Z_oo | 526544 00

Z.00 - 4.00 | 157403 14.3% | SE3FL7 86.8% | 144713 13.2% | l1.00 | 157403.00

4.00 - g.00 | 8EGE7 7.8% | 1039574 94.6% | Lo0ez 5.4% | o.0o | 0.oo0

g.00 - 16_00 | 37z70 Z.4% | 1076844 93.0% | Z178z Z.0% | o.oo | o.00

le.00 - 3z.00 | 13771 1.3% | 10906lE 33.3% | B0Z1 0.7% | 0.00 | 0.oo0

3z.00 - 64_00 | 4z30 0O.4% | 1094305 93_.7% | 3731 0.3% | o.oo | o.00

64.00 - 128.00 | 1944 0.2% | 10968458 33.8% | 1737 0.2% | Q.00 | 0.00

1lz8.00 - 1000.00 | o 0.0% | 1096843 93.2% | 1787 0.2% | o.0o | 0.oo0

Total Separation Rating = 3335923.00

Separation Statistics Sample

The Separation Bins table provides bin totals, plus cumulative totals above and below the upper limit of each bin
(highlighted in bold). The sMult column is each separation bin's multiplier, with n * sMult the product of each
separation bin's total volume and multiplier. The total gives the Separation Rating for the entire data.

By Hour

The hourly variant of the Separation Statistics report provides separation bin distribution grouped by hour of day.

Hour Bins
Time | Bin 1 Mean 1 Sep Sep Sep Sep Sep Sep Sep Sep Sep Sep
| | ] 0.0 0.5 1.0 Z.0 4.0 &.0 16.0 2z.0 E4.0 lzz.0
] ] ] 0.5 1.0 Z.0 4.0 8.0 16.0 32.0 £2.0 1E2.0 1000.0
0000 | 11zo06 | Zl.0 | 3 22z 1135 1735 2068 2239 1371 1130 444 137
0100 | 7018 | 31.5 1| Ll 26 £zg gzz 100g 1371 1402 lozz 477 238
0200 | 4657 | 48.2 | 1 Z6 2z3 356 493 204 288 91 L0z 243
0300 | 4806 | 3.6 | o 11 178 279 467 738 [EZ 367 Ez3 277
0400 | 8133 | 4z.3 | 1 47 292 544 778 1157 1385 1108 L4 240
0500 | 16Z6Z | 16.1 | 10 583 2199 2899 33339 3308 2340 1083 343 145
0600 | 42820 | 12,8 | 72 4809 12098 2381 723l 4586 131e £33 178 37
o000 | 22z | lz.5 | EL 11304 3zz292 15957 7509 3340 lzi0 286 ELY ZZ
0300 | 79364 | 1z.0 | 1oz 11660 36630 18ZEE 7IEE 3ZEE 1033 306 ek 15
0300 | BZ3E7 | 7.2 1 B3 £833 Z301e lez7e 9854 45683 1354 253 lz 1)
1000 | BO61E | 6.6 | 79 6187 21476 16345 10014 4894 1453 132 a8 3
1100 | E5306 | 6.2 | 93 7320 24217 17284 l0zs7 4713 1239 151 ke £
1200 | 0012 | 6.5 | o1 2486 27238 18227 lozsz 4450 1121 111 o 1
1300 | B7260 | 6.3 | 9z 7971 ZEE1OD 17664 10132 4837 1234 121 & 3
1400 | BILET | 0.5 | 104 8736 ZB558 17828 o181 4428 1156 pR-T 3 1)
1500 | 79571 | 8.6 | 133 11833 33338 15533 3780 3819 242 10l z 1)
1600 | gz0z7? | 7.E | pi-13 158582 42098 21308 237¢ 3lez 631 21 4 £
100 | 9z431 | £.0 150 14607 4z984 22235 BEeLD 3010 643 28 a le
1300 | BZ0O81 | 6.3 | =13 7084 23016 15323 SE0E 4E87 1518 Z4z =3 1
1300 | 3BE3L | g.01 36 2630 10z2z7 8483 7835 5300 2333 £4a3 ) z
2000 | 28888 | 2.9 24 1307 5853 6532 6431 4978 ZE36 217 133 4
2100 | ZEE1E | 1l.8 | 1e 1138 E03z2 £272 £343 4E30 ZEET 1007 lgz 7
2200 | 2z799 | 11.9 | & 59 2911 4803 Lo4g 4321 259z lozz zag z8
2300 | 16201 | 16.4 | 3 407 2308 3038 3485 3394 281z 1138 418 k=11
---- 1 1098636 | 1 1451 123752 403490 263272 157403 85657 37270 13771 4290 1944

Separation Statistics by Hour Sample
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Adjusted Vehicle Flow

. . . 9
The Adjusted Vehicle Flow report analyses ADT and AADT for asite. )
()]
Thefirst part of the report lists daily total volume, along with an adjusted volume, using adjustment factors entered :
into the report's Profile. 8
o)
o
Day Hits Raw¥ol DayFac MonFac Ad3j¥ol - Date 5
a 4 55553 1.000 1.000 55553.000 - Monday, 1 January 2007 m
1 4 76052 1.000 1.000 76052.000 - Tuesday, 2 January 2007 )
z 4 80462 1.000 1.000 ©S0462.000 - Wednesday, 3 January 2007 o
3 4 84360 1.000 1.000 ©£4360.000 - Thursday, 4 January z007 o
4 4 §5196 1.000 1.000 ©5195.000 - Friday, 5 January 2007 :_
5 4 61475 1.000 1.000 61475.000 - Saturday, 6 January 2007 7
6 4 53277 1.000 1.000 53277.000 - Sunday, 7 January 2007
359 4 45084 1.000 1.000 45084.000 Wednesday, 26 December 2007
360 4 65799 1.000 1.000 €5799.000 Thursday, 27 December 2007
361 4 69659 1.000 1.000 €9659.000 Friday, 28 December 2007
362 4 571594 1.000 1.000 57594.000 Saturday, 29 December 2007
363 4 51905 1.000 1.000 51%05.000 - Sunday, 30 December 2007
364 4 63801 1.000 1.000 6£8801.000 Monday, 31 December 2007

Daily volume and adjusted volume

General | Format I Header | Colars | Scheme I Speed | Mass I Sepalation‘ Adjust
Month 1.000000  Manth factar

.,; January
.,,7 Februan
B March 1000000 Monday
B Al

i 1.000000  Tugsday
B June 1.000000  ‘wednesday

.,,7 July
B August 1.000000  Thursday
' September
', Dctober

B Noyermber 1.000000 5 atuday
B December

Daily factor

1.000000  Friday

1.000000  Sunday

Entering adjustment factors

The second part of the report lists the calculated ADT/AADT, split into weekdays and weekends, and a list of
adjustment factors calculated from the available data.

Total days = 364, Coverage = 99.73%
ADT = 84717.712, D = 16507.040
RADT = §4717.712, §D = 16507.040

Weekdays = 260, Coverage = 71.23%
AUDT = 23298.912, 5D = 9766.783
AAUDT = 93298.912, 5D = 9766.783

Weekend days = 104, Coverage = 28.49%
AWET = 63264.712, 3D = B353.135
AAWET = 63264.712, 3D = &358.135

ADT and adjustment factor by month

Jan - Vol = 2510431, Days = 31, ADT = G0981.645, Adjust = 1.04613, l/Adjust = 0.95590
Feb - ¥ol = 2497098, Days = 28, ADT = B89182.071, Adjust = 0.94994, 1/hdjust = 1.05270
Mar - ¥ol = 2725072, Days = 31, ADT = B§7905.543, Adjust = 0.96374, l/Adjust = 1.03763
Apr - vol - 2431368, Days = 30, ADT = B81045.600, Adjust = 1.04531, l/Adjust = 0.95665
May - ¥ol = 2606075, Days = 31, ADT = B§4066.935, Adjust = 1.00774, 1/Adjust = 0.99232
Jun - Vol = 2512904, Days = 30, ADT = 03763.467, Adjust = 1.01139, l/Adjust = 0.98874
Jul - ¥ol = 2493906, Days = 350, ADT = B83130.200, Adjust = 1.01910, l/hdjust = 0.96126
Aug - Vol = 2675253, Days = 31, ADT = B6295.484, Adjust = 0.95168, l/Adjust = 1.01866
Sep - Vol = 2533981, Days = 30, ADT = 04466.033, Adjust = 1.00298, l/hdjust = 0.99703
Oct - ¥ol = 2665100, Days = 31, ADT = B§5970.963, Adjust = 0.98542, 1/Adjust = 1.01479
Hov - ¥ol = 2661718, Days = 30, ADT = 0§9330.600, Adjust = 0.94773, l/Adjust = 1.05516
Dec - Vol = 2504341, Days = 31, ADT = B80785.194, Adjust = 1.04868, l/hdjust = 0.95358
ADT and adjustment factor by day of week

Mom - Vol = 4620210, Days = 53, 4DT = 87173.774, Adjust = 0.97183, l/hdjust = 1.02899
Tue - ¥ol = 4345416, Days = 52, ADT = 03181.077, Adjust = 0.90917, 1/Adjust = 1.09990
Wed - ¥ol = 4313070, Days = 52, ADT = 04482.115, Adjust = 0.69665, l/Adjust = 1.11526
Thu - ¥ol = 4990648, Days = 52, ADT = 95974.000, Adjust = 0.88272, l/hdjust = 1.13287
Fri - ¥ol = 4388373, Days = 51, ADT = 05850.451, Adjust = 0.88385, l/Adjust = 1.13141
sat - Vol = 3635712, Days = 52, ADT = 69917.538, Adjust = 1.21168, l/hdjust = 0.82530
Sun - Vol = 2943518, Days = 52, ADT = 56611.885, Adjust = 1.49647, 1/Adjust = 0.66624

Adjusted Vehicle Flow totals and adjustment factors
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Data Scan

The Data Scan report validates a single datafile, based on a set of adjustable rules and boundaries. Thisreport is o
primarily intended as an automated data check for Scripting. o
=
8
& MCReport - [DataScan-64] [EETRE =
File Edit Wiew Graph Tools Window  Help [-=]x] S
— m l
Jn@@\m@@\’@@ﬁﬂ%g Validate ‘ =% P
‘ DataScan-64 | - @
_ ©
— Validation parameters i
Validation Parameters o
EE— & Time step in minutes =1
Fail ifno data (State = TRUE) %Max\mum number of consecutive empty steps w
Fail if bad direction cade (State = TRUE) % Faled steps required to signal
Fail if bad sensor layout (State = TRUE) B Maximum percent rejected hits
Maximum percent sensor mismatch (Limit= 2%;) .,; Minimum percent passenger automobiles
Maximum number of failures displayed (300) r‘-'l.a-m'lum percent uni fiable

Mumber in time step to permit validation (10) ﬁﬂ(c
Time step in minutes (B0) @
Maximum number of consecutive empty steps (6)

Failed steps required to signal {4)

Maximum percent rejected hits (Limit= 15%)

Minimum percent passenger automohiles (Limit= 30%) " ¢ unclassifistl
Maximum percent unclassifiable (Limit= 7%) i percent Unclassifiabls

Class maximurn percent (2, Limit=100%) |

Class maximurn percent (8, Limit= 20%)
Class maximurn percent (10, Limit= 20%)
Percentvehicles less than threshold speed (10 kmih, Limit= 7%)
Percentvehicles more than threshold speed (120 kmih, Limit= 10%)
Percentvehicles with correlation less than threshold {0.85, Limit= 20%)
Percentvehicles with separation less than threshold (0.6, Limit= 20%)

lass maximum percent

Data Scan validation parameters
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Spectrum of Axle Hits
The Spectrum of Axle Hitsreport, or Hit Spectrum, is ahistogram of the time difference between successive sensor
hits. This chart is one of the most useful tools for instantly verifying data quality.

MCReport scans a dataset, and keeps atally of the time between successive sensor hits, grouping them by the order
of hits: Ato A, Bto B, Ato B or B to A. The Hit Spectrum showsthe A to A and B to B plots by default - the time
between hits on the same sensor provides the most useful information.

The time between sensor hits can vary over a huge range, so the horizontal axisislogarithmic. This allows arange
from one millisecond to ten million seconds.

A typical Hit Spectrum is characterised by the following:
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1.  With good quality classification data, the A to A and B to B plots should perfectly overlay each other. Only
the top-most plot may be visible.

2. Peaksinthe left-most region, from around 10 to 30 milliseconds, depict spurious hits caused by sensor noise.

3. A sharp peak somewhere around 100ms represents the product of speed and wheelbase of the most frequently
recorded vehicles (usually cars).

4. Additional smaller peaksin this region are due to bi-axle and tri-axle groups, or trailers.

5. A trough approaching the x-axis indicates low congestion.

6. Theremainder of the Hit Spectrum, usually above 400ms, is characterised by a broad hump that represents
the distribution of inter-vehicle times.

Typical Hit Spectrum
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Correlation of Axle Hits

The Correlation of Axle Hitsreport is atime-based plot of uncorrelated axle hits per integration period. A correlated
axleis one where there isamatching A and B sensor hit for any given axle, within a small margin of error. Perfect
data quality would have no uncorrelated axles, however a small number is common due to sensor noise,
simultaneous vehicle crossings on bidirectional sites, and vehicles changing lanes.
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Correlation of Axle Hits Sample
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Audit of Data Quality

The Audit of Data Quality report is atime-based plot comparing the number of axles recorded on both the A and B
sensors, and displays a graph of the difference between them. Note that thisis a comparison of hit counts after
MCReport has processed the raw data, so is ameasure of the quality of data used to classify vehicles. This may differ
from the Hits plot in the File Tree, which is raw data.

This report immediately highlights single sensor failures where the trace deviates significantly from the zero
horizontal axis. The Header Sheet also contains additional axle and vehicle statistics.
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Audit of Data Quality sample - one sensor fails mid-survey
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Axle Position Histogram

The Axle Position Histogram is a histogram of inter-axle spacings within vehicles. This report will usually have a
characteristic shape corresponding to common axle spacings, making it an extremely useful tool for verifying data
quality.

The Axle Position Histogram can be characterised by:

1. A group of spikes representing the most common passenger vehicles, and light trucks.

2. Spikes corresponding to the double and triple axle groups of heavy vehicles (for datasets containing a
noticeable percentage of these vehicles).

3. Smaller spikes corresponding to the longer inter-axle spans in heavy vehicles, such as buses.
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Axle Position I-ﬁsttiqram Sample
The Axle Position Histogram can be used to check for:
» matching sensor length, and
* correct sensor spacing.

Characteristic spikes in the histogram can be checked against known good data from the same area. If these spikes
deviate in position by a significant amount, one of these problems may exist, and speed and classification should be
considered suspect for this dataset.

For example, it is possible to target the double axle group on the back of an articulated truck, which is usually one of
afew standard distances apart. Selecting Properties from the report's right-click menu will display the axle spacings

filter.
ﬁ '
I_ ) O

=] =1

5Pl SP2 5P3 5P4
Inter-axle spacings

3
Axle spacings ﬁ
Inter-axle spacing
E15P1
[EIsp2
[sP3
Clise D
IE1sP s
OsPs [
Oser
[Cspa Checkal | ||
[EIsPa il
FlsP10 Uncheck all
g M awirnum ¥ scale [meter]]
—

Selecting SP4 in this case will display only the spacings between axles four and five. Note also the X-axis scale can
be modified to increase resolution.

Filtering should create a few clearly defined spikes that can be verified using the cross-hairs. Again, deviation from
known values may indicate a sensor installation problem.
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Filtered Axle Position Histogram

For bidirectional datawith a suspected problem, it is possible to distinguish between different sensor length and
incorrect spacing. Different sensor length will result in spacings that are too short in one direction, and too long in
the other. If filtering for one direction using the report Profile's direction filter moves the Axle Position Histogram
left or right, thisindicates different sensor length. If the report is unmoved, then incorrect spacing isthe likely cause.
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Vehicle Flow

The Vehicle Flow report is atime-based plot of total vehicle volume.

Note that the Vehicle Flow report is a measure of vehicles per time period. The time period, or integration timeis
displayed next to the vertical axis. For example, with an integration time of one hour, each point on the graph

represents total vehicles per hour.
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Vehicle Flow Sample
The Vehicle Flow report has a variable display span and integration time using the report's Graph Toolbar.
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Velocity Dispersion

The Velocity Dispersion report is atime-based plot showing relative speed densities. This report highlights the
relationship between speed and traffic density at a site. Periods of congestion are especially obvious.
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Velocity Dispersion Sample
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Speed

The Speed report is atime-based plot of average vehicle speed per selected integration period. By default, the report
also shows a plot of maximum vehicle speed, and a horizontal marker for the posted speed limit (PSL).

Speed Report sample, with mean, 85th percentile and maximum speed.
Right-clicking on the report and selecting Properties displays the report's options.

Speed MinMax tools ===

7] Show Min trace
Showe Max trace
Show posted speed limit
[] Show Extra Speed Limits
Show Percentile

Annotation at marker

Time of collision -

Speed report options

Show Min trace displays a plot of minimum speed per integration period. Show Percentile displays aplot for the first
percentile, and Show Extra Speed Limits displays horizontal markersfor each of the speed limits, per the settingsin
the Speed page of the report's Advanced Profile options.

The Annotation at marker is a piece of text that appears next to the time of the marker, which can be placed with the
cross-hairs. The drop-down list is also user-editable.

The Speed report also has two special Display Span options for a Virtual Day or Virtual Week.
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Stacked Flow

The Stacked Flow reports are similar to the Flow report, but with either vehicle class or speed bin differentiation.

Total flow per integration period is represented by a stack of bars for each included class or speed bin. Fewer classes
or speed bins may be required to give sufficient detail. Aggregating a class scheme (usually light, medium and heavy
vehicles) often gives extremely useful results.
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Flow Stacked by Class sample, using an aggregated class scheme
Another example is two speed bins, one either side of the PSL, highlighting total vehicles exceeding the PSL.

towt

[ =

Flow Stacked by Speed sample showing vehicles above and below the PSL
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Clustered Flow

The Clustered Flow reports are a variation of the Stacked Flow reports. Rather than stacking the classes or speed
bins, each is plotted side-by-side.
These reports require a large integration time or asmall display span to give sufficient resolution.

e
I:

¥

Flow Clustered by Class sample, with aggregated class scheme

B
| 55

Flow Clustered by Speed Bins sample, showing vehicles exceeding the PSL
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Separation

The Separation report is atime-based plot of average vehicle separation per integration period.
Remember that separation can be optionally defined as headway or gap in the report's Advanced Profile options.
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Separation report sample
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Dispersion Plots

MCReport has four dispersion or scatter plots:

 Speed vs Separation

¢ Volume vs Speed

e Density vs Volume

¢ Volume vs Density
Every vehicle is represented by a single point on the graph. Point density isindicated by the density colour glide
specified in the report Profile.

These plots portray differing characteristics of traffic flow, which are normally based on theoretical valuesin traffic
engineering text books. They can be very useful when analysing data on roads that are at or near capacity, or for
before and after studies of road works such as traffic calming.

The Granularity option in the Format page of the Advanced Profile options adjusts the resolution of these reports. A
higher granularity gives finer resolution, but require more vehiclesto build any significant density.
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Speed vs Separation Dispersion Plot sample

The horizontal axis of the Speed vs Separation can be modified to give more resolution. Simply right-click, and
select Properties.
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Bin charts

MCReport has two bin charts - the Class bin report, and the Speed bin report. These reports provide a graphical
representation of the proportions of class and speed bins respectively. The Header Sheet also contains a table of

class/speed bin totals and percentages.
Bin charts have four renderings, each providing a unique data representation. The most common renderings are bar
or column charts, and pie charts.

The pie chart rendering is athree-dimensional, dynamic chart. The chart can be rotated to the angle that best
represents the data by clicking and dragging the black circle in the centre. Individual pie slices can be highlighted by
clicking the coloured circle next to the class or speed bin label.
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Class Bin report sample, with pie rendering

Speed Bin report sample, with bar rendering
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Speed Histogram

The Speed Histogram report provides the speed profile at asite. A normal curve, with the same mean and standard
deviation, is plotted to help gauge the skew of the speed distribution.

Optional vertical markers also show the speed percentile, speed pace and posted speed limit - all as specified in the
report's Profile.

Speed Histogram sample

Right-clicking on the report and selecting Properties displays the report's options, most of which are
self-explanatory.

Speed histogram tools @

Show best-fit nomal distribution
[] Show as agive [cumulative]
Show speed limit

Percentile

Face

[] Set %-max to profile speed max

) |

Speed Histogram Options

The Set X-max to profile speed max option changes the maximum value of the speed axis to be the upper limit of the
Profile's speed filter.

The Show as ogive option displays a cumulative total of vehicles.

T

PR,

Speed Histogram sample in cumulative mode
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Wheelbase Histogram

The Wheel base Histogram report presents a graphical distribution of vehicle wheelbases, highlighting common
vehicle lengths.

The Axle Position Histogram report aso shows intra-vehicle axle spacings.
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Wheelbase Histogram Sample
The X-axis scale can be changed, by right-clicking the report and selecting Properties.

©2013 MetroCount® - - MTE User Manual 124




Separation Histogram

The Separation Histogram report provides a graphical distribution of the separation (in time) between vehicles.
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Separation Histogram Sample

The X-axis scale can be changed, by right-clicking the report and selecting Properties. This allows for examination
of the behaviour of close-following vehicles.

The Speed vs Separation dispersion plot also examines this behaviour, but takes into account vehicle speed.
The definition of separation as either headway or gap can be set in the report's Advanced Profile options.
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Special Reports

Most of the reportsin the Special group of reports are highly application-specific, emulating other "standard" report
formats.
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Generating a Custom List Report
Report Wizard

The Custom List report is a Classification report, under Tables in the Report Vortex. The Custom List report's
properties are displayed as an additional step to the Report Wizard, just before the report is generated.

A Custom List report's properties can be accessed at any time viathe report's right-click menu, just like the report's
Local Profile. Custom Lists can also be easily saved for future use.
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Fils Management List

T\\\
Vy

Vehicle and report settings
Vst e et s e b

(=5 b ] [Cian

Report Wizard for the Custom List report

Custom List Properties

The main Custom List dialog box is used for loading and saving Custom List formats, and for changing the current
format.

Custom lists

Custom List reports

Create custom reports here

I

Default

Custom List favorites

B Class Bins Yirtual Day and Wesk
| % Class Bins with 15-min drops

| % Camma Separated Speed Bing
% Database example

B ndividual

B Safely Camera Example [30-40]
% Safety Camnera Example (50-60-70]
% Speed Bing with Grand Total

% Split Direction Clazs Bing

B XML Example

[ Load ] [ Save As... ] [ Delete ]

Custom List report properties

Toload an existing Custom List format, select an item from the Favorties list and click the Load button, or simply

double-click. The Custom List name will change to indicate the format has been loaded. Several examples are
provided.

The Save As button writes the current Custom List format to afile, whose name will then appear in the Favorites list.
Custom List format files have a .xpt extension, and should be stored in the Profiles folder in MTE's Documents
folder.
The Modify button at the top leads to another dialog box, with the Custom List properties broken into four areas:

» Format - defines the layout of the report, specifically the rows and totals.

« Fields - defines the included columns, and their order.
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« Advanced - miscellaneous options, including user-defined fields and totals.
« XML - options for exporting datavia XML.

Most of these options are covered in subsequent sections. Exporting data via XML is covered in its own chapter.

Note:
A The word modified will be appended to the Custom List format name when any properties are changed. To remove
this, simply save the format.
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Custom List Format

Time Step Interval

The Time Step option isthe interval over which vehicles are accumulated for each row in a Custom List report. The
Suppress steps selection removes all data rows from the Custom List report, leaving only summary totals and
statistics such asthe Virtual Day or Week.

9
Custom List Properties &]
Fomst | Fisids | Advanced [ XML | Time Total C€ls Cls Cls Cls Cls Cls Cls Cls Cls Cls Cls Cls Cls Mean Vpp
Time step for rows 1 2 3 4 5 I3 7 ] E) 10 11 1z 13 85
7] Roll days nooo Z56 1 z47 3 P 1 0 [ ) [ 0 0 ) 0 78.6 B84.2
Suppress steps ) 01 zz6 0 zz3 1 z o o o o o o o o 0 7.3 &850
vaepmmmgs picles 0zoo 13z o 1zs 0 z 3 1 0 0 ] 1 o 0 0 8l.z 8B.Z
Ten minutes ons 0300 111 110 o 3 2 1 o o o o o o 0 8l.6 @8.9
15 minutes 0400 185 1 1sz 1 ] 5 1 1 1 z 0 1 o 0 7.8 84.6
20 minutes 0500 450 5 4l0 5 14 7 0 [ 1 1 5 1 [ 0 801 85.7
30 minutes 0800 1343 5 1204 z4 57 16 4 1 3 7 z1 o 1 o0 731 73.2
0700 211l 8 1365 33 &3 3 4 z 7 H 5 1 1 1 0.1 72.0
Two hours 0800 z161 7 zols 285 7z 15 5 3 5 4 5 o o 0 561 64.1
Three hours 0800 1780 3 1637 16 a0 15 4 3 3 H 3 1 o 0 65.5 73.8
Four hours 1000 1618 4 1470 zz a1 11 4 7 1 3 1z 1 [ 0 65.0 73.1
Six hours 1100 1e61 4 1518 18 a3 14 4 B 1 & 7 0 a 0 g1 731
Eight hours 1200 1663 6 1541 16 75 14 1 3 o 3 3 1 o 0 E5.3 74.Z
?”‘EI“’E;‘U“'; 1300 1535 3 1452 14 85 15 3 4 z 8 3 o o 0 67.4 74.9
ety four hours 1400 1701 4 1878 18 77 1o 3 1 3 1 & 0 o o &7z 742
[T Append Grand Total 1500 1915 g 1789 28 69 5 z 3 5 4 5 0 [ 0 4.3 70.9
[ Append a Vitual Day 1600 1436 3 1378 zo z8 3 z 1 1 o z o 1 0 346 Ez.9
] Append a Virtual Wesk 1700 1346 4 13ls ] 16 0 0 [ [ 0 0 0 [ 0 z3.& 3.2
7] Autoscale to ft page width 1800 1654 8 1625 z 1z 2 1 1 o z 1 o o 0 545 73.4
1800 1048 4 loz7 3 1z 0 0 1 1 o 0 1 o 0 7E.E 796
] Emit every vehicle 2000 ane 3 787 1 11 1 0 [ [ 1 z 0 o 0 75.0 79.9
[#] Include header irformation z1o00 742 3 727 z 7 1 a o o 1} z 0 a o 78z 8l.0
[] Page layout preference is landscape 2200 &72 5 (133 1 3 3 z ) ) z 1 o 1] o 77.0 8L.7
2300 466 3 453 1 3 2 o o o o 1 o o 0 773 @z.4
Field delimiter sample 07-1% 20658 73 19285 217 157 113 33 36 28 a4 65 4 2 1 58.9 72.0
06-22 24598 83 23030 247 844 131 37 ae 32 52 90 5 2 1 61.4 M.5
0000 0001 0002 0003 .. 06-00 25736 96 24138 249 853 136 29 £ 3z 54 92 5 E] 1 62,1 5.6
00-00 27096 105 25407 259 889 155 4z 39 34 57 98 7 ] 1 630 76.3

Example Custom List report with a time step of one hour

Time Step Grouping

The Group by days option breaks the time steps into 24-hour groups, placing the date at the start of the group. The
option also includes the column descriptions option before the group, and the totals, speed statistics and peaks
options after the group. If the Group by days option is not selected, these options appear at the beginning and end of
the entire range of time steps.

@ Thursday, 2 August 2007
@ Time Total Cls Cls Cls Cls Cls Cls Cls Cls Cls Cls Cls Cls Cls HMean Vpp

1 2 3 4 5 & ki 8 9 10 11 12 13 85
e T P e === 0000 262 T 251 z P z 0 0 0 1 1 0 0 0 84.6 9l.8
olon 118 1 108 1 g z o o [ 0 0 o o 0 840 93.8
Format | Fieids | Advanced 2L | 0zoo 100 o o9z 1 4 z o o [ 1 0 o o 0 83.8 92.5
0300 167 1 157 [ 7 z o o [ 0 0 o o 0 853 93.2
Time step for 1ows 0400 420 o401 z 13 z z o [ 0 0 o o 0 845 92.2
[ Roll days 0500 11894 11 1118 5 a5 11 1 1 [ 0 1 o o 0 83.3 00.4
Include rows with na vehicles 0600 2775 13 2581 Bl 87 1l 8 1 3 3 g o o 1 80,0 86.0
{8 7] Inchds column desciipians 0700 3760 15 3581 3% a4l 13 4 3 4 5 7 1 o 0 727 BO.3
7] Fule below 0800 3376 13 31e4 20 110 10 z 2 5 4 8 z o 0 72.7 BO.§
A 0900 2992 13 2752 36 127 1§ & 7 8 7zl o o 0 739 BL.7
(T St diectiors. 1000 2440 10 2167 24 157 2l B 13 ] 7 23 1 1 0 77.0 B4.6
Underine spits 1100 2542 10 2279 26 186 20 ] 7 5 & a0 E] 2 0 7E.0 532
[¥] Group by daps. 1200 2756 B 2481 27 166 22 ] ] ] 718 ] 1 0 75,2 82.8
|| Extended heading 1300 2881 186 2601 33 148 26 13 3 & 10 25 z z 1 75.6 83.2
Include totals 1400 3016 11 2754 4z 145 13 4 a S 3 17 o o 0 76.0 83.2
Include speed statistics 1500 3413 18 3147 4% 140 1§ 3 4 g 5 24 3 o 1 74.7 BL.7
[¥] Includs pesks 1600 3918 20 3703 46 113 g 1 8 8 5 7 o o 1 7l.6 B80.8
1700 4062 1 3911 2z 80 4 z 1 2 4 g o o z 727 BO.§
ls00 2708 11 2643 14 30 3 o 1 [ 1 4 o 1 1 77.6 B4.8
["] 4ppend Grand Total 1000 1638 5 1602 3 20 1 a 1 [ 1 z ] ] U B0.3 B6.8
[T &ppend a Virtual Day 2000 1212 11 1181 4 11 3 o o [ 0 2 o o 0 8l.3 8.2
[7] ppend 3 Vitusl Week zl00 1328 10 1298 2 9 3 1 o [ 0 4 o o 1 8l.0 86.8
[¥] &utoscale to fit page width 2z00 994 a 976 2 10 3 a a 1] 1 2 a a 0 Bl.9 B8.Z
[ Emit every vehicls 2300 878 3 653 314 z o o 1 0 0 o o 0 8l.3 B7.5
[ Include header infarmation 07-19 37877 169 35213 369 1473 173 5% 69 M 0 181 12 7 6§ .4 82.1
[ Page layout prefersncs is landscape 9us—zz 14828 208 41875 432 1610 191 66 71 77 14 195 12 7 8 T5.4 83.2
06-00 46498 211 43504 437 1634 196 68 1 T 75 191 12 7 8 15.6 83.5
Field delfimiter sample 00-00 48779 225 45631 448 1714 217 11 T2 T 11 1989 12 7 8 T6.0 83.9
00000001 0002 0003 ...
@reak step 17:00 [4062) WM Peak step D7:00 [3760] PM Peak step 17:00 (4062)
Vehicles = 48753
Posted speed limit = 20 kw/h, Exceeding = 15246 (31.27%), Mean Exceeding = 85.15 km/h

- © i = 167.1 km/h, Minimum = 4.7 km/h, Mean = 76.0 ku/h
85% Speed = 23.3% kw/h, 95% Speed = 83.% kun/h, Mediamn = 76.3 kn/h
20 km/h Pace = 65 - 95, Number in Pace = 38143 (78.23%)
Variance = 7z.71, Standard Deviation = 2.53 km/h

Custom List Grouping and Totals

When datais grouped by days, the first time step starts at midnight. The Roll days option groups data in 24-hour
periods aligned to the start of the report's Time Filter. Thisis useful for short 24 or 48-hour counts where daily totals
are required, but the data may not start at midnight.
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* Tuesday, 1 May 2007 - Wednesday, 2 May 2007

Time Total Cls Cls Cls Cls Cls Cls Cls Cls Cls Cls Cls Cls Cls Mean Ypp
1 2 3 4 5 [ 1 ] 2 i0 11 12 13 85

Coson ) 1741 7 1lg03 17 76 11 B 5 5 z B 1 [} 3 7.7 77.0
1471 2 1z13 z4 a7 1z & £ El 4 3 o 1} o 737 80.3

1100 1544 1 1396 15 3L 11 7 7 4 4 [ 1 o 0 73.0 73.6
1z00 1580 z 1lezz 15 a4 1z 5 4 3 1 10 1 1 0o 73z 80.3
1200 1878 0 l42E 11 23 1z 7 2 £ 1 £ Ll a o 7z.% 736
1400 1709 0 1552 z7 a3 z0 4 6 z 2 1z o o 0o 7z.4 78.2
1800 1822 1 1les0 z3 az 1z El z 4 2 3 o 1} 1 7.2 78.E
1600 Z018 & 19zl zz 56 [ o z z 1 z o o 0 &€7.0 75.6
1700 15984 z 1m9z zz 3z 5 El z 4 z o o 1} 0 3.z 73.8
1200 1880 ¥ LlEZE 7 1e £ Ll a Z 1 1 1 a 0 75.3 8l.4
1900 1032 2 1008 7 El z o 1 o 1 1 o o 0 79.z B4.6
zooo 787 7 760 El 10 4 o 1 1 o 1 o 1} 0o 75.6 85.0
z100 204 3 783 1 [ z o 1 o [z} z o o 0 73.6 85.0
zzoo 633 3 8lz z 10 z 1 1 1 o 1 o 1} 0o 75.5 85.3
2200 349 1 237 a 7 z Ll a a o z Ll a 0 8z.0 283.9
oooo 196 2 187 o 1 2 o o o 1 1 o o 0 83.3 88.6
o100 L o a0 1} z 2 o 1} 1} 1 o o 1} o 8z 1 87.1
ozoo 78 1 73 o 4 [z} o o o [z} [z} o o 0 3.4 38.9
0300 133 o1zl 1} 3 3 1 1} 1} o z o 1} 0 sz.8 87.8
0400 338 1 ZLE 3 11l ke 1 a a o 1 Ll a 0 gzZ.e 88.2
os0o 738 6 &80 3 13 9 1 o z 1 1 o o 0 8l.5 B85.4
0E00  1EED & 1461 13 £d 1z z 1 4 o 1 1 1} o 76,1 81.7
o700 1837 10 1811 zo 38 s z o o 3 7 1 o 0 3.1 78.7
0800 1836 & 1750 10 47 8 z z z 1 3 o 1} 0 68.1 76.3
07-1% 20697 43 19220 220 200 1zo0 43 44 31 26 64 5 1 4 70.4 118.5
06-22 24379 61 23308 249 879 140 45 48 a2 27 69 6 1 4 71.7 9.9
06-00 25861 €5 24257 251 896 144 48 49 43 27 12 € 1 4 72.1 80.3
00-00 27437 76 25723 257 955 165 49 49 a5 30 7 6 1 4 72.7 810

Example Custom List report with roll days option enabled

The Split directions options inserts two rows for each time step, one for each direction. Note that the direction is
based on A>B and B>A, not the compass direction. When combining multiple files with this option, ensure the
compass directions match.

Date Time Dir Total Cls Cls Cls Cls Cls Cls Cls Cls Cls Cls Cls Cls Cls Mean Vpp

1 2 3 4 5 6 ? 8 9 10 11 12 13 a5

2/03/1993 0000 AB 3962 25 3646 31 239 & 4 1 0 ] 3 a o 1 566 64.1
2/03/1993 0000 EA 4467 24 4143 14 263 g g 1 2 1 z a o 1 &l.2 63.7
3/03/1993 0000 AB 3841 16 3547 26 237 a 1 1 0 3 a a o 1 &7.1 A5.2
3/03/1993 0000 EA 4238 11 3934 21 258 5 4 z 1 1 1 a o 0 57.1 64.4
4/03/1993 0000 AB 4075 24 3755 4z 234 & 4 3 1 1 3 a o 2 &7.1 64.8
4/03/1993 0000 EA 4438 19 4175 26 257 5 3 z 0 0 1 a o 0 &57.3 64.4
5/03/1993 0000 AB 4143 22 3805 41 255 7 & z 3 0 a a o 2 &7.2 65.2
5/03/1993 0000 EA 451z z4 4189 23 258 3 g 4 1 1 1 a o 0 53.9 64.1
6/03/1998 0000 AB 4361 18 4031 47 247 g 2 1 4 1 1 a o 1 56.6 64.4
6/03/1998 0000 EA 4541 13 4235 16 256 a 7 1 2 2 a a o 0 &1.9 63.4
7/03/1998 0000 AB 2991 1z 2819 23 128 3 1 1 2 0 a a o 2 &8.3 66.6
7/03/1993 0000 EA 3246 & 3087 13 136 3 a o 0 0 1 a o 0 &3.3 66.2Z
8/03/1998 0000 AB 2659 21 2591 14 31 1 1 o 0 0 a a o 0 &3.0 A5.9
8/03/1993 0000 EA 2741 12 2669 16 40 3 a o 0 0 a a 1 0 5&3.4 66.2Z
- 07-19 #AB 20675 103 18999 200 1274 39 17 9 10 9 7 o [} 8 56.9 64.8

- 07-19 BA 23036 51 21409 121 1341 34 29 1o 6 4 [ o 1 1 5.2 64.1

- 06-22 AB 24107 117 22333 215 1339 40 18 9 10 10 1 o o 9 57.0 64.8

- 06-22 BRA 26723 108 24983 123 1409 36 30 1o 6 5 & o 1 1 54.9 64.4

- 06-00 AB 25110 117 23318 218 1394 a0 18 9 10 1 T [ o 2 57.1 64.8

- 06-00 BA 27665 109 25901 129 1431 36 30 10 6 5 [ o 1 1 55.0 64.2

- 00-00 AB 26032 136 24194 224 1371 40 19 9 10 11 T o o 9 57.2 695.2

- 00-00 BA 28233 109 26432 129 14638 36 30 10 1] 5 6 o 1 1 55.1 64.4

Custom List with 24-hour time step and Split Directions option

Partial Totals

The Include totals formatting option by default includes a 24-hour total (00:00-00:00), as well as the common
12-hour (07:00-19:00), 16-hour (06:00-22:00) and 18-hour (06:00-00:00) partial totals. These can be changed or
removed on the Advanced page of the Custom List Properties.

Time Total Vpp Meanx

Partial Total e} 85 s0
0000 643 82.6 87.3
Fartial otals — - start howr olon 382 S0.4 87.9

o~
®[1]US'UU'22'U El zzoo 1843 87.1 6&6.35

2300 1161 87.8 6§6.35
07-19 70079 79.9 §4.2
06-22 82673 81.4 84.6
06-00 85677 81.7 84.7
00-00 892841 $2.4 65.1

il [T I—

(D[3]00:00- 00:00 To disable & total, set the span to zsro

@ Couble-click to edit

Editing Custom List Partial Totals

Double-click any of the Partial Totalsto edit thetime range. To disable a Partial Total set the start and end hours to
the same value, except for 00:00-00:00 which is the 24-hour total. A disabled Partial Total will display 0ff and will

not be displayed in the totals block.

Virtual Day/Week

The Append a Virtual Day or Week options include a virtualised summary of the data at the end of the Custom List

report.
A virtual day represents a"typical" 24 hour period, using one hour per row. A virtual week represents a "typical"

week, with arow per day. Datais accumulated for all the matching times, and then recal culated. The summaries are

not just an average of previously calculated rows, totals or statistics.
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* Virtual Day (21)
Time -/n  Total Cls Cls Cls Cls Cls Cls Cls Cls Cls Cls Cls Cls Cls Vpp MeanX

1 2 3 4 5 6 1 ] 9 10 11 12 13 85 &0

oooo 21 349 1 337 1 5 2 o ) ) L 1 o ) 0 9l.1 87.8
oo 21 169 o 181 1 4 1 o ) ) L 1 o ) 0 92.2 88.4
0200 21 143 o 135 1 3 1 o ) ) a a o ) 0 94,0 83.5
0300 21 179 o 170 1 4 2 o ) ) a a o ) 0 93.2 8§%.0
0400 21 375 1 338 2 10 1 1 ) ) a a o ) 0 9z2.5 88.0
oS00 21 979 7 928 5 a7 7 2 1 1 a 1 o ) 0 9l.4 87.4
0e00 21 al3z 10 1992 30 77 ) 3 1 3 L 4 o ) 0 86.8 85.5
o700 21 2909 12 2762 28 78 ) 4 2 3 2 3 1 ) 0 8z2.8 845
0800 21 2798 14 2650 23 77 1z 4 2 5 2 g 1 ) 0 8z2.4 848
0900 21 242z 92247 26 99 13 4 4 5 4 11 1 ) 0 83.5 849
o000 21 23la 6 2llo 29 119 17 & 5 5 3 1z 1 ) 0 84,2 85.0
1100 21 2550 & 2338 30 12z A=) & 5 7 4 13 1 ) 0 83.5 846
1200 21 2571 8§ 2362 30 121 17 4 4 5 4 13 1 ) 0 83.% 849
1300 21 2514 10 2313 33 106 17 & 4 6 4 1z 1 ) 1l 84,2 84.9
1400 21 26877 2 2470 36 114 15 4 5 6 4 11 1 ) 1l 83.5 84.9
1500 21 2936 12 2748 35 0z 13 2 3 5 4 ) 1 ) 1l 8z2.8 848
1600 21 3348 le 3180 32 9L g 2 4 5 3 7 o ) 1 8l.4 847
1700 21 3517 14 3397 25 13 4 1 2 2 L 4 o ) 0 &5l.4 845
1800 21 2392 9 2334 1z 28 4 o 1 1 L 2 o ) 0 8§5.3 85.2
1900 21 1476 4 1446 7 15 2 o 1 ) a 3 o ) 0 8§7.5 85.9
2000 21 1114 4 1088 4 1z 3 o ) ) a 2 o ) 0 88.2 86.3
2100 21 1130 4 1108 3 10 2 o ) ) a 2 o ) 0 8§7.8 86.2
2200 21 941 3 920 2 1z 2 o ) ) a 1 o ) 0 88.2 86.4
2300 21 590 1 575 1 ) 2 o ) ) L 1 o ) 0 8§%.3 8§7.0
07-19 21 32945 1271 30910 339 1122 119 39 42 53 3 108 9 2 5 §3.2 84.8
06-22 21 38799 149 36544 383 1235 167 43 44 59 39 119 9 2 6 84.2 85.1
06-00 21 40330 154 36038 381 1255 i 43 45 59 40 122 9 2 6 64.2 83.2
00-00 21 42544 164 40148 397 1311 185 a7 46 61 43 125 9 2 6 84.6 85.5

*Virtual Week (3)
Time -/n  Total Cls Cls Cl=s Cls Cls Cls Cls Cl=s Cls Cls Cls Cls Cls Vpp MeanX

1 2 ¥ 4 5 6 1 & 9 10 11 12 13 B3 80

Mon 3 44450 156 41584 4lz 1639 244 56 56 73 56 158 11 2 Z B4.2 B5.2
Tue 3 46757 177 43768 415 1699 250 60 55 80 53 179 1z 3 7 B84.2 B5.2
Wed 3 47722 175 44807 43z 1610 243 68 59 80 56 170 13 1 6 B83.9 B85.3
Thu 3 47779 181 44830 423 1676 232 59 59 77 &0 161 11 4 7 B83.9 B85.2
Fri 3 43460 z04 45363 438 1728 238 65 58 83 59 145 13 4 & B84.2 B5.3
| 3at 3 34674 138 33462 346 532 65 14 25 26 13 4z 5 1 5 B6.8 B86.0
| Bun 3 27964 118 27215 260 292 25 5 11 a 4 2z 1 0 4 87.1 8a.1
-- 3 297806 1148 281035 2776 9176 1296 328 322 427 301 81 66 15 39 84.6 85.5

Custom List Virtual Day and Virtual Week

Careful attention should be paid to the start and finish time alignment in the Profile when including virtual
summaries. When using the virtua day, the Profile duration should be a whole number of days. When using the
virtual week, the Profile duration should be awhole number of weeks. This ensures that averages are not skewed by
including part of an hour or day that was only partially recorded. The whole number of days and weeks can be
unaligned (not aligned to midnight). The Profile's time Auto-Wrap options assist in selecting an appropriate time
range.

If the Profile is not appropriately set, the title will indicate partial data, such as ** Virtual Day (Partial days = 7.06)
or ** Virtual Week (Partial weeks = 1.01). In these cases, total rows (if selected) will not be shown.

Grand Total

The Append Grand Total option includes an aggregate row for the entire range of data. Like the Virtual Day and
Week, these values are calculated from al the underlying data, not from previously calculated rows, totals or
statistics.

* Grand Total

Time Total Cls Cls Cls Cls Cls Cls Cls Cls Cls Cls Cls Cls Cls Vpp Meanx

1 2 3 4 5 6 7 8 9 10 11 12 13 85 80
-- §9341% 34495 43104 9326 27527 3668 983 96T 1282 04 2631 191 4% 117 84.6 85.9

Custom List Grand Total

Individual Vehicle Steps

The Emit every vehicle option creates arow for every vehicle. The special Vehicle parameter group of fields contain
fields similar to those found in the Individual Vehicles report.

Date-Time Speed Dir Thase Hibszy Gap Ax Gp Vehicle Pic

1993-09-20 13:01:25 76.5 AB 3.1 Z.4 2.3 2 Zo o

1993-09-20 13:01:27 82.3 AB 2.9 Z2.2 Z.1 2 Zoo

1993-09-20 13:01:47 &3.8 AB 9.1 20.5 20.4 3 30 o a
1993-09-20 13:01:59 B3.8 A 14.3 11.6 11.2 6 3 o oo ooo
1993-09-20 13:02:33 &0.Z AB 3.0 34.2 33.6 2 Zoo

1993-09-20 13:02:58 B&5.2 AB 2.5 24.8 Z24.6 Z Z oo

1993-09-20 13:03:26 77.7 AB 7.4 28.2 28.1 3 Za oo

1993-09-20 13:03:33 76.3 AB 5.8 7.1 6.7 2 Zao a

1993-09-20 13:03:37 76.3 A 19.7 4.0 3.8 & 40 oo ooo oo
1993-09-20 13:03:51 79.9 AB 1.9 14.1 13.2 2 1 oo

Custom List report with Individual Vehicles

Using the Suppress steps Time Step option, all other Custom List fields will be ignored, producing a report with just
individual vehicles. If aTime Step is selected, they will be interspersed with the individual vehicles.

Page Layout

If the width of the selected fieldsin a Custom List report exceed the width of the page, the Autoscale to fit page
width will automatically reduce the size of the report's font. If the font becomes too small to read, alandscape page
layout may be preferable.

©2013 MetroCount® - - MTE User Manual 131

o
c
7
—
(]
=
C
@
@,
X
D
°
o
=3




Autoscale to fit page width

[] Emit every vehicle

Include header information

[] Page layaut preference is landscape

Custom List page layout options

The Include header information option includes the standard MetroCount report header at the start of the Custom
List report, as well as a column legend for the selected fields.

Field Delimiters

Fields or columnsin a Custom List report are separated by a space character by default. To change this to another
character, such as a comma for exporting to a spreadsheet, click the Change button at the bottom of the Format page.
Each field can optionally be enclosed in another character, such as a double quote.
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" Tine"," Total®,’
Field delimiters | W

Field defimiter

Enclose items in... |"" Double quotes =
Sepalzmoly

T

=

‘
*oooooT, 437,
*ooLooT, gz,
*oozoow, T 3117,
o03007, " Iz,
04007, " T,
oosooT, Tt 17sav, T
o0enoT, "
07007, BodsT, T
o0s00", T 541l

Custom List Field Delimiters
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Custom List Fields

Selecting Fields

Fieldsin a Custom L.ist report form the columns of the report. The Fields page of the Custom List Properties contains
the Fields Tree at the top with the list of available fields, and the Selected Fields list at the bottom.

.
Custom List Properties [

Figlds | Advancad | #hL
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3 Time and date fields -
= (& Count and sub-count fields
8 11 - Number in time step [Total]
% 81 - Number in time step [4B] [Tatal]
% 82 - Number in time step (BA) [Total]
Y 12 - 15-minute diops [How steps only) [Drop
% 13 - Curnulative total wehicles [FunT of]
[ Class bin fields _
[ Speed bin fields otl??:@‘cet ;Meclé
[ Separation bin fields
3 Speed limit fields
@ Speed statistics fields
[ Mass and axle loading fields i

m

Selected fields (drag to change order) ‘.:.‘.j
Selected Fields

& 01 - 24-hour time (0000 - 2353) [Time]
11 - Mumber in time step [Tatal]
D014 - Class totaks [Els][% >
[]25- Awerage speed [WSan] - 1= ke AR
[] 28 - Percentile speed [Vpp]
12 - 15

[Hour steps only] [Drop]

@Crag to re-order

Selecting Custom List Fields

Fields can be added to the Selected Fields list by double-clicking them, or dragging them from the Fields Tree. The
order of fields can be changed by dragging them around in the Selected Fields list. To remove a selected field, smply
double-click it.

Note that the text in square brackets at the end of each field name is the column heading used for that field.

Time and Date Fields

The Time and Date Fields display the beginning of each time step. There are avariety of standard date formats, most
of which are self-explanatory.

(& Time and date fields 9 (=)

S, 01 - 24-hour time (0000 - 2359) [Time] €) o ) o e o 4 thhimm £ (ddmmiyyyy)

0 P DD Time | YYY 1 Date-Time | Date-Time | Time | Date | Time' | Date
% 03';‘?‘13[ a:f” 'S‘Etwwe 1® G500 | 200707150000 | 2007-07-19 00:00:00 [ 2007-07-15T00:00:00 | 00:00 | 19707/2007 | 12700 A | Ls7ulzan?
9 03 Full date an ime: [Diate-Time] . 0100 | 200707180100 | 2007-07-19 01:00:00 | 2007-07-19T01:00:00 | 0L:00 | 19/07/2007 | 0L:00 AN | 19Jul2007
1%, 701308601 date and tine (<ML) [D-ate-Time] @) 0200 | 200707190200 | 2007-07-19 02:00:00 | 2007-07-19T02:00:00 | 02:00 | 19/07/2007 | 02:00 AN | 19dul2007
% 04 - Losale time (Time] @ 0300 | 200707190300 | 2007-07-19 03:00:00 | 2007-07-19T03:00:00 | 03:00 | 19/07/2007 | 03:00 AM | 19Jul2007
9, 05- Locale short date [Date] @ 0400 | 200707190400 | 2007-07-19 04:00:00 | 2007-07-19T04:00:00 | 04:00 | 19/07/2007 | 04:00 AN | 19dul2007
%, 06 - User defined time picturs [Time] @ 0500 | 200707190500 | 2007-07-19 05:00:00 | 2007-07-18T05:00:00 | 05:00 | 18/07/2007 | 05:00 AM | 15Jul2007
% 07 - User defined date picture [Date] @) 0600 | 200707190600 | 2007-07-19 06:00:00 | 2007-07-19T06:00:00 | 06:00 | 19/07/2007 | 06:00 AN | 19dul2007

Custom List Time and Date Fields
The Locale options use the format provided by the operating system's regional settings.
The 1808601 format is recommended when exporting data, to provide compatibility with programs such as Excel.
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The User defined date and time pictures can be edited on the Advanced page of the Custom List Properties, using the
standard Windows time and date notation.

HHmm Time format picture

ddbibdpy Date format picture

Custom List user defined date and time pictures

Count and Sub-count Fields

The Count and Sub-count fields provide the total number of vehiclesin the current time step.

(@)
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= Count and sub-count fields Time Total Total Total | Drop Drop Drop Drop | RunTot
3 11 - Humber in time step [T otal] 7B Bl --00  --15 --30  --45
%, 81 - Number in tims step (48] [Total] ] 643 302 34l | zll 171 146 115 | 643
%, B2 - Number in time step (B4) [Tatal] olo0 38z 16z 220 | 90 87 83 108 | 1025
@ 12-15minute driops (Howr steps only) [Drop] 0200 311 116 195 | s 84 77 55| 1338
% 13 - Cumulative total vehicles [RunTot] 0300 32z 158 164 | &0 72 84 108 | 1658

Custom List Count Fields

If the directional totals AB and BA are used with multiple datasets tagged, each dataset should have the same direction
code.

When using an hourly time step, the 15-minute drops field inserts a column for the total vehiclesin each 15-minute
period.

The Cumulative total vehicles field displays the cumulative number of vehicles since the beginning of the report.

Class Bin Fields

The Class totals and percentages fields include a column of total vehicles (or percentage) for each classincluded in
the report's Local Profile.

Time Total | Cls Cls Cls | Cl% Cl% Cl%

(& Class bin fields 1 2 3 1 2 3
3, 14~ Class totals [Cls] 0000 643 | 623 12 a1 9.9 1.9 l.2

, 15-Class percentages [Ciz] 0100 382 1 368 10 4] 96.3 2.6 1.0
o0zan 311 | 302 7 21 97.1 2.3 0.8

0300 322 | 305 15 21 94.7 4.7 0.8

Custom List Class Bin Fields

Speed Bin Fields

The Speed bin totals and percentagesfields include a column of total vehicles (or percentage) for each enabled
speed bin in the report's Local Profile. The lower and upper limits of each column are displayed in the column's
heading.

Note that some vehicles may be hidden if some speed bins are disabled.

Time Total | Vbin Vhbin Vbin Vhin | Vb Vb Vh%  Vh% | TRate
@ Speed bin fields o 60 0 100 o 60 an 100
de 1E - Speed bin totals [Vhin] 60 80 100 200 0 80 100 200
% 17 - Speed bin percentages [vbi] oooo 643 | 1 263 355 24 | 0.2 40,8 55.2 3.7 1 403.0
% 37 - Speed rating [vRate] oLoo gz | 2 137 204 19 1 0.5 4l.1 53.4 5.0 1 242.0
nzoo 31110 1 113 185 1z | 0.3 36.3 59.5 3.9 1 208.0
0300 a2 | o 10z 205 15 | 0.0 3L.7 63.7 4.7 | 235.0

Custom List Speed Bin Fields

The Speed rating field is the sum of products of each speed bin total multiplied by the bin's multiplier. These are
defined in the report's Local Profile.

Separation Bin Fields

The Separation bin totals and percentages fields include a column of total vehicles (or percentage) for each
separation bin defined in the report's Local Profile. The lower and upper limits of each column are displayed in the

column's heading.

Time Total | Sep Sep Sep Sep Sep | Sep% Sepx Sepk Sep% Sep% | sRate

Bﬂ Separation bin fields 0.00 0.50 1.00 2.00 4.00 0.00 0.50 1.00 2.00 4.00

% 41 - Separation bin totals [Sep] 0.50 1.00 2.00 4.00 1000.00 0.50 1.00 2.00 4.00 1000.00
%, B0- Separalion bin percertages [Sep%] 0700 6945 | ] 954 3757 1647 579 | 0.1 13.7 54,1 23.7 8.3 | 12055.0
% 42 - Separation rating [sF ate] 0s00 5909 | 3 385 2600 2405 al4 | 0.1 6.5 44.0 40.7 8.7 | 8772.0
0800 6072 | 4 586 3080 1673 728 | 0.1 2.7 50,7 27.6 12.0 | 9607.0
1000 5134 | 5 579 2246 1381 213 | 0.1 11.3 43.7 27.1 17.6 | 7640.0

Custom List Separation Bin Fields

The Separation rating field is the sum of products of each separation bin total multiplied by the bin's multiplier.
These are defined in the report's Local Profile.
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Speed Limit Fields

The Speed Limit fields display the total number of vehicles (or percentage) exceeding the selected speed limit. The

Posted Speed Limit, and up to 10 other limits are defined in the report's Local Profile. Q
The actua limit, and the limit's name if one was defined, are displayed in the column heading. )
=

Z Speed limit fields Time Total | >PSL »PSL% | >SL1 3>SL1% | >SL2 >SL2% —

3, 19 - Number exceeding Posted Speed Limit [>PSL] 80 80 90 L1 100 100 a

%, 19 - Percent exceeding Posted Speed Limit [»P5L%] PSL+10 PSL+10  PSL+20 PSL+20 —

% 20 - Mumber exceeding Speed Limit 1 [>SL1] o0oo 643 | 379 53.9 | 92 14.3 | 24 3.7 il

% 21 - Percent exceeding Speed Limit 1 [>5L1%] 0100 382 | 223 58.4 | 63 16.5 | 19 ] )

&, 61 - Number exceeding Speed Limit 2 [512] 0200 311 | 197 63.3 | 57 18.3 | 1z 3.9 o

% B2 - Percent exceeding Speed Limit 2 [>5L2%] 0300 3zz | 220 B8.3 | 7z 2z2.4 | 15 4.7 o

=3

Custom List Speed Limit Fields

Speed Statistics Fields

The Speed Statistics fields provide avariety of standard statistical measures for the speed of vehiclesin the current

time step.
(& Speed statistics fields Time Total | nPace vPace Pace Mean Vmin Vmax Vop  Vep  ¥50 sD Var Mean¥
3 22 - Number in speed pace [nPace] 20 20 20 35 95 80
% 23- Speed at start of pace [Pace] 0000 €43 | 54z 72.7 84.3 B82.6 50.3 145.6 9.6 96.5 8L.0 8.0 70.7 87.3
% 24 - Percent in pace [Pace?) 0l00 382 | 33 7.9 1.9 82.7 52.8 123.1 90.4 99.0 8L.0 9.0 Bl.l &7.3
1% 25 Average speed [Mean] 0z00 311 | 252 73.4 81.0 83.3 G56.6 134.6 91.4 93.3 3l.7 9.0 80.1 &7.8
&, 26 - Minimum speed [Vimin] 0300 32z | 256 T73.1 79.5 8.9 85.1 115.0 94.0 99.7 835 8.4 70.3 88.3
&, 27 - Mawimum speed [Vmax] 0400 717 | €03 727 84.1 a8d.z 56.9 1z1.1 91.4 93.6 82.8 8.0 B4.2 87.5
@ 26 Percentile speed [Vop] 0500 1789 | 1520 T2.7 85.0 83.8 59.7 132.4 9l.1 97.2 82.8 7.5 56.5 87.4
9 29- Percentile speed 2 [Vpp] 0600 4867 | 4177 68.5 85.8 78.2 4.2 116.8 857 90.0 79.2 7.0 49.3 85.0
© 20-50thpercentle speed (Mediar) [/50) 0700 6945 | 4858 2.3 72.0 70.8 21.1 109.9 0.6 85.0 7.0  10.5 109.5 3.9
&, 44 - Standard Devistion [3D] 0800 5900 | 2634 63.0 44.6 52.8 0.0 105.2 TE.5 82.8 62.3  24.5 597.8 63.3
&, 45-Variance [Var 0900 6072 | 3382 63.0 55.7 6.4 2.4 115.8 79.9 84.6 8.0  13.4  179.3 &4.1
% £3-ean Exceeding [Mearik] 1000 5134 | 4064 63.4 79.2 74.0 49.4 112.5 8l.7 B86.5 T4.2 8.0 644 84.4

Custom List Speed Statistics Fields

The width of the speed pace, the percentile speeds and the posted speed limit for Mean Exceeding are all set in the
report's Local Profile. The actual values are displayed in the column headings.
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Mass and Axle Loading Fields

The number of single, double and triple axle groups are based on the definition of a group (two or more axles less

. . e - @)
than a certain distance apart) in the selected Classification Scheme. S
—
. . . . ' . o
The ESA and estimated mass fields use the Estimated Mass table in the report's Local Profile. 3
& Mass and axle loading fields Time Total | nhxl nAx2 nAx3 ESA fMass glass Energy g
3 31 - Number of isalated single axles [ndx1] 1300 233 | 458 44 1z 102.9 404.0  957.1 232.94 —
1% 32 - Number of doubls axls groups [nds2] 1400 255 | 45z 53 10 96.8  337.0 90l.0 209.67 m
3, 33- Number of triple (o more] avle groups [nés3] - 1500 332 | 642 40 9 746 279.0  640.5  147.97 )
% 34 - Number of equivalent standard axles [E54] 1800 309 | 533 51 14 11z.5 474.0 1033.1 252.22 o)
% 35 Estimated freight mass [fMass] 1700 297 | 579 41 16  95.6 417.0 B65.9  220.43 b}
3, 36- Estimated gross mass [Mass] 1800 179 | 337 40 20 98.9  43Z.0  905.7  234.99 3
%, 43- Energy [Energy] 1900 97 | 172 30 19 82.3  379.0 7748 195.33

Custom List Mass Fields

Formatting Fields

Fields or columnsin the Custom List are normally separated by a space character on the right-hand side of thefield.
This character can be changed in the Custom List's Formatting options.

The Separate columns with a vertical rule field can be used to further delineate fields. Placing Remove separator
from next field before afield will join the next two fields together.

@ Formatting fields o )
33- Separate columne with a verical e (1) pime Total | Fixl Fix? | Fixl Fix?
% 40- Remove separato from ”fem'em[]@ 1300 239 | User defined 1 User defined 2 | User defined lUser defined 2
3, 08 - User defined fixed test [Fixl | 1400 255 | User defined 1 User defined Z | User defined lUser defined 2
%, 09 - User defined fixed text [Fix2] 1500 332 | User defined 1 User defined Z | User defined lUser defined 2

Custom List Formatting Fields
The user defined text fields can be set in the Advanced page of the Custom List Properties.

User defined 1 Fixed field 1

User defined 2 Fixed field 2

Custom List user defined fields
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Other Fields

The Average of sensor correlation field is the average ratio of "matching” A and B hits for vehiclesin the current

. . O
time step. Perfect datawill have avalue of one. S
The Normalise divisor field can be used in the Virtual Day and Week to show the number of times a particular hour %
of the day (or day of the week) contributed to the virtualised totals and statistics. C

(]

R (- P

& Other fields oooo0 7 AB 1.000 360 ()

% 38 - Awerage of sensor correlation [Rho] o000 7 EBA 1.000 47z °

% 46 - Momnalise divisar [-/n] 0100 7 AE 1.000 202 o

% 10 - Direction code [Dir] olod 7 BA 1.000 313 =
0z00 7 AB 1.000 143
0z00 7 BA 1.000 243

Custom List Other fields

The Direction code field can be used with the Split directions formatting option where each time step is split into two
rows (A>B and B>A). The text shown for each direction can be overridden in the Advanced page of the Custom List
properties.

AB AR BA B Diection codes

Custom List direction codes

Vehicle Parameter Fields

The Vehicle Parameter fields are used with the Emit every vehicle formatting option. Refer to the Individual Vehicle
report for a definition of each field.

= Vehicle parameter fields Date-Time DS Index Ht Speed Whase  Hdwy Gap Aix Gp Rho Hm C1 Vehicle Pic
47 - Dataset [DS) 2007-07-12 14:12:48 2 10747 12 78.9 15.1 9.7 9.6 6 3 1.00 20 10 o oo 200
&, 48 - Wohicla inde [Inde] 2007-07-12 14:12:49 4 9268 4 58.4 6.3 2.1 2.0 2z 2 l.00 20 40 a
3, 43 Total bits in vehicke [HY] 2007-07-12 14:12:50 5 5928 4 78.9 2.4 L9 L8 2z 2 l.00 20 zoo
%, 50 - Vehivls speed [Spesd] 2007-07-12 14:12:51 3 7292 8 B3.2 10,2 148 147 4 3 L.00 20 Bo o 00
& 51 -Vehicke wheebase fwbase]  2007-07-12 14:l2:52 2 10759 4 73.0 2.6 3.5 2.8 2 2 L.00 20 zZoo
& 52 -Vehicle haadnay [Hdws] 2007-07-12 14:12:52 3 7300 4 82,0 2.9 L3 0.9 z 2 l.00 20 zoo
53 Vihicls g [Gap] 2007-07-12 14:12:52 4 9272 4 59.2 2.9 3.8 34 2z 2 L.00 20 zoo
& 54-ehide aves 4] 2007-07-12 14:12:53 5 5932 4 77.7 2.8 3.0 2.9 2z 2 l.00 20 zoo
5, 5 - Vahile e groups [5¢] 2007-07-12 14:12:53 2 10763 4 76.2 2.8 L0 0.9 2z 2 l.00 20 zoo
2007-07-12 14:12:53 3 7304 4 85.0 2.9 0.8 0.6 2z 2 l.00 20 zoo
& 96 - Axle conelation [Rha] 2007-07-12 14:12:54 4 9276 12 57.7 148 1.8 1.6 6 3 L.00 20100 oo oo
% 57 - Debug parameter [N 2007-07-12 14:12:56 2 10767 4 7L.6 2.6 2.1 2.0 2z 2 1.00 20 200
%, 58 -Vehicle picturs [Vehiole Picl — 2007-07-12 14:12:56 2 10771 4 78.4 2.8 1.2 L.l 2 2 1.00 20 zoo
% 53 -Vehicle class [CI] 2007-07-12 14:12:56 3 7308 4 79.3 2.5 3.3 3.2 2z 2 L.00 20 zZooao

Custom List Vehicle Parameter Fields
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Custom List Chart
Split Window

The Custom List report is a dual-pane split report, with atime-based chart on the right where fields included in the
report can be optionally plotted. The entire time range of dataisincluded in the chart, with the time step asthe
integration time.

Like dual-pane graphical reports, the left pane is the primary pane, with access to the report's Local Profile, datasets
and Custom List Properties via the right-click menu.

& MCReport - [CustomList-38] : 3
File Edit Wiew Graph Tools Window Help
| HSR B IFup | nERENSA ~c20Ec0 |

J Files 1 CustomList-35
 T—

AT N P

[- =]

20,007

& [ rime Torar ws @s ms ome @s 0 Default
1 2 E} 4 s 5 {
=2 | 55—z PR — = < CustomList-38 (Metric) Site: GFF Tunnel Eastbound 1E GFF Tunnel Eastbound.2E GFF Tunnel Westbound. 1 GFF Tunf
ae | oreo  ssz o see " 5 2 N Description: Multiple sites - See Header sheet for site descriptions. :
B | ozae 211 3 29t M M 2 M Filter tirne: 00:00 Friday, 13 July 2007 =» 00:00 Friday, 20 July 2007
£ 0200 222 1 Filter: Cl1 23456 789 10 11 12 13 ) DigNES) Sp(, 200) He adwayr>0)
G oaon 717 Recalculate & Scheme: Vehicle classification (ARX)
o500 1789 § .
000 4587 Local profile... 2 B Mean] Average speed
g;gg i:ij Datasets... .1: [ [Mean] Mean Exceeding
soon seme vt B vmaq Maximum speed
Tooo  s1o4 Properties I B rmin] Minimum speed
1100 5116 [
1200 5251 Cut 9 <00:00 Friday, 13 July 2007 (Day)
1300 5377 10
len 5708 Copy o 200.0
1500 s206 H 180,07
100 £se9 Paste 0 150,01 , i A b .
1700 £517 1 A IK( |"' . J"u\ A"U - i
1300 5000 Page setup.. ° 1400 L/U{\f s A i lV\ /J\
. il ¥ .
1500 930 o = 1200 Ut [l LAY w[
zooo  zzvo Typeface 1 = 100.0] \
2100 zsa? 1 R S
Page bresk : s e A N e S
2700 1151 ) &0.00- ’\ g™ f\w e { o e
07-18 70073 Telo &5 a0.00- rf I8 | JA Jr ! \ i
06-22 82673 186 77488 746 3130 402 96 M I Wi i V] .
W A IV L L T R R I
T T T T T T 1

m |

0E-00  85E77 183 80436 785 3161 413 ag
00-00 89841 212 84362 772 3265 450 108

.00
s 0000 Fri 0000 Sst 0000 Sun 0000 Mon 0000 Tue  ODDOWed 0000 Thu 0000 Fri
In profile Uehicles = 591214 / 521003 (92.23% 43-Jul 14dul 15-Jul 48-Jul 47-dul 18-Jul A9-Jul 20-Jul
4 m (2 Time

Custom List Chart

To print or save the Custom List chart it must first be activated by clicking anywhere within its pane. The blue
MetroCount bar indicates the active pane, which print and save operations relate to. The usual graph rendering and
scaling properties can be changed via the Graph menu in MCReport's main menu.
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Selecting Fields

The check box next to each selected field in the Custom List report's Propertiesis used to include the field in the
Custom List chart. Fields with a cross in the check box cannot be plotted.

Custom List Properties .& Q

Fields | Advanced | #ML

@ Time and date fields

@ Count and sub-count fields
[ Class bin fields

@0 Speed bin fields

3 Separation bin fields

@ Speed limit fields

[ Speed statistics fields

[ Mass and axle loading fields
2 Formatting fields

3 Other hields

@ Vehicle parameter fields

o
=
o
o
=
r
=
Py
)
©
o
=t

Selected fields [dhag o change order)
Selected Fislds

- 24-hour time (0000 - 2358) [Time]
- Number in lime step [Total]
- Class totals [Cls]

2% - Average speed [Mean]

E9 - Mean Exceeding [Mean]
- Maximum speed [Vmax]
- Minimum speed [Vmin]

Selecting fields to plot

All selected fields are plotted on one vertical axis, so for best results, only select fields with asimilar range in values.
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Overview

Events

Event Count reports are used to analyse simple "count” data, typically collected using single axle sensors or vehicle
sensors, such as loops. Event Count reports support time-stamped datasets, and binned datasets from RSUs that have
a binned-count mode.
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Example sensor layouts for typical "count" data

The definition of an event is known as the Count Method, which is set via an Event Count report's Local Profile. The
Count Method can be a combination of raw counts, counts with a division factor, or gaps for time-stamped data.

The two inputs (A and B) from each dataset included in an Event Count report can independently contribute to the
totals by adding, subtracting or excluding them. Thisis known as the Input Contribution. For example, given the
Split sensor layout shown below using tubes, counts for the two lanes can be derived from the B input for the left
lane, and A - B for theright line.

Example Split mode Sensor Layout

Note that since events can be subtracted via the Input Contribution, this can result in negative totals. The meaning of
a negative number is entirely application dependent. For example, the net flow at a point could be reported by adding
inward inputs, and subtracting outward inputs.
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Generating an Event Count Report

Report Wizard

Event Count reports are grouped into a separate page at the top of the Report Vortex. Reports are then divided into
the usual sub-groups of tables, charts and special formats.

The Local Profile for an Event Count report uses the Scheme button to set the desired Count Method, with all the
vehicle filter settings disabled. The Advanced Profile options contain all the usual report formatting options, with the
vehicle-related options removed.
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The Input Contribution for each of the tagged datasets is displayed as an extra step in the Report Wizard after the
Local Profile. A separate page appears at the top for each of the tagged datasets.

W hapon Toeronth,
[ 1ie 1 i g Tl et
@8 Bl2sunnenansa~ra0as0

| Dl ® =

\View reporf]

Report Wizard for Event Count reports
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Count Method

To set the Count Method for an Event Count report, click the Scheme button in the report's Local Profile, and select
one of the optionsin the Event Count Method drop-down list at the bottom.

| [ Genersl | Fomat [ Header | Colors | Scheme | Speed | Mass | Separation | Adust]

|| Class scheme Class scheme description

ED"' DEM schemes Scheme ARX is a modification of AustRoads34. It removes class 12,
% AR + mowes all other classes up by one, and ingerts a short two-asle class az
-8, Scheme F + class one.
o B SchemeF2+
B, Scheme F99 +
o B Austfioadsdd +

Vehicle and report settings

“ehicle filkering and report settings are here...

m
<
D
=)
3
2
o
C
=)
=1
>
>
)
<
3,
(2}

Name [Default Frofls o gmds_ﬂ:*
Sheed [iotused 2 e, [ sgaregate the selected class scheme
pee: ok uzed in event count reports wedish? +
3 —

Separation [Not used in svent count reparts By Soheme Axle

{3 Extemal schemes

Ditection [Not used in event count reparts

Classes Mot used in event count reparts

Scheme |Count events divided by setup divisor

e — b

ime
[ From 12:55 Monday, 14 July 2008 ta 07:15 Tuesday. 9 Decemb

|Event count method

Disable filter

Count each event
Count events divided by bwo
Coaunt events divided by comman divisor

Count gaps above 5 specified length
=% Count following gaps

Setting the Count Scheme for an Event Count report

The default Count Method is Count events divided by setup divisor, which automatically sets a division factor based
on the Sensor Layout used for each dataset - divide-by-one for vehicle sensors (loops), and divide-by-two for axle
sensors (tubes and piezos). This alows data from different sources to be combined in a single report.

Count events divided by channel divisor uses a custom divisor for each dataset included in an Event Count report.
The divisors are specified in the Input Contribution dialog box.

Count each event, Count events divided by two and Count events divided by common divisor apply the same
division factor to all datasets. The common divisor is specified immediately below the Event Count Method.

Counting gaps can be used with time-stamped data. Gaps above the specified length are divided by the specified gap
and the total added to the event count at the start of the gap. This can be further qualified by specifying a start gap,
usually longer than the specified following gap, for examining entering capacity.

The Interpolate binned data option relates to Event Count reports with a bin size smaller than the bin size of a
binned dataset. Take for example a binned dataset with hourly bins, and an Event Count report with five-minute bins.
With this option on, the hourly binswill be evenly distributed across the five-minute bins. With this option disabled,
the hourly counts will appear in the first five-minute bin.
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Input Contribution

The Input Contribution dialog box is used to set how each of the inputs (A and B) for each of the tagged datasets are
combined in an Event Count report. Each tagged dataset is presented in a separate page at the top.

Input contributions from tagged datasets k- ﬁ

Nartows Loop South | Narows Loop South | Nanows Loop South |

Site Mame  Marrows Loop South

Attibute  [-31.966908 +115.846505]

Datarange 08:00 Friday, 12 December 2008 to 17:32 Tuesday, 31 March 2009

Description Marrows Bridge South

Lapout ehicle sensors - Separate [Count]

DataFile  File: D:\SWNProjects\MCS8004nkAD atabM arows\Narows Loop South31Mar2003.ECT

Input & = 3 - South bound, Lane 1 Input B = 3 - South bound. Lane 2
() Ignore & () lgnore B
(@ Add A events @ Add B events

() Sublract & evenls () Sublract B events

Channel divisor 1.000

l Restore to setup ] [ Copy to all ]

Setting Input Contribution for an Event Count report

Each input can be added, subtracted or ignored from an Event Count report. A separate tally is kept for each Lane
number specified in each dataset.

The default Input Contribution for a dataset depends on the Sensor Layout used. For vehicle sensors, the default
contribution isto add all inputs. For axle sensors, the default contribution is the A input only, which is given by Add
A and Ignore B. For a split layout, the contribution will default to "Add A" and "Subtract B", which givesthe
secondary lane.

The Channel divisor is used with the Count events divided by channel divisor Count Method, to set a unique divisor
for each dataset.

The Input Contribution for an existing Event Count report can be changed by right-clicking on the report, and
selecting Datasets to display the File Management List. Click the Inputs button at the bottom to change the Input
Contribution.

7
Martows Loop South | Narraws Loop South | Nanows Loop South |

Site Mame  Marmows Loop South

Aftibute  [-31.96E308 +115.846506)

Datarange 08:00 Friday, 12 December 2008 to 17:32 Tuesday. 31 March 2009

Description Marraws Bridge South

Layout Wehicle sensars - Separate [Count)

DataFile  File: D:ASYNProjects\MCS8004unkAD atabM arows\Narows Loop South31Mar2003.ECT

Input & = 3 - South bound. Lane 1 Input B = 3 - South bound. Lane 2
) lgnore A ) lanore B
(@ Add A events ) Add B events

() Sublract & events (7 Subtract B events

Chanrel divisor 1.000

[ Restore ta setup ] [ Copy ta all ]

Setting Input Contribution for an Event Count report
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Event Count Reports
Tables and Charts

M CReport's Event Count reports are divided into Tables, Charts and Special formats. The Weekly Event Counts,
Event Counts and Event Flow reports are similar to their corresponding classification reports. The Special reports
emulate several "standard" report formats.

Note that the Event Flow report can show multiple traces the grand total of events, aswell asindividual lanes counts
and the A and B totals. To change the included totals, right-click the report, select Properties.

[Tl
<
o
S
=
Q)
(]
c
=
=L
>
5
o
<
28
o

mmaon  [EventFlow 61 TR

File Edit View Graph Tools Mindow Help
HER(Eaxn® AN REDEA|# ¢+ O M
J I Files 1 | ® EventFlow-61

MetroCount

[ shaw grand katal
Show lane counts
[ Show & total
EventFlow-81 (Metrie) Site:Narroms Loop South 128 Nartows Losp Seuth 248 Narrows Loag| | 0w B total

S0 | Desoription: Multiple Sites - See Header sheet far site desoriptions
Filter time: 05:00 Friday, 12 December 2008 => 17:40 Tuesday, 31

Event Flow

Recalculate
Scheme: Count svents divided by setup divisor Local profile...

WLane=1 WLans-z [ Datasets...

WLane=s [Lane=s Properties
< 00:00 Monday, 16 March 2009 (D ay) Copy

7 o . age setupe.

3 1600 v -
w 1400 i

£ 1200 ¥ | i )/ ﬁ i
3 1000
= TR . b\ 1
cR N il R L 1) &Jff h\fﬁﬂ@“ A
£ a0 5

g 203 i QJJ ’\& N
o i T T T T T T

0000 Men 0000 Tus 0000 Wed 0000 Thu 0000 Fi 0000 Sat 0000 Sun 0000 Men !
17-Mar 18-Mar 19-Mar_ 20-Mar ZlMar  22Mar
Time

Event Flow report showing all lanes
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Event List Report

The Event List report is atabular format that bins events, and is useful for exporting event data. The report includes a
row for each bin or time step, which can range from five minutes to 24 hours.

Time step for rows ? ?
(1] O Friday, 12 Decemhegl][ls ?
1

T 1
z008-12-12,08: 00,15, 1142, 629, 513,

T 1
[¥] Include day headings € a, 133, 133, 278, 311, 218, 3
|nclude MetroCount Headsr 2008-12-12,08: 18,15, 1346, 763, 577, o, 156, 238, 262, 332, 341, 7
s i e =) 2008-12-12,08: 30,15, 1351, 785, 566, o, 171, 224, 275, 338, 329, 7
2008-12-12,08: 45,15, 1305, 786, 543, a, 177, 217, 285, zz8, 324, 7
Ineude arand total @) zo0g-12-1%,09: 00,15, 1133, 672, szl, a, 137, z11, za3, 304, zaz, &
Include lane counts@ Z00G-12-12,09:15,15, 1185, 694, 431, o, 170, 151, z4z, 294, zsz, &
Include /8 totals @ 2008-12-12,09: 30,15, 1176, 875, 5L, o, laz, 138, 244, 310, 2839, 3
[ Qutput numbers as decimal 2008-12-12,09: 45,15, 1228, 71s, 513, o, l4s, 182, 256, 327, 31z, 4
z008-12-12,10: 00,15, 1168, 641, szg, a, 128, 138, 237, zzz, 278, 5
Field delimiter sample 2008-12-1%,10: 15,15, 1197, 665, 532, o, 1z8, 213, 250, 316, 287, E
2008-12-12,10: 30,15 1268 745 523 o 157 190 230 330 238 3

0000,0001,0002.0003, . e 4 4 4 . - - - - .
Ehange. 2008-12-1Z,10: 45,15, 1213, &3z, 5zl1, a, 158, 204, 285, 31z, z79, 5

Event List report format

The Include day headings option breaks the time steps into 24-hour blocks by inserting the date. The Include column
for interval option displays the time step length in minutes.

Columns for the event count grand total, individual lane counts, and A and B totals can be optionally included.

The Event List report also has optional field delimiters, which can be set by clicking the Change button. The default
is to separate columns with a comma.

The Event List formatting options are displayed at the end of the Report Wizard. These options can be accessed at
any time by right-clicking on the Event List report, and selecting Properties.
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ARX

ARX isamodification of AustRoads94. It removes class 12, moves al other classes up by one, and inserts acycle classasclass 1.

« Units: Metric (m)

« Car class: 2
« Unclassifiable vehicle class: 13
- Dominant
Axles |Groups Description Class Parameters . Aggregate
Vehicle
Very Short - Bicycle or
2 lor2 Motorcycle MC 1 d(1)<1.7m & axles=2 &
Short - Sedan, Wagon, 4WD, d(1)>=1.7m, d(1)<=3.2m &
2 |lor2 Utility, Light Van V| 2 axles=2 = 1 (Light)
P groups=3, d(1)>=2.1m,
3ol 3 Stort Towing- Trallen syt | 3 | d@)<=32m, d@2)>=21m & @
' L axles=3,4,5
2 2 Two axle truck or Bus TB2 4 d(1)>3.2m & axles=2 4=
3 2 Three axle truck or Bus TB3 5 axles=3 & groups=2 2= 2 (Medium)
>3 2 Four axle truck T4 6 axles>3 & groups=2 &
Three axle articulated vehicle d(1)>3.2m, axles=3 & ,
3 3 or Rigid vehicle and trailer ART3| 7 groups=3
Four axle articulated vehicle or d(2)<2.1m or d(1)<2.1m or
4 >2 Ricid vehicle and trailer | ART4| 8 d(1)>3.2m 1=
9 axles=4 & groups>2
Five axle articulated vehicle or d(2)<2.1m or d(1)<2.1m or
5 | *2 | “Rigidvehideandtraler | ART2| 9 d(1)>3.2m o=
axles=5 & groups>2
Six (or more) axle articulated 3 (Heawy)
X icu
>=6 | >2 | vehideor Rigidvehideand |ART6| 10 |XI&6& groups>2oraxles>6)
) & groups=3
trailer
>6 4 B-Double Oir';if;';'y truck and BD 11 groups=4 & axles>6 B
Double or triple road train or
>6 >=5 | Heavy truck and two (or more) | DRT 12 groups>=5 & axles>6 ===
trailers
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Scheme F

Scheme F is an implementation of the FHWA's visua classification scheme as an axle-based classification scheme. Thisis one of
severa interpretations.

« Units: Non-metric (ft)
» (Carclass: 2
« Unclassifiable vehicle class: 14

Axles |Class Description SP1 SP2 SP3 SP4 SP5 Aggregate
F1 motorcycle <6.0 1 (Light)
F2 passenger car or light pickup 6.0-10.0 1
2 F3 heavy pickup 10.0-15.0 1
F5 two-axle truck 15.0- 20.0 2 (Medium)
Fa bus >20.0 2
F2 car with trailer <10.0 10.0-18.0 1
F3 pickup with trailer 10.0-15.0 | 10.0-18.0 1
3 F4 bus >19.0 2
F8 251 >18.0 3 (Heavy)
F6 three-axle truck 2
F2 car with trailer <10.0 <35 1
F3 pickup with trailer 10.0-15.0 <35 1
4 F8 232 >5.0 >35 3
F8 331 <5.0 >10.0 3
F7 four-axle truck 2
F11 251-2 >6.0 3
F9 332 <6.1 35-8.0 3
5 F3 pickup with trailer 9.9-15.0 <35 1
F5 two-axle truck with trailer 14.9-20.0 <35 2
F9 five-axle combination 3
F10 six-axle combination 35-5.0 3
6 | F12 3S1-2 >10.0 3
F10 3s3 3
=7 || o ade s
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Scheme F2

Scheme F2 is an implementation of the FHWA's visual classification scheme as an axle-based classification scheme. Thisis one of
severa interpretations.

« Units: Non-metric (ft)

» (Carclass: 2

« Unclassifiable vehicle class: 14

Class | Type | Axles SP1 SP2 SP3 SP4 SP5 SP6 SP7 SP8 Aggregate
1 F1 2 1.0-6.0
2 6.0-10.2
2 F2 3 6.0-10.2 | 6.0-18.0
4 | 6.0-10.2 | 6.0-180 | 0.0-6.0 1 (Light)
2 10.2-13.0
3 F3 3 10.2-13.0 | 6.0-18.0
4 10.2-13.0 | 6.0-18.0 | 0.0-6.0
4 Fa 2 20.0-40.0
3 20.0-40.0 | 0.0-6.0
5 F5 2 13.0-20.0
6 F6 3 6.0-23.0 0.0-6.0 (Megium)
4 6.0-23.0 | 0.0-9.0 0.0-9.0
7 F7 5 6.0-17.0 0.0-6.0 0.0-6.0 0.0-6.0
6 6.0-17.0 | 0.0-6.0 0.0-6.0 0.0-6.0 0.0-6.0
3 6.0-17.0 | 14.0-40.0
8 F8 4 6.0-20.0 | 0.0-6.0 | 6.0-40.0
4 6.1-17.0 | 14.0-40.0 | 0.0-6.1
9 Fo 5 6.0-22.0 | 0.0-6.0 | 6.0-40.0 | 0.0-125
5 6.0-22.0 | 0.0-6.0 | 6.0-23.0 | 1.1-23.0
3 (Heavy)
10 F10 6 6.0-22.0 | 0.0-6.0 | 0.0-40.0 | 0.0-11.0 | 0.0-11.0
7 6.0-22.0 | 0.0-6.0 | 0.0-40.0 | 0.0-13.0 | 0.0-13.0 | 0.0-13.0
11 F11 5 6.0-17.0 | 11.0-25.0 | 6.0-18.0 | 11.0-25.0
12 F12 6 6.0-22.0 0.0-6.0 1.0-25.0 | 6.0-18.0 | 11.0-25.0
13 F13 7-9 0.0-40.0 | 0.0-40.0 | 0.0-40.0 | 0.0-40.0 | 0.0-40.0 | 0.0-40.0 | 0.0-40.0 | 0.0-40.0
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Scheme F99

@)
Scheme F99 is the decision trees described in Truck Characteristics Analysis, FHWA July 1999 with all redundancy removed. =
Note motorcycles have been restored. 2
« Units: Non-metric (ft) 8
« Car class: 2 S
« Unclassifiable vehicle class: 14 =@
=0
(¢}
Class | Type | Axles SP1 SP2 SP3 SP4 SP5 Aggregate CBD
1 F1 2 0.00-6.00 ®
2 F2 2 0.00-9.90
2 .
3 1 (Light)
3 F3
4 11.40-50.00
4 0.00-22.00
4 F4 3 0.00-5.80
2 12.10-50.00
5 F5 )
5 9.90-31.70 2 (Medium)
3 0.00-18.80 0.00-5.80
6 F6
5 0.00-3.50
3 20.90-50.00
4 24.70-50.00
8 F8
4 12.60-50.00
4
5 9.90-50.00
9 F9 = 3 (Heavy)
10 F10 6 0.00-12.70
11 F11 5 9.90-40.00 11.80-50.00
12 F12 6
13 F13 7-20
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AustRoads94

Austroadso4 replaced NAASRA in Australiain 1994. It is an improved system using information from the spacings of the first
three axles, the total number of axles and the number of axle groups. There are 13 classes.

« Units: Metric (m)

« Carclass: 1
« Unclassifiable vehicle class: 13
- Dominant
Axles |Groups Description Class Parameters . Aggregate
Vehicle
Short - Sedan, Wagon, 4WD, d(1)>=1.7m, d(1)<=3.2m &
2 |lor2 Utility, Light Van V|1 axles=2 =
L groups=3, d(1)>=2.1m, 1(Light)
3ol 3 StortTowing - Trailer, syt | 2 | d@)<=32m, d2)>=21m & S
' L axles=3,4,5
2 2 Two axletruck or Bus TB2 3 d(1)>3.2m & axles=2 EE|
3 2 Three axle truck or Bus TB3 4 axles=3 & groups=2 = =] 2 (Medium)
>3 2 Four axle truck T4 5 axles>3 & groups=2 Bow
Three axle articulated vehicle d(1)>3.2m, axles=3 & 2
3 s or Rigid vehicle and trailer ART3| 6 groups=3
Four axle articulated vehicle or d(2)<2.1m or d(1)<2.1m or
4 >2 Rigid vehicle and trailer ART4| 7 d(1)>3.2m =
axles=4 & groups>2
Five axle articulated vehicle or d(2)<2.1m or d(1)<2.1m or
5 >2 Rigid vehicle and trailer ART5| 8 d(2)>3.2m =
axles=5 & groups>2
Six (or more) axle articulated
>=6 | >2 | vehicleor Rigidvehicleand |ARTG| o |PIeS0&OOPS2oradesss) g 3 (Heavy)
4 groups=3
trailer
B-Double
>6 4 B-Double or Heavy truck and | BD 10 groups=4 & axles>6 =
trailer
Double road train or Heavy
>6 |[50r6 truck and two trailers DRT | 11 groups=5 or 6 & axles>6 ===
Tripleroad train or Heavy
>6 >6 truck and three trailers TRT 12 groups>6 & axles>6 =
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NAASRA

NAASRA was used in Australia until 1994. It is a system classifying according to the total number of axles, the number of axle ch_))
groups and vehicle wheelbase. There are 13 classes. &
« Units: Metric (m) 8
« Carclass: 1 S
« Unclassifiable vehicle class: 13 =@
=0
Class Description Axles Wheelbase %
S2 1 Car 2 0-30 @
M345 2 Car + trailer 3-5 30-75
M2 3 Medium length 2 axle 2 30-75
M3 4 Medium length 3 axle 3 30-75
M4 5 Medium length 4 axle 4 30-75
L3 6 Long length 3 axle 3 75-185
L4 7 Long length 4 axle 4 75-185
L5 8 Long length 5 axle 5 75-185
L6 9 Long length 6 axle 6 75-185
L78 10 Long length 7 or 8 axle 7-8 75-185
Mc 11 Medium combination 5-11 18.5-34.0
Lc 12 Long combination 6-19 >34.0

©2013 MetroCount® - - MTE User Manual 151



TNZ 1999

o
TNZ 1999 is a scheme developed by Transit New Zealand. It has 14 classes. =
« Units: Metric (m) %
+ Carclass: 1 L
« Unclassifiable vehicle class: 14 S
9]
Q
Class | Axles Vehicle Types SP1 SP2 SP3 SP4 Aggregate =
1 2 0-0 (short) <32 5
- 1(Car &
5 3 0-0-0 (short towing) <32 LCV)
4 0-0-00 (short towing) 22-32 <10
3 2 0--0 (long) >3.2 2 (MCV)
4 3 0-00 >32 <22
5 3 0-0--0 >3.2 >22
6 4 00--00 <22 3(HCV])
0--0-0--0
7 4 >22 >1.0
0-0--00
0--00-0--0
8 5
0-00--00
9 6 0-00--000 >22 <14
10 6 0-00-0--00 >22 >14
0-00--00--00 (B-train)
11 7 0--00-00--00 (T & T) >22
0-00--00-0--0 (A-train)
4 (HCV2)
00--00-0--0
12 | 6-8 00--00-0--00 <22
00--00-00--00
0-00--000-00 (B-train)
0-00-000-0--0 (A-train)
13 89 i >22
0-00-00-0--00 (A-train)
0-00--000--000 (B-train)
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Scheme Axle

Simply the number of axlesin the vehicle.
« Units: Metric (m)
« Car class: 2
« Unclassifiable vehicle class: 12

Class

Axles

Aggregate

[N

[N

1

Ol O(N| OO B WIN

Ol O(N| OO B WIN

Ol O[NNI WIN

=
o

=
o

=
o

=
[

>10

=
[
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Vagverket

* Units: Metric (m)

» (Carclass: 2

« Unclassifiable vehicle class: 15

Class Type Axles SP1 SP2 SP3 SP4 SP5 SP6 Aggregate
1 MC 2 0.8-18 1(MC)
2 P20 2 1.8-33
3 P21 3 1.8-33 1.8-6.0 2(P)
4 P22 4 18-33 1.8-6.0 0.0-6.0
5 L20 2 3.3-105
6 L21 3 33-105 | 1.8-105
7 Loo 4 33-105 | 3.3-105 0.8-3.3

4 33-105 | 18-105 | 33-105
5 1.8-6.0 3.3-105 0.8-1.8 0.8-3.3
8 L23 5 33-105 | 18-105| 1.8-105 | 08-33
5 33-105 | 33-105 | 08-18 | 3.3-105
9 L2a 6 33-105 | 33-105| 0.8-18 | 1.8-105 | 08-33
6 33-105 | 33-105 | 6.0-105 | 08-18 0.8-33 3(L)
10 L30 3 1.8-105 0.8-18
11 L31 4 1.8-6.0 0.8-18 3.3-105
12 L32 5 1.8-6.0 0.8-18 33-105 | 0.8-105
6 18-6.0 08-18 | 3.3-105 | 08-18 0.8-33
13 L33 6 1.8-6.0 0.8-18 33-105 | 1.8-105 0.8-3.3
6 18-6.0 08-18 | 33-105 | 08-18 | 3.3-105
14 L34 7 1.8-6.0 0.8-18 3.3-105 0.8-1.8 1.8-10.5 0.8-3.3
7 18-6.0 08-18 | 33-105 | 1.8-105 | 0.8-18 0.8-33
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Arkansas F99

@)
Thisisvery similar to Scheme F99. The boundary between F3 and F5 has been changed. =
« Units: Non-metric (ft) %
+ Carclass: 2 L
« Unclassifiable vehicle class: 14 S
%)
Q
Class Type Axles SP1 SP2 SP3 SP4 SP5 Aggregate =
1 F1 2 0.00 - 6.00 3
2 F2 2 0.00-9.90
2 .
3 1 (Light)
3 F3
4 11.40 - 50.00
4 0.00- 22.00
4 F4 3 0.00-5.80
2 12.60 - 50.00
5 F5 )
5 9.90 - 31.70 2 (Medium)
3 0.00-18.80 0.00-5.80
6 F6
5 0.00-3.50
3 20.90 - 50.00
4 24.70 - 50.00
8 F8
4 12.60 - 50.00
4
5 9.90 - 50.00
9 F9 z 3 (Heavy)
10 F10 6 0.00-12.70
11 F11 5 9.90 - 40.00 11.80 - 50.00
12 F12 6
13 F13 7-20
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ARX Cycle

@)
ARX with cycle class. &
« Units: Metric (m) %
+ Carclass: 3 L
« Unclassifiable vehicle class: 14 S
7))
(@]
Class Type Axles Grps SP1 SP2 Aggregate =
1 CYCLE 2 1-2 00-115 3
2 MC 2 1-2 1.15-17 _
1 (Light)
3 SV 2 1-2 17-32
4 SVT 3-5 3 21-32 2.1-50.0
5 B2 2 3.2-50.0
6 TB3 3 2 2 (Medium)
7 T4 4-20 2
8 ART3 3 3 3.2-50.0
4 3-4 0.0-21
9 ART4 4 3-4 00-21
4 3-4 3.2-500
5 3-5 0.0-21
10 ART5 5 3-5 00-21
3 (Heavy)
5 3-5 3.2-50.0
6 2-6
11 ART6
6-20 3
12 BD 7-20 4
7-20 5-6
13 DRT
7-20 7-20
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Chelsea

Custom scheme for Daimler-Chrysler. %CT)
« Units: Non-metric (ft) %.
« Carclass: 1 9
+ Unclassifiable vehicle class: 4 i
Class Type Axles SP1 %
1 C 2 0.00- 9.00 3

2 C 2 9.00 - 10.00

3 C 2 10.00 - 40.00
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DfT-UK

GB DTp National Core Census. %_C’)
« Units: Metric (m) %
+ Carclass: 3 o
« Unclassifiable vehicle class: 12 i

Class Type Axles SP1 SP2 SP3 SP4 SP5 >
1 C > 0.00- 1.06 3
2 (@] 2 1.06 - 1.70

2 1.70- 2.64
3 CAR 3 1.89-2.95 1.90-4.00
3 1.89-2.95 3.50-6.00
4 1.89-2.95 1.90- 6.00 0.50-1.30
4 LGV 2 2.64-3.75
5 R2 2 3.75-6.00
6 R3 3 2.00-6.00 1.00-1.90
3 1.00- 1.88 2.00-12.00
4 1.00- 1.90 2.00-12.00 1.00-1.90
! Ra 4 3.00-9.00 1.00- 2.50 1.00- 2.50
3 2.95-9.20 1.90-4.00
3 1.89 - 3.99 3.50-15.00
8 A3 4 2.95-12.00 2.00-12.00 2.50-12.00
4 2.95-9.20 2.50-9.00 0.50- 250
4 1.89 - 3.99 3.50-15.00 1.05-2.50
4 1.89 - 2.95 3.50-6.00 1.05-1.30
9 A4 4 1.00- 1.90 1.90 - 12.00 2.00-15.00
4 1.70-5.25 1.00-1.90 2.00 - 15.00
5 2.00-12.00 1.00 - 12.00 2.00-12.00 1.00-1.90
5 2.00-12.00 1.00-1.90 1.90 - 12.00 2.50-12.00
5 1.70-5.25 1.00-1.90 2.00 - 15.00 1.00 - 2.50
5 1.00- 1.90 1.90 - 12.00 2.00 - 15.00 1.00- 2.50
10 AS* 5 2.00-12.00 2.00-15.00 0.70-1.80 0.70-1.80
6 2.00-12.00 1.00-1.90 1.90 - 12.00 2.00-12.00 1.00-1.90
6 1.90-5.25 1.00-1.90 2.00-15.00 1.00-1.90 1.00-1.90
7-20
1 BUS 2 6.00-12.00
3 6.00-12.00 1.00-1.90
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Euro13

* Units: Metric (m)

« Carclass: 1
« Unclassifiable vehicle class: 13
Class Type Axles SP1 SP2 SP3 SP4 SP5 Aggregate
2 1.71-2.99
3 1.89 - 2.96 1.90-4.01
1 EU13-1 .
4 1.89 - 2.96 3.50-6.01 1.05-1.31 1 (Light)
4 1.89 - 2.96 1.90-6.01 050-1.31
2 EU13-2 2 2.99-451
3 EU13-3 3 2.00-7.01 1.00-1.91
4 1.00-1.91 2.00-12.01 1.00-1.91
4 EU13-4
4 3.00-9.01 1.00- 251 1.00- 251
3 2.65-9.21 1.90-4.01
4 2.96-12.01 2.00-12.01 2.50-12.01 2 (Medium)
5 EU13-5
4 2.96-9.21 2.50-9.01 0.50-251
5 2.00-12.01 1.00-12.01 2.00-12.01 1.00-1.91
6 EU13.6 5 2.00-12.01 1.00-1.91 1.90-12.01 2.50-12.01
6 2.00-12.00 1.00-1.90 1.90- 12.00 2.00-12.00 1.00-1.90
7 EU13-7 3 1.89 - 4.00 4,01-15.01
8 EU13-8 4 1.89-4.00 3.50-15.01 1.05-251
9 EU13-9 5 2.00-12.01 2.00-15.01 0.70-1.81 0.70-1.81
4 1.00-1.91 1.90-12.01 2.00-15.01
4 1.70-5.26 1.00-1.91 2.00-15.01
10 |EU13-10 3 (Heavy)
5 1.70-5.26 1.00-1.91 2.00-15.01 1.00-2.51
5 1.00-1.91 1.90-12.01 2.00-15.01 1.00- 251
11 EU13-11 6 1.90-5.25 1.00-1.90 2.00-15.00 1.00-1.90 1.00-1.90
2 451-6.41
12 EU13-12
3 1.00- 1.89 2.00-12.01
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FLDOT

FLDOT Class Scheme

« Units: Non - metric (ft)
» (Carclass: 2
« Unclassifiable vehicle class: 15

Class Type Axles SP1 SP2 SP3 SP4 SP5 SP6 Aggregate
1 MC 2 0.0-6.0
2 6.0-10.0
2 AUTO 3 6.0-10.0 6.0-25.0
4 6.0-10.0 6.0-25.0 0.0-6.0 .
1 (Light)
2 10.0- 133
3 10.0-13.3 | 6.0-25.0
3 RV
4 10.0-13.3 | 6.0-25.0 0.0-6.0
5 10.0-13.3 | 6.0-25.0 0.0-6.0 0.0-6.0
2 23.0-40.0
4 BUS
3 23.0-40.0 0.0-6.0
2 13.3-23.0
3 13.3-23.0 | 6.0-250 i
5 2D 2 (Medium)
4 133-23.0 | 6.0-25.0 0.0-6.0
5 13.3-23.0 | 6.0-250 0.0-6.0 0.0-6.0
6 3AXLE 3 6.0-23.0 0.0-6.0
7 4AXLE 4 6.0-23.0 0.0-6.0 0.0-6.0
3 10.0-23.0 | 11.0-40.0
8 251,21 4 10.0-23.0 | 11.0-40.0 | 2.0-120
4 6.0-23.0 0.0-6.0 6.0-44.0
9 350 5 6.0-26.0 0.0-6.0 6.0-46.0 0.0-11.0
5 6.0-26.0 0.0-6.0 6.0-230 | 11.0-270
6 6.0-26.0 0.0-6.0 0.0-46.0 0.0-11.0 0.0-11.0
10 333,33 3 (Heavy)
7 6.0-16.70 0.0-6.0 13.3-40.0 | 0.0-13.3 0.0-13.3 0.0-133
11 2512 5 6.0-26.0 | 11.0-260 | 6.0-20.0 | 11.0-26.0
12 3512 6 6.0-26.0 0.0-6.0 11.0-26.0 | 6.0-240 | 11.0-26.0
7
13 2523,3522 8
9
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GB_DTp

@)
GB DTp National Core Census. 7
« Units: Metric (m) %
+ Carclass: 3 o
« Unclassifiable vehicle class: 27 S
7]
Q
Class Type Axles SP1 SP2 SP3 SP4 SP5 =
1 DTpC 2 0.0-1.06 3
2 DTpO 2 106-17
3 DTp1 2 1.7-2.64
4 DTp2 2 2.64-3.75
3 1.89-295 35-6.0
5 DTp21 3 1.89-2.95 19-40
4 1.89-295 19-6.0 05-13
6 DTp31 2 3.75-6.0
3 20-6.0 1.0-1.9
7 DTp 32
3 10-1.88 20-120
4 10-19 2.0-120 10-19
8 DTp 33
4 3.0-9.0 10-25 10-25
3 2.95-9.2 1.9-4.0
9 DTp 41 4 295-120 20-12.0 25-120
4 2.95-9.2 25-9.0 05-25
10 DTp 42 5 20-120 1.0-120 20-120 10-19
11 DTp43 5 20-120 10-19 19-120 25-120
12 DTp44 6 2.0-12.0 1.0-1.9 1.9-120 2.0-120 1.0-1.9
13 DTp51 3 1.89-3.99 35-15.0
4 1.89-3.99 35-15.0 1.05-25
14 DTp52
4 1.89-295 35-6.0 105-13
4 10-19 19-120 2.0-15.0
15 DTp53
4 1.7-5.25 1.0-1.9 2.0-15.0
5 1.7-5.25 1.0-1.9 2.0-15.0 1.0-25
16 DTp 54
5 10-19 19-120 20-15.0 10-25
17 DTp55 5 20-120 20-150 0.7-18 0.7-18
18 DTp56 6 19-5.25 10-19 2.0-15.0 10-19 10-19
2 6.0-12.0
19 DTp 61
3 6.0-12.0 1.0-1.9
20 DTp7 7-20
21 DTp 1IN 1
22 DTp 2N 2
23 DTp 3N 3
24 DTp 4N 4
25 DTp5N 5
26 DTp 6N 6
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Norfolk

Scheme similar to ARX, modified for UK.

« Units: Metric (m)
» (Carclass: 2
« Unclassifiable vehicle class: 13

Class Type Axles Grps SP1 SP2

1 MCB 2 0.0-1.75
2 CAR 2 1-2 1.75-3.0
3 LGV 2 1-2 3.0-38
4 STOW 3-5 3 1.75-3.8 1.75-50.0
5 RIGID2 2 2 3.8-50.0
6 RIGID3 3 2
7 RIGID4 4-20 2
8 ARTIC3 3 3 3.8-50.0

4 3-4 0.0-1.75
9 ARTIC4 4 3-4 0.0-1.75

4 3-4 3.8-50.0

5 3-5 0.0-1.75
10 ARTICS5 5 3-5 0.0-1.75

5 3-5 3.8-50.0
11 ARTIC6 6 26

6-20 3

12 BDBL 7-20 4
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Sample ARX

Thisisan example scheme. It isvery similar to ARX. ch_))
« Units: Metric (m) %
+ Carclass: 2 L
« Unclassifiable vehicle class: 13 i

Class Type Axles Grps SP1 SP2 Aggregate ?g
1 MC 2 1-2 00-17 3
2 sV 2 1-2 1.7-32 1 (Light)

3 SVT 3-5 3 21-32 2.1-50.0
4 B2 2 3.2-50.0
5 TB3 3 2 2 (Medium)
6 T4 4-20 2
7 ART3 3 3 3.2-50.0
4 3-4 00-21
8 ART4 4 3-4 0.0-21
4 3-4 3.2-50.0
5 3-5 0.0-21
9 ARTS5 5 3-5 00-21
3 (Heavy)
5 3-5 3.2-500
10 ART6 6 26
6-20 3
11 BD 7-20 4
12 DRT 7-20 >0
7-20 7-20
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Sample AustRoads

Thisis an example scheme. It isvery similar to AustRoads94. é_j
« Units: Metric (m) %\
« Carclass: 1 L
« Unclassifiable vehicle class: 13 i

Class Type Axles Grps SP1 SP2 Aggregate %
1 ARL 2 1-2 00-32 3
2 AR2 3-5 3 21-32 2.1-50.0 1 (Light)

3 AR3 2 3.2-50.0
4 AR4 3 2
5 AR5 4-20 2 2 (Medium)
6 ARG 3 3 3.2-50.0

4 3-4 00-21
7 AR7 4 3-4 00-21

4 3-4 3.2-50.0

5 3-5 00-21
8 ARS8 5 3-5 00-21

5 3-5 3.2-50.0 3 (Heavy)
9 AR9 6 26

6-20 3

10 AR10 7-20 4
11 AR11 7-20 5-6
12 AR12 7-20 7-20
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Sample F2

Thisis an example scheme. It is very similar to Scheme F2. gc_?
« Units: Non - metric (ft) %
+ Carclass: 2 L
« Unclassifiable vehicle class: 14 i
Class | Type | Axles SP1 SP2 SP3 SP4 SP5 SP6 Aggregate %

1 F1 2 | 10-60 3
2 6.0-10.2

2 F2 3 6.0-10.2 6.0-18.0
4 6.0-10.2 6.0-18.0 0.0-6.0 1(Light)
2 10.2-13.0

3 F3 3 10.2-130 | 6.0-18.0
4 10.2-13.0 6.0-18.0 0.0-6.0

4 F4 2 20.0- 40.0
3 20.0-40.0 0.0-6.0

5 F5 2 13.0-20.0

6 F6 3 6.0-23.0 0.0-6.0 2 (Medium)
4 6.0-23.0 0.0-90 0.0-90

7 F7 5 6.0-17.0 0.0-6.0 0.0-6.0 0.0-6.0
6 6.0-17.0 0.0-6.0 0.0-6.0 0.0-6.0 0.0-6.0
3 6.0-17.0 14.0-40.0

8 F8 4 6.0-20.0 0.0-6.0 6.0-40.0
4 6.1-17.0 14.0-40.0 0.0-6.1
5 6.0-22.0 0.0-6.0 6.0-40.0 0.0-1250

o R 5 6.0-22.0 0.0-6.0 6.0-23.0 11-230

3 (Heavy)

6 6.0-22.0 0.0-6.0 0.0-11.0 0.0-11.0

10 F10 7 6.0- 220 0.0-6.0 0.0-13.0 0.0-13.0 0.0-13.0

11 F11 5 6.0-17.0 11.0-25.0 6.0-18.0 11.0-25.0

12 F12 6 6.0-22.0 0.0-6.0 1.0-250 6.0- 18.0 11.0-25.0

13 F13 7-9
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Sample F3

This very similar to Scheme F2. Class 11 has been changed. gc_?
« Units: Non - metric (ft) %
+ Carclass: 2 L
« Unclassifiable vehicle class: 14 i
Class | Type | Axles SP1 SP2 SP3 SP4 SP5 SP6 Aggregate %

1 F1 2 10-60 3
2 6.0-10.2

2 F2 3 6.0 - 10.2 6.0-18.0
4 6.0-102 | 6.0-180 | 0.0-6.0 1 (Light)
2 10.2-13.0

3 F3 3 10.2-13.0 6.0-18.0
4 10.2-13.0 6.0-18.0 0.0-6.0

4 F 2 20.0-40.0
3 20.0-40.0 0.0-6.0

5 F5 2 13.0-20.0

6 F6 3 6.0-23.0 0.0-6.0 2 (Medium)
4 6.0-23.0 0.0-9.0 0.0-9.0

7 F7 5 6.0-17.0 0.0-6.0 0.0-6.0 0.0-6.0
6 6.0-17.0 0.0-6.0 0.0-6.0 0.0-6.0 0.0-6.0
3 6.0-17.0 14.0-40.0

8 F8 4 6.0 - 20.0 0.0-6.0 6.0-40.0
4 6.0-20.0 14.0-42.0 0.0-6.1
5 6.0-22.0 0.0-6.0 6.0-40.0 0.0-125

o F9 5 6.0-220 0.0-6.0 6.0-23.0 11-230

3 (Heavy)

6 6.0-22.0 0.0-6.0 0.0-40.0 0.0-11.0 0.0-11.0

10 F10 7 6.0-220 0.0-6.0 0.0-40.0 0.0-13.0 0.0-13.0 0.0-13.0

11 F11 5 6.0-22.0 11.0-25.0 6.0-18.0 11.0-25.0

12 F12 6 6.0-22.0 0.0-6.0 10-25.0 6.0-18.0 11.0-25.0

13 F13 7-9
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Turkce

@)
Tirkiyeye ait synyflandyrma semasy. =
« Units: Metric (m) %
+ Carclass: 2 o
« Unclassifiable vehicle class: 12 S
(9]
(@]
Class Type Axles SP1 SP2 SP3 SP4 SP5 Aggregate =
1 s 2 0.0- 183 3
2 1.83-3.0
2 oto .
3 1.83-30 1.83-4.24 1 (hafif)
3 i 2 30-35
prep 3 3.0-35 183-4.24
. 2 5.4-12.0
4 Otobls
3 54-12.0 0.0-1.83
5 Kamyon2 2 35-53
3 2.8-53 0.0-1.83
6 Kamyon3
3 0.0-1.83 28-53 2 (orta)
4 0.0-1.83 2.0-7.05 0.0-1.83
4 2.0-7.05 0.0-1.83 0.0-1.83
7 Kamyon
4 0.0-1.83 0.0-1.83 2.0-7.05
5 0.0-1.83 2.0-7.05 0.0-1.83 0.0-1.83
3 1.83-6.1 425-12.0
4 1.83-6.1 0.0-1.83 1.83-120
8 Treyler
4 1.83-6.1 1.83-12.0 0.0-1.83
4 1.83-6.1 183-7.0 1.83-12.0
5 1.83-6.7 1.83-12.0 0.0-1.83 0.0-1.83
. 5 1.83-6.7 0.0-1.83 1.83-12.0 0.0-1.83 3
9 Komhi5 3 (adyr)
5 1.83-6.7 0.0-1.83 1.83-7.65 1.83-12.0
5 1.83-6.70 1.83-12.0 1.83-7.65 1.83-12.0
6 1.83-6.7 0.0-1.83 1.83-120 0.0-1.83 0.0-1.83
10 Kombi6 6 1.83-6.7 0.0-1.83 1.83-12.0 1.83-7.65 1.83-7.65
6 1.83-6.7 0.0-1.83 1.83-7.65 1.83-120 0.0-1.83
11 >7aks 7
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Signature Type Reference

Classification
Tables

Report Name

[ Base ]

[ Regular]

[ Plus ]

[ Phase ]

Description

User Defined Vehicle Reporis

Custom List Report

|

| v | v |Cust0m built reports.

Formatted Vehicle Reports

Table of hourly vehicle counts, peaks and

Weekly Vehicle Counts v v v v averages. One week per page.
Weekly Vehicle Counts (Virtua v v Table of hourly vehicle counts, peaks and
Week) averages. Compressed into one week.
Vehicle Counts Vv Vv v v~ |Report optimized for vehicle counts.
. . Report optimized for vehicle counts.
Vehicle Counts (Virtual Day) v v Compressed into one day.
. Class volumes and percentages of daily and
Daily Classes VoI VY weekly flow.
Daily Classes by Direction v v v~ |Class volumes and percentages by direction.
, , Class volumes and percentages of daily and
Daily Classes (Estimated Mass) v v weekly flow with estimated masses
Class Speed Matrix v v v~ | Table showing speed versus class, with totals.
. . Table showing speed versus vehicle separation,
Speed Separation Matrix v v with totals.
Rolling Day Totals v v Pailyvolumeandspeedsummaryinrolling
ormat.
List of each vehicle showing time, speed, class,
Individual Vehicles v v~ |wheelbase, headway, axles, groups and wheel
picture
Queued Vehicles v v |List queues showing lead and trailing vehicles
Speed Statistics v v~ |Report showing speed statistics by bin
Speed Statistics by Hour v v |Report showing speed statistics by hour
Separation Statistics v v~ |Report showing separation statistics by bin
Separation Statistics by Hour v v |Report showing separation statistics by hour
Adjusted Vehicle Flow v v |Report showing AADT and ADT.
Data Scan v v |Datascan with result status
Phase Reports
Custom List Report v~ |Custom built phase reports.
Individual vehicles ordered by phase, with speed
Data Phase Report v statistics,
Phase Statistics v |Phasetiming statistics.
Charts
Report Name (_Base ] |(Regufar}|[_Plus ]| Phase ] Description
Vehicle Data Verification Charts
Spectrum of Axle Hits v v~ |Chart showing logarithm of sensor hit times.
, . Chart showing vehicle correlation between
Correlation of Axle Hits v v NSO,
Audit of Data Quality v v Char_t showing sensor balance and axle hit
quality.
Axle Position Histogram v v |Axledistribution within vehicles.
Environmental Test v v~ |Special report
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DB974BB611.htm
DB974BB5F4.htm
DB974BB5F4.htm
DB974BB5F4.htm
DB974BB5F5.htm
DB974BB5F5.htm
DB974BB5F6.htm
DB974BB5F6.htm
DB974BB5F6.htm
DB974BB5F7.htm
DB974BB5F8.htm
DB974BB5F9.htm
DB974BB5FA.htm
DB974BB5FB.htm
DB974BB5FC.htm
DB974BB5FC.htm
DB974BB5FD.htm
DB974BB5FD.htm
DB974BB5FE.htm
DB974BB5FF.htm
DB96193EB8.htm
DB96193EB8.htm
DB96193EB8.htm
DB974BB600.htm
DB974BB601.htm
DB974BB602.htm
DB974BB603.htm

Report Name (_Base }|(Regular}|(_Plus ||[ Phase | Description
Time Based Vehicle Plots
Vehicle Flow v v v v |Plot of integrated vehicle flow versustime.
Velocity Dispersion v v |Plot of velocity dispersion with time.
Speed v v |Plot of mean speed with min/max limits.
Flow Stacked by Class v v |Plot of flow segregated by class.
Flow Stacked by Speed Bins v v~ |Plot of flow segregated by speed bins.
Flow Clustered by Class v v~ |Plot of flow segregated by class.
Flow Clustered by Speed Bins v v~ |Plot of flow segregated by speed bins.
Separation v v |Plot of vehicle separation.
Lane Occupancy v v~ |Plot showing lane occupancy and capacity.
Dispersion Plots
Speed vs Separation v v~ |Plot of speed vs vehicle separation.
Volume vs Speed v v |Plot of traffic volume vs speed
Density vs Speed v v~ |Plot of traffic density vs speed
Density vs Volume v v |Plot of traffic density vs volume
Binned Charts
Class Bin Chart v v~ |Interactive chart showing class hins.
Speed Bin Chart v v~ |Interactive chart showing speed bins.
Vehicle Statistics
Speed Histogram % % Eg% d(ljlstsrtlrllagltjltcl)gnand summary showing closest
Notional Speed Limit v v~ |Shows changing speed limit.
Wheelbase Histogram v v~ |Vehicle wheelbase distribution.
Separation Histogram v v~ |Vehicle separation distribution.
Phase Charts
Phase Spectrum v~ |Chart showing distribution of phase times.
Phase Flow v~ | Chart showing phase-flow distribution.
Phase Speed v~ |Chart showing phase-speed distribution.
Phase Future Position v~ |Chart showing estimated future position.
Phase Queue v~ |Chart showing phase queueing.
Phase Delay v~ |Chart showing phase delay.
Phase Cycle v |Time series showing phase-cycle length.
Special
Report Name [ Base ]|[Regular]|[ Plus ]|[ Phase ] Description
Standard Vehicle Formats

Florida SPS Class % % % F(L?rrr: gta DOT Survey Processing Software, class
Florida SPS Vehicle Volume v v v v \'jl)?ﬂs]i IfDo(r)r-Tr1 a?urvey Processing Software,
Florida SPS Vehicle Speed % v v r(l)?r: gta DOT Survey Processing Software, speed
PRN Class Format v v v |PRN file class counts.
PRN Directional Volume v v v |PRN filedirectional vehicle counts.
PRN Speed Format v v v |PRN file speed counts.
New England TAS v v |New England TAS.
QDOT 60 Minute Report v v v |QDOT 60 minute format
QDOT 15 Minute Report v v~ |QDOT 15 format
FHWA VTRIS Class Report v v v~ |FHWA VTRIS Class Report
FHWA VTRIS Vehicle Volume v v v~ |FHWA VTRIS Vehicle Volume Report
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DB974BB604.htm
DB974BB605.htm
DB974BB606.htm
DB974BB607.htm
DB974BB607.htm
DB974BB608.htm
DB974BB608.htm
DB974BB609.htm
DB974BB60B.htm
DB974BB60B.htm
DB974BB60B.htm
DB974BB60B.htm
DB974BB60C.htm
DB974BB60C.htm
DB974BB60D.htm
DB974BB60E.htm
DB974BB60F.htm
DB96193EB8.htm
DB96193EB8.htm
DB96193EB8.htm
DB96193EB8.htm
DB96193EB8.htm
DB96193EB8.htm
DB96193EB8.htm

Report Name (_Base }|(Regular}|(_Plus ||[ Phase | Description
Report
TNZ Class Report v v v |Tranzit New Zealand class report.
MRWA Vehicle Report v v |MRWA Vehicle report.
FIME13 v v |Fime Reports
FIME24 Vv v v~ |Fime Reports
Exotics
Speed Bin Totals v v v~ | Speed bin totalsin 15 minute steps.
Class Bin Totals Vv v v |Classbin totalsin 15 minute steps.
TAMS Vehicle Count Report v v v |TAMS Vehicle Count Report
GR Formats
GRO0O0 Vehicle Count Report v v v |GROO0 Vehicle count report type
GR60 Speed Report v v v~ |GR60 speed report type
GR66 Class Report v v v |GR66 class report type
GR69 Speed/Class Report v v v~ |GR69 Speed and Class report type
NYSDOT Subsystem

NY SDOT Reports

’ v | v | v |Avarietyof special format reports for NY SDOT
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Event Count

92
S
Tables 8
S
Repo" Name [ Base }|[Regular]|[__Plus ]|[_Phase ] Descrip“on ;
User Defined Event Reports ®
- )
. Text list report of events (useful for export to @
Event List Report v v other programs). %
Formatted Event Count Reports 3
(0]
Weekly Event Counts % % % % Table of hourly event counts, peaks and

averages. One week per page.
Table of hourly event counts, peaks and

Weekly Event Counts (Virtual

Week) v v v averages. Compressed into one week.
Event Counts v v v v~ |Report optimized for short-term count surveys.
. Report optimized for short-term count surveys.
Event Counts (Virtual Day) v v v Compr {into one day.
Adjusted Event Flow v v~ |Report showing AADT and ADT.
Charts
Report Name [ Base }|[Regular]|[__Plus ]|[_Phase ] Description

Event Count Verification Charts

Spectrum of Axle Hits v v~ |Chart showing logarithm of hit times.
Piezo Test Report v v |Piezo statistics chart

Time Based Event Count Plots

Event Flow ‘ v ‘ v ‘ v ‘ v ‘ Plot of integrated event volume versus time.
Special
Report Name [ Base ]|[Regular]|[ Plus ]|[ Phase ] Description
Exotics
Punched Tape | v | v | v | v |Fi scher Porter tapein 15 min bins
Standard Event Count Formats
Florida SPS Event % % v v FloridaDOT Survey Processing Software, event
counts.
E'gpvgﬁ VTRIS Event Count v | v | v | v~ |FHWA VTRISEvent Count Report
PRN Event Format Vv Vv v v |PRN File Event counts.
GROO0 Event Count Report v v v v |GROO Event Count Report
GRO08 Event Count Report v v v v |GRO8 Event Count Report
GR18 Event Count Report v v |GR18 Event Count Report
TAMS Event Count Report v v v v~ |TAMS Event Count Report
New England TAS v v v |New England DFL file
TNZ Event Report v v v~ | Transit New Zealand count report
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